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.

New in This Release

Login Banner
For Communication Server 1000 Release 5.5, Element Manager displays
a security warning banner, in the login page of Element Manager on
VxWorks, that can be modified if necessary.

Media Gateway and 32 Channel Secure Media commands
Element Manager now provides support for executing Media Gateway
Controller (MGC) and 32 Channel Secure Media Card (MC32S) command
line interface (CLI) maintenance commands from Element Manager.

Traffic Reports
The display format of all the traffic reports displayed in Element Manager
has been changed. Data measured under System Traffic and Customer
Traffic is displayed with proper headers and descriptions.

Subscriber Manager
Communication Server 1000 Release 5.5 also introduces a new Nortel
product called ECM Subscriber Manager, which provides a common
application to handle subscriber data and launches subscriber based
provisioning workflows for various Nortel enterprise services.

Subscriber Manager is a Web-based interface that is deployed as a
plug-in application on the Enterprise Common Manager (ECM) framework.
Subscriber Manager provides a centralized location for the management
of subscriber information for enterprise services.

Element Manager in ECM provides a nodal management interface for
provisioning CS 1000 phones. EM is able to inter-work with Subscriber
Manager to provision phone services for subscribers. For more information
about Subscriber Manager refer to, Subscriber Manager Fundamentals ()
(NN43001-120).
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10 New in This Release

Mobile Extension
With CS 1000 Release 5.5, Element Manager supports configuration
and maintenance aspects of the Mobile Extension feature for CPPIV and
CPPM machines.

The CS 1000 Mobile Extension feature enables mobile phones connected
to a CS 1000 system to appear as an office extension. Incoming calls
to an office phone number automatically call out to the mobile phone
associated with the office phone number. A user making a call from a
mobile phone can use the enterprise dial plan as if the call were made
from an office extension. Call treatments provided for an office extension
are extended to the mobile phone.

The Element Manager interface supports overlay prompts for Mobile
Extension.

Mobile Extension provides various telephony features to the Mobile user.
A Mobile user is configured with a Universal Extension (UEXT), which
provides the logical connection to the mobile phone. A Mobile user can
have an office desktop phone (digital, IP etc) in addition to the Universal
Extension. A single Directory Number (DN) can be shared between the
Universal Extension and the desktop phone.

With CS 1000 Release 5.5 Element Manager supports configuration of
phones with the UEXT designation. Functionalities provided for the new
set are:

• Single/bulk phone addition

• Single/bulk phone modification

• Basic and advanced search

• Retrieval of phones from PBX

• Single/bulk phone deletion

• Reports generation in HTML and CSV format

Two features are part of UEXT – Universal Extension Type (UXTY) and
Universal Extension ID (UXID).

For more information about Mobile Extension refer to, Features and
Services Fundamentals - Book 4 of 6 () (NN43001-106-B4).
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Other
Revision History

November 2008 Standard 02.14. This document is up-issued to add information in the Software
section.

April 2008 Standard 02.13. This document is up-issued to add patching information.

March 2008 Standard 02.12. This document is up-issued to add information about Zone 0
and CR Q01834961.

February 2008 Standard 02.11. This document is up-issued to reflect changes in technical
content.

January 2007 Standard 02.10. This document is up-issued to reflect changes in technical
content.

December 2007 Standard 02.09. This document is up-issued to support Communication Server
1000 Release 5.5.

August 2007 Standard 01.05. This document is up-issued to support Microsoft Exchange
Server 2007 Unified Messaging.

June 2007 Standard 01.03. This document is up-issued for: (1) to specify that PDT access
is required to access the Element Manager patching feature. (2) to indicate
that the rows in the Excel spreadsheet must be completed sequentially. (3)
to correct the graphic Digit Conversion Tree Configuration Web page. (4) to
provide more information on QoS threshold values. (5) to correct the graphic
Clock Controller Basic Properties Web page.

May 2007 Standard 01.01. This document is up-issued to support Communication Server
1000 Release 5.0. This document contains information previously contained
in the following legacy document, now retired: Element Manager System
Administration (553-3001-332).

August 2005 Standard 3.00. This document is up-issued to support Communication Server
1000 Release 4.5.

September
2004

Standard 2.00. This document is up-issued for Communication Server 1000
Release 4.0.

October 2003 Standard 1.00. This document is a new NTP for Succession 3.0. It was
created to support a restructuring of the Documentation Library. This document
contains information previously contained in the following legacy document,
now retired: Element Management (553-3023-222). Some content from
Element Management (553-3023-222) also appears in Succession 1000
Element Manager: Installation and Configuration (553-3001-232).
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.

Introduction
WARNING
Do not contact Red Hat for technical support on your Nortel
version of the Linux base operating system. If technical support
is required for the Nortel version of the Linux base operating
system, contact Nortel technical support through your regular
channels

Contents
This section contains information on the following topics:

“Element Manager overview” (page 13)

“Element Manager Launched from Enterprise Common Manager” (page
16)

“Key features” (page 16)

“Signaling Server” (page 16)

“Call Server and Media Gateway” (page 17)

“IP Line 5.5/Voice Gateway” (page 17)

Element Manager overview
Element Manager is a Web-based user interface used to configure and
maintain CS 1000 components.

There are six scenarios by which Element Manager can be deployed:

• Element Manager on CPPM server, can be coresident with Network
Routing Service (NRS).

• Element Manager on ISP1100 server, can be coresident with Network
Routing Service (NRS)

• Element Manager on COTS IBM server that resides on Signaling
Server
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14 Introduction

• Element Manager on COTS HP server that resides on Signaling Server

• Element Manager on COTS IBM server on Enterprise Common
Manager Framework

• Element Manager on COTS HP server on Enterprise Common
Manager Framework

Table 1 "Element Manager deployment scenarios" (page 14) further
illustrates the deployment scenarios for Element Manager.

Table 1
Element Manager deployment scenarios

Hardware Platform Operating Environment Scope

ISP1100
CPPM
HP DL320
IBM 360

VxWorks OS Configuration of one IP system,
generally the system that is
associated with the signaling
server software that runs on
the same platform.
Note: NRS supports
co-residency in some situations
depending on the engineering
of the network.

HP
IBM

ECM framework
Linux OS

Management of:
• Features:

— Single Sign On through
ECM security domain

— Configuration of
telephones

Note: In this deployment,
Element Manager does not
co-reside with the NRS
application

Element Manager can also be launched from Telephony Manager.

When Element Manager is deployed on Linux operating systems, it
is launched from the Enterprise Common Manager framework. For
more information, see Enterprise Common Manager Fundamentals
(NN43001-116) () .

For further information on installing the Linux operating system, see
Linux Platform Base and Applications Installation and Commissioning
(NN43001-315) () .

Element Manager can also be accessed through Telephony Manager
(TM). The TM navigator includes integrated links to each network system
and their respective instances of Element Manager.
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Element Manager overview 15

With Subscriber Manager, an administrator can add and configure phone
services for subscribers with available Templates in Element Manager. A
Template contains attributes common to a CS 1000 phone type. Once a
Template is created, you can use it to apply these common attributes to a
group of phones, without having to repetitively define the same value for
each phone. In general, using a Template is a more efficient method of
adding large numbers of phones than maintaining each phone individually.

Element Manager is a simple and user-friendly Web-based interface that
supports a broad range of system management tasks, including:

• configuration and maintenance of IP Peer and IP Telephony features

• configuration and maintenance of traditional routes and trunks

• configuration and maintenance of numbering plans

• configuration of Call Server data blocks

• maintenance commands, system status inquiries, backup and restore
functions

• patch upload, patch activation, firmware download

Element Manager has many features to help administrators manage
systems with greater efficiency. Examples are as follows:

• Web pages provide a single point-of-access to parameters that were
traditionally available through multiple overlays.

• Parameters are presented in logical groups to increase ease-of-use
and speed-of-access.

• The hide or show information option enables administrators to see
information that relates directly to the task at hand.

• Full-text descriptions of parameters help administrators reduce
configuration errors.

• To simplify response selection, Configuration screens offer preselected
defaults, drop-down lists, checkboxes, and range values.

• To simplify the importing of phones to the database a Comma
Separated Value (CSV) file can be used.

Note: All screen captures in this chapter are applicable to CS
1000Eand CS 1000Msystems, unless otherwise indicated. In some
cases, Web pages are different, depending on whether they are
presented on a Large or a Small System. Where there is no indicator,
the screen and commands are available on both. When the screen or
command is specific to a Large or a Small System, this is indicated.
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16 Introduction

Element Manager Launched from Enterprise Common Manager
This document focuses on the Element Manager application launched from
Enterprise Common Manager.

Except where indicated, the text and Figures in this document refer to
Element Manager when launched from Enterprise Common Manager.

Key features
The following functional areas can be accessed using Element Manager:

• Links — Provides access to Virtual Terminal sessions.

• IP Network — Helps the user access all functions related to
managing IP Networks. These functions include data and physical
structure configuration, high-profile operational activities, and
administrative/maintenance functions.

• System — Provides access to system-wide configuration and basic
hardware/software management, including supported maintenance
overlays and configuration.

• Customers — Allows the user to view and edit customer properties.

• Routes and Trunks — Provides access to all functions required to
create and manage trunks.

• Dialing and Numbering Plans — Provides a means to configure all
Electronic Switched Network (ESN) data blocks for the Call Server,
as well as to access configuration for the Network Routing Service
(NRS). When deployed on VxWorks, this menu provides links to NRS
Manager, which performs configuration of NRS services, SIP/Redirect
services, and H.323 gatekeeper.

• Phones— Enables users to import and configure phones for the Call
Server.

• Tools — Provides general administrative tools, features and functions,
and allows the user to find and access task-related pages, including
Reports.

• Security — Allows the user to perform Security functions, including
IP Security.

Signaling Server
Element Manager enables administrators to perform the following activities
on the Signaling Server:

• reset

• access the maintenance window
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IP Line 5.5/Voice Gateway 17

• download new IP Phone firmware

• upgrade IP Phone firmware

• view report log

• view Operational Measurements (OM) data

• Telnet

• patching

• increase Virtual Trunk capacity and perform configuration tasks on
Virtual Trunks

• configure and manage the Web-based services for Personal Directory,
Redial List, and Callers List

• add, delete, view, and edit Signaling Server information

Call Server and Media Gateway
For Call Server and Media Gateway, Element Manager enables
administrators to configure and manage the following data:

• Configuration Record

• Customer Data Block

• Route Data Blocks

• Trunks

• ESN Data Block

• Patching

To learn more about parameters that can be configured and managed in
Element Manager, see System Management Reference (NN43001-600) ()
.

IP Line 5.5/Voice Gateway
Element Manager enables administrators to perform the following activities
on the IP Line 5.5/Voice Gateway Media Cards:

• View and configure Simple Network Management Protocol (SNMP)
parameters and add IP addresses for forwarding SNMP traps.

• View and configure Voice Gateway profile data.

• View and edit Quality of Service (QoS) parameters.

• Use Local Area Network (LAN) configuration to configure the
Management LAN (ELAN) subnet, Telephony LAN (TLAN) subnet, and
Routes.
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18 Introduction

• View and edit Simple Network Time Protocol (SNTP) Server and
Client information.

• View and configure file server access for downloading firmware for IP
Phones.

• View and select the Loss and Level Plan for the country. For more
information about selecting the Loss and Level Plan for the country,
see Transmission Parameters Reference (NN43001-282) () .

• Add, remove, view, and edit card properties of Voice Gateway Media
Cards.

To learn more about IP Line 5.5 and Voice Gateway Media Card
parameters that can be configured and managed in Element Manager, see
IP Line Fundamentals (NN43100-500) () .

The following maintenance activities are supported when using Element
Manager for IP Line 5.5 and Voice Gateway Media Card:

• reset Voice Gateway Media Card

• enable/disable Voice Gateway Media Card

• access the maintenance window to the Voice Gateway Media Card

• download new loadware/firmware for upgrades

• run Syslog reports

• obtain Operational Measurement (OM) data

• Telnet to the card

• patching

To learn more about the IP Line 5.5 and Voice Gateway maintenance
activities that are supported by Element Manager, see “IP Network” (page
131).
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How to get help

Contents
This section contains information on the following topics:

Getting help from the Nortel Web site
The best way to get technical support for Nortel products is from the Nortel
Technical Support Web site:
www.nortel.com/support
This site provides quick access to software, documentation, bulletins, and
tools to address issues with Nortel products. From this site, you can:

• download software, documentation, and product bulletins

• search the Technical Support Web site and the Nortel Knowledge Base
for answers to technical issues

• sign up for automatic notification of new software and documentation
for Nortel equipment

• open and manage technical support cases

Getting help over the telephone from a Nortel Solutions Center
If you do not find the information you require on the Nortel Technical
Support Web site, and you have a Nortel support contract, you can also
get help over the telephone from a Nortel Solutions Center.
In North America, call 1-800-4NORTEL (1-800-466-7835).
Outside North America, go to the following Web site to obtain the
telephone number for your region:
www.nortel.com/callus

Getting help from a specialist by using an Express Routing Code
To access some Nortel Technical Solutions Centers, you can use an
Express Routing Code (ERC) to quickly route your call to a specialist in
your Nortel product or service. To locate the ERC for your product or
service, go to:
www.nortel.com/erc
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Getting help through a Nortel distributor or reseller
If you purchased a service contract for your Nortel product from a
distributor or authorized reseller, contact the technical support staff for that
distributor or reseller.
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How to use Element Manager

Contents
This section contains information on the following topics:

“Launching Element Manager” (page 21)

“Timeout after a period of inactivity” (page 24)

“Navigation” (page 24)

“Configuring data” (page 28)

“Logging out” (page 29)

Launching Element Manager
CS 1000 Element Manager can be installed with the Enterprise Common
Manager (ECM) security framework on a dedicated IBM 306 or an HP
DL320 Commercial Off The Shelf (COTS) server. Element Manager is
launched from the ECM framework. This framework supports Single
Sign-on so that the user can access multiple systems. Users access
the framework through Microsoft Internet Explorer 6.02600 or later. For
information on how to log in to ECM, configure the ECM framework,
and log in to Element Manager, see Enterprise Common Manager
Fundamentals () (NN43001-116).

The VxWorks version of Element Manager can be deployed on an
ISP1100 Signaling Server, an IBM 306 or an HP DL320 Commercial
Off The Shelf (COTS) server, or a CPPM server. To log in to Element
Manager on VxWorks, follow the steps in Procedure 1 “Launching Element
Manager on VxWorks” (page 22). Element Manager supports Microsoft TM

Internet Explorer 6.0.2600 and later versions.

Before following this procedure, ensure that the Web browser is still
configured properly for optimal Web browser performance. This
configuration was performed when the Signaling Server software was
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22 How to use Element Manager

installed. Refer to Signaling Server Installation and Commissioning ()
(NN43001-312) for information on configuring the browser for optimal
performance of Element Manager.

Note: This procedure requires Service Pack 1 and Java Runtime
environment.

Procedure 1
Launching Element Manager on VxWorks

Step Action

1 Open the Web browser.

2 Enter the Signaling Server Node IP address in the Address
Bar of the browser window and press Enter on the keyboard.

Note: The ELAN network interface IP address can be
required, instead of the Node IP address, to access the
Element Manager login Web page in secure environments.

3 The Element Manager Login Web page opens (see Figure 1
"Element Manager Login Web page" (page 23)).

Note: If a security certificate is correctly installed, and the
usage rule set to UserChoice, the user has the option to log
in using Secure mode. If the usage rule is set to Always, the
user is redirected to the https site, and a warning message
appears. For more information, see “Certificate Management”
(page 333).

a Enter a valid User ID and Password combination.

Note: A valid User Id and Password combination is one
that is defined on the Call Server.

The IP Address of the Call Server appears in the Call Server
IP Address field.

b Click Login.
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Figure 1
Element Manager Login Web page

4 The System Overview Web page appears (see Figure 2
"Element Manager System Overview Web page" (page 23)).

--End--

Figure 2
Element Manager System Overview Web page
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24 How to use Element Manager

Timeout after a period of inactivity
Element Manager times out after a period of inactivity. Users are logged
out without any warning in all Element Manager Web pages. The
exception to this is the Node Configuration Edit Web pages. When a
user is working in this Web page, a message appears that warns of the
impending timeout action. Click OK (on the warning message) within the
remaining timeout period (five minutes) to reset the timer. If there is no
response within the five-minute warning period, the session is cancelled,
and the user must log in again. Any data modifications made on screen,
but not submitted to the system, are lost.

Navigation
The Element Manager navigator is located on the left side of the browser
window as shown in Figure 3 "Element Manager navigator on Linux" (page
25).
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Figure 3
Element Manager navigator on Linux

Links in the Element Manager on Linux navigator are structured as follows:

• Home

• Links

— Virtual Terminals

• System

— Alarms

— Maintenance

— Core Equipment

— Peripheral Equipment

— IP Network
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26 How to use Element Manager

— Interfaces

— Engineered Values

— Emergency Services

— Geographic Redundancy

— Software

• Customers

• Routes and Trunks

— Routes and Trunks

— D-Channels

— Digital Trunk Interface

• Dialing and Numbering Plans

— Electronic Switched Network

— Flexible Code Restriction

— Incoming Digit Conversion

• Phones

— Templates

— Report

— Properties

• Tools

— Backup and Restore

— Call Server Initialization

— Date and Time

— Logs and Reports

• Security

— Passwords

— Policies

— Login Options

During periods of high call volume, Element Manager Web pages load
more slowly.

When deployed on VxWorks, the Element navigator appears as shown in
Figure 4 "Element Manager navigator on VxWorks" (page 27).
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Figure 4
Element Manager navigator on VxWorks

Links in the Element Manager on VxWorks navigator are structured as
follows:

• Home

• Links

— Virtual Terminals

— Bookmarks

• System

— Alarms

— Maintenance

— Core Equipment

— Peripheral Equipment
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28 How to use Element Manager

— IP Network

— Interfaces

— Engineered Values

— Emergency Services

— Geographic Redundancy

— Software

• Customers

• Routes and Trunks

— Routes and Trunks

— D-Channels

— Digital Trunk Interface

• Dialing and Numbering Plans

— Electronic Switched Network

— Network Routing Service

— Flexible Code Restriction

— Incoming Digit Conversion

• Tools

— Backup and Restore

— Call Server Initialization

— Date and Time

— Logs and Reports

• Security

— Passwords

— Policies

— Login Options

Configuring data
In many cases, users can edit data using configuration Web pages. At the
bottom of the configuration Web pages, the following four buttons appear:

• Submit — Transmits changes to the Call Server.

• Refresh— Refreshes data from the Call Server. Refresh overwrites
any changes not yet submitted.
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Logging out 29

• Delete — Deletes the item being edited or configured.

• Cancel — Discards the changes and returns to the appropriate
configuration page.

Logging out
To log out of Element Manager, click the Logout link in the top right-hand
corner.

WARNING
Do not close the browser window before logging out. The
session remains active and the user will be unable to log in
again within 30 minutes.

In the VxWorks environment, the command userLogOut
<username> can be used in vxshell of the Signaling Server to
logout the Element Manager user. This will release the active
session for the user.
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.

Links

Contents
This section contains information on the following topics:

“Introduction” (page 31)

“Virtual Terminals” (page 31)

“Bookmarks” (page 34)

Introduction
The features available under the Links branch of the Element Manager
navigator enable Element Manager to be the single point of management
access to Web pages and character-based interfaces.

Use the Virtual Terminal feature to define and access the IP addresses
of any character-based interfaces. On the Call Server, users can access
context-sensitive online help, which provides detailed information on
system prompts and error messages.

The Bookmarks feature allows access to any Web servers embedded
within the components of the system. Users can also add links to any
other useful Web sites.

Note: The Bookmarks link is available only on Element Manager on
VxWorks. When using the Enterprise Common Manager framework, the
user accesses the link directly from the framework.

Virtual Terminals
Click the Virtual Terminals link to open the Virtual Terminal Sessions
Web page as shown in Figure 5 "Virtual Terminal Sessions Web page"
(page 32).
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Figure 5
Virtual Terminal Sessions Web page

The Virtual Terminal Sessions Web page enables users to Telnet to any
IP-based element in the system. By entering and saving the IP address to
Telnet to a particular IP-based element, users can access those elements
more quickly in the future.

ATTENTION
Java Runtime Environment (JRE) version 1.5 must be installed for the Virtual
Terminal Emulator to run properly

Follow the steps in Procedure 2 “Adding a Virtual Terminal session” (page
32) to add a Virtual Terminal Session .

Procedure 2
Adding a Virtual Terminal session

Step Action

1 On the Virtual Terminal Sessions Web page, click Add. The
Add Virtual Terminal Session Web page appears, as shown in
Figure 6 "Add Virtual Terminal Session Web page" (page 32).

Figure 6
Add Virtual Terminal Session Web page

2 Enter a Name and IP Address for the session.
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3 Select the Type from the drop-down list.

4 Click Save to save.

5 To cancel the session, click Cancel.

--End--

To access a Virtual Terminal Session that is already created, click the
name of the Virtual Terminal Session on the Virtual Terminal Sessions
Web page. A Virtual Terminal window opens in a separate browser
window.

Note 1: Virtual terminal prompts for pdt2 password, but user can press
Enter and give the admin1 or admin2 password to get connected,
and pdt2 password is not mandatory if user launches Virtual Terminal
through ECM.

Note 2: Upon initial launch of Virtual terminal, the user is prompted for
the PDT2 level password. Entering this password will navigate user to
the PDT2 shell of the Call Server. The user can also carriage return
past the PDT2 password prompt. This action will prompt the user for
a new username for other accounts on the Call Server. The user can
provide admin1 or admin2 login credentials allowing overlay access to
the Call Server.

The Virtual Terminal window provides a menu with the following items:

• Current Overlay

• Current Prompt

• Search M1 Help Files

• About Terminal Client

When the user enters an overlay, the Current Overlay and Current Prompt
menu items are enabled.

Click the Help -> Current Overlay link to open a Help window containing
help for that particular overlay.

Click the Help -> Current Prompt link to open a Help window explaining
the definition of the prompt, along with acceptable responses.

Follow the steps in Procedure 3 “Editing an existing Virtual Terminal
session” (page 33) to edit an existing Virtual Terminal session.

Procedure 3
Editing an existing Virtual Terminal session
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Step Action

1 Select the radio button beside the appropriate Virtual Terminal
name on the Virtual Terminal Sessions Web page.

2 Click Edit.

The information about the Virtual Terminal Session selected is
displayed in the fields.

3 Edit the Name and IP Address values as necessary.

4 To change this session so that it logs into a Call Server, select
the Call Server check box.

5 Click Save to save the changes.

6 Click Cancel to undo any changes made.

--End--

Procedure 4
Deleting an existing Virtual Terminal Session

Step Action

1 Select the radio button beside the appropriate Virtual Terminal
name on the Virtual Terminal Sessions Web page.

2 Click Delete to remove the Virtual Terminal Session information
completely.

--End--

Bookmarks
The Bookmarks link is available only on Element Manager on VxWorks.
When using the Enterprise Common Manager framework, the user
accesses the link directly from the framework. Element Manager on
VxWorks enables users to bookmark Web sites for easy access. Click the
Bookmarks link to open the Bookmarks Web page, as shown in Figure 7
"Bookmarks Web page" (page 35).

Note: If there are no bookmarks created, a dialog box appears when
selecting the Bookmarks link that states the following: There are no
bookmarks configured. Click on [OK] to add one. Click OK to create a
bookmark or click Cancel to return to the System Overview Web page.
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Figure 7
Bookmarks Web page

To create a new bookmark, follow the steps in Procedure 5 “Creating a
new Bookmark” (page 35).

Procedure 5
Creating a new Bookmark

Step Action

1 Click Add.

The Bookmark Property Configuration Web page appears as
shown in Figure 8 "Bookmark Property Configuration Web page"
(page 36).
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Figure 8
Bookmark Property Configuration Web page

2 Enter a Description and Location (the URL) of the Web site to
be bookmarked.

3 Click Submit to enter the bookmark.

4 To cancel the session, click Cancel.

--End--

To access a bookmark that is already created, click the name of the
bookmark on the Bookmark Web page. The Web site opens.

To edit the properties of an existing bookmark, follow the steps in
Procedure 6 “Editing the properties of an existing Bookmark” (page 36).

Procedure 6
Editing the properties of an existing Bookmark

Step Action

1 Click Edit

The Bookmark Property Configuration window appears as
shown in Figure 9 "Bookmark Property Configuration Web page
- Edit" (page 37).
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Figure 9
Bookmark Property Configuration Web page - Edit

2 Edit the Description and Location (URL) values.

3 Click Submit to record the changes.

4 Click Delete to remove the bookmark completely.

5 Click Cancel to disregard any changes made.

--End--
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System

Contents
This section contains information on the following topics:

“Introduction” (page 40)

“Maintenance” (page 46)

“Application Module Link Diagnostics” (page 49)

“Background Signaling and Switching Diagnostics” (page 52)

“Call Trace Diagnostics” (page 53)

“Clock Controller Diagnostics” (page 59)

“Core Common Equipment Diagnostics” (page 60)

“Core Input/Output Diagnostics” (page 64)

“D-channel Diagnostics” (page 66)

“D-Channel Expansion Diagnostics” (page 69)

“Digital Trunk Diagnostics” (page 72)

“Digital Trunk Maintenance Diagnostics” (page 75)

“Emergency Services Diagnostics” (page 78)

“Ethernet Diagnostics” (page 81)

“Ethernet Quality of Service Diagnostics” (page 85)

“Input/Output Diagnostics” (page 87)

“Intergroup Switch and System Clock Generator Diagnostics” (page 90)

“MSDL Diagnostics” (page 94)

“Multifrequency Sender Diagnostics” (page 96)

“Multifrequency Signaling Diagnostics” (page 99)

“Network and Peripheral Equipment Diagnostics” (page 101)

“Network and Signaling Diagnostics” (page 106)

“TMDI Diagnostics” (page 108)

“Tone and Digit Switch Diagnostics” (page 110)
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“Trunk Diagnostics” (page 112)

“Zone Diagnostics” (page 114)

“Loops (Common Equipment)” (page 116)

“Superloops” (page 118)

“MSDL/MSIP Cards” (page 120)

“Conference/TDS/Multifrequency Cards” (page 121)

“Tone Senders and Detectors” (page 121)

Introduction
The System branch of the Element Manager navigator provides access to
diagnostic tools that enable users to issue a variety of commands to the
components of the CS 1000 system.

The following buttons appear on some or all of the System Web pages:

• Submit — Transmits changes to the Call Server.

• Refresh — Refreshes data from the Call Server. Refresh overwrites
any changes not yet submitted.

• Cancel — Discards the changes and returns to the appropriate
configuration Web page.

Events
To configure or edit Events information, click the Alarms > Events link in
the System branch of the Element Manager navigator. The Events Web
page appears as shown in Figure 10 "Events Web page" (page 40).

Figure 10
Events Web page
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To display event default severity, event thresholds and site-specific event
preferences, click the Event Defaults and Preferences link to open the
Event Defaults and Preferences Web page as shown in Figure 11 "Event
Defaults and Preferences Web page" (page 41).

Figure 11
Event Defaults and Preferences Web page

To edit the Suppression Threshold Value and Global Window Timer
Length that are common to all events, in the Thresholds section click
Edit. The Edit Thresholds Web page appears as shown in Figure 12
"Edit Thresholds Web page" (page 42).
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Figure 12
Edit Thresholds Web page

Enter the desired changes and click Save.

Search for event defaults by clicking either the Severity or Event
Category radio buttons. Enter the Search criteria and click Search. The
results appear in the Event Defaults section.

To maintain a list of system events, from the Events Web page click the
System Events link. The System Events Web page appears as shown in
Figure 13 "System Events Web page" (page 43).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



Events 43

Figure 13
System Events Web page

The System Event List Size in the Collection Limit section is the upper
limit to the number of events collected in the System Event List. To edit
this limit, click Edit.

All events collected in the system event list are displayed in the text area
at the bottom of the page.

Use this page to import an Event Preference Table from a user specified
location to the switch.

Import Event Preference Table (EPT)
Use this page to import an Event Preference Table from a user specified
location to the switch.

To display this page, choose System>Alarms>Events>Event Defaults
and Preferences. In the Event Preference Table Section, click Import.
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The Event Preference Table page opens.

Note: The user needs to change the Security settings in Microsoft
Internet Explorer while doing Import EPT. This file is residing at the
user PC which uses ActiveX FileSystemObject to do the validations.
This provides access to the local file system of the PC using even
JavaScript code. Microsoft IE has a field called "Initialize and script
ActiveX controls not marked as safe" under IE -> Tools -> Security ->
Custom Level. This field needs to be either set to "Prompt" or "Enable".
When this field is set to Disabled it doesn’t allow IE to create ActiveX
object and we find an error called "Automation server can not create
object" and our validation for the file fails. If the IE Security level setting
is set to High then no ActiveX controls is allowed, hence it should be set
to Medium with the specified field to set to either "Prompt" or "Enable".

Procedure 7
Import Event Preference Table

Step Action

1 Click Browse, to browse for the Event Preference Table.

2 Click Import & Activate to import the Event Preference Table
to the switch.

3 Click Cancel to return to the Event Defaults and Preferences
without importing a Event Preference Table to the switch.

--End--

SNMP
To configure or edit SNMP information, click the Alarms > SNMP
link in the System branch of the Element Manager navigator. The
SNMP Configuration Web page opens as shown in Figure 14 "SNMP
Configuration Web page" (page 45).
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Figure 14
SNMP Configuration Web page

The information entered on this Web page corresponds to the SNMP data
traditionally configured using LD 117 - Ethernet and Alarm Management.

By entering information into the appropriate text boxes, the following tasks
for SNMP can be performed:

• turn SNMP on and off by enabling or disabling traps

• trap destination IP addresses

• configure community name strings

• enable Call Server filtering

• enable Event Default Table (EDT), Event Preference Table (EPT), and
alarm suppression thresholds

Note: Element Manager does not provide an SNMP alarm browser,
so the TM alarm browser must be used when SNMP alarm collection
is required.

For detailed information on SNMP, see Communication Server 1000 Fault
Management - SNMP (NN43001-719) () .
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Maintenance
When the user clicks the Maintenance link in the System branch of
the Element Manager navigator, the Maintenance Web page appears.
The user can choose how the options are presented. If the user chooses
Select by Functionality, the diagnostic tool options are presented
by functionality as shown in Figure 15 "Maintenance diagnostic tools
presented by functionality" (page 46).

Figure 15
Maintenance diagnostic tools presented by functionality

The following tool options are available from this Web page:

• AML Diagnostics

• Background Signalling and Switching

• Call Trace Diagnostics

• Centralized Software Upgrade

• Clock Controller Diagnostics

• Core Common Equipment Diagnostics

• Core Input/Output Diagnostics

• D-Channel Diagnostics
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• D-Channel Expansion Diagnostics

• Digital Trunk Diagnostics

• Digital Trunk Maintenance Diagnostics

• Emergency Services Diagnostics

• Ethernet Diagnostics

• Ethernet Quality of Service Diagnostics

• Geographic Redundancy Diagnostics

• Input/Output Diagnostics

• InterGroup Switch & System Clock

• MSDL Diagnostics

• Multifrequency Sender Diagnostics

• Multifrequency Signaling Diagnostics

• Network and Peripheral Equipment Diagnostics

• Network and Signaling Diagnostics

• TMDI Diagnostics

• Tone and Digit Switch Diagnostics

• Trunk Diagnostics

• Zone Diagnostics

Note: Depending on the type of system being accessed, not all options
may be available.

If the user chooses Select by Overlay, the following options are presented
by LD numbers, as shown in Figure 16 "Call Server diagnostic tools
presented by overlay" (page 48):

• LD 30 - Network and Signaling

• LD 32 - Network and Peripheral Equipment

• LD 34 - Tone and Digit Switch

• LD 36 - Trunk

• LD 37 - Input/Output

• LD 39 - Intergroup Switch and System Clock

• LD 45 - Background Signaling and Switching

• LD 46 - Multifrequency Sender

• LD 48 - Link
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• LD 54 - Multifrequency Signaling

• LD 60 - Digital Trunk Interface and Primary Rate Interface

• LD 75 - Digital Trunk

• LD 80 - Call Trace

• LD 96 - D-Channel

• LD 117 - Ethernet and Alarm Management

• LD 135 - Core Common Equipment

• LD 137 - Core Input/Output

• LD 143 - Centralized Software Upgrade

Figure 16
Call Server diagnostic tools presented by overlay

If selecting an overlay that corresponds to more than one functionality,
choose the desired functionality in the Select Group list, as shown in
Figure 17 "Select Group drop-down list" (page 49).
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Figure 17
Select Group drop-down list

This document presents the options by functionality, with cross-references
to the appropriate overlay.

The following sections provide information on each functionality.

Application Module Link Diagnostics
Click the AML Diagnostics link in the list of Maintenance functionalities to
open the Link: AML Diagnostics Web page as shown in Figure 18 "AML
Diagnostics Web page" (page 50).
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Figure 18
AML Diagnostics Web page

The commands available from this Web page correspond to the AML
diagnostics traditionally performed by using LD 48.

To perform AML commands using this Web page, follow the steps in
Procedure 8 “Performing AML commands” (page 50).

Procedure 8
Performing AML commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a STAT AML - Get AML status

b STAT ELAN - Check status of all specified / all configured
ELANs

c EST AML - Establish layer 2 on AML

d MAP AML - Get card information of one or all AMLs

e RLS AML - Release layer 2 on AML

f SLFT AML - Perform self-test on AML
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g UPLD AML - Upload parameter table 1 to 4 from AML

2 (Optional) Enter the device number in the Command
Parameters text box.

3 Click Submit.

--End--

To disable AML using this Web page, follow the steps in Procedure 9
“Disabling AML ” (page 51).

Procedure 9
Disabling AML

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a DIS AML - Disable AML

b DIS AML - Disable AUTO recovery on AML

c DIS AML - Disable layer 2 on AML

d DIS AML - Disable layer 7 on AML

e DIS AML - Disable MDL error reporting on AML

f DIS ELAN - Disable ELAN (server/client task)

2 (Optional) Enter the device number in the Command
Parameters text box.

3 Click Submit.

--End--

To enable AML using this Web page, follow the steps in Procedure 10
“Enabling AML” (page 51).

Procedure 10
Enabling AML

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a ENL AML - Enable AML

b ENL AML - Enable Automatic set-up on AML

c ENL AML - Enable AUTO recovery on AML
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d ENL AML - Enable Layer 2 on AML

e ENL AML - Enable Layer 7 on AML

f ENL AML - Enable MDL error reporting on AML

g ENL ELAN- Enable ELAN (server task)

2 (Optional) Enter the device number in the Command
Parameters text box.

3 Click Submit.

--End--

Background Signaling and Switching Diagnostics
The Background Signaling and Switching diagnostics Web page is
applicable only to Large Systems.

Click the Background Signaling and Switching link in the list of Call
Server functionalities to open the Background Signaling and Switching
Diagnostics Web page, as shown in Figure 19 "Background Signaling and
Switching Diagnostics Web page" (page 52).

Figure 19
Background Signaling and Switching Diagnostics Web page
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The commands available from this Web page correspond to the
Background Signaling and Switching command traditionally performed
using LD 45 - Background Signaling and Switching Diagnostics.

This Web page is used to perform the TEST command. This command
performs a continuity test for specified loops.

Procedure 11
Performing the TEST command

Step Action

1 Select the Diagnostic Command from the drop-down list.

2 Enter the loop number in the Command Parameters box.

Note: To run the TEST command on all loops, leave the
Command Parameters box empty.

3 Click Submit.

--End--

Call Trace Diagnostics
Click the Call Trace Diagnostics link in the list of Maintenance diagnostic
tools to open the Call Trace Diagnostics Web page, as shown in Figure
20 "Call Trace Diagnostics Web page" (page 54).
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Figure 20
Call Trace Diagnostics Web page

The commands available from this Web page correspond to the Call
Trace diagnostics traditionally performed by using LD 80 - Call Trace
Diagnostics.

This Web page is used to perform the following Call Trace functions:

• TRAC commands

• TRAD commands

• TRAC commands

• TRIP commands

To perform TRAC commands, follow the steps in Procedure 12
“Performing TRAC commands” (page 55).

Note: To issue a detailed call trace select the DEV checkbox.
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Procedure 12
Performing TRAC commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a TRAC - List Route, type and status of trunks for a Customer

b TRAC - Trace calls for specified customer and DN/LSC DN

c TRAC - Trace calls for specified customer, route and member

d TRAC - Trace calls on specified Digital Subscriber Loop (0-7)

e TRAC - Trace calls associated with the specified unit

f TRAC - Trace calls on specified key for specified unit

2 Enter the customer number and the acod number in the
Command Parameters text box.

3 Click Submit.

--End--

To perform TRAD commands, follow the steps in Procedure 13
“Performing TRAD commands” (page 55).

Procedure 13
Performing TRAD commands

Step Action

1 Select the following command from the second Commands
drop-down list:

a TRAD - Trace DTI/DLI calls on a channel of a loop

2 Enter the loop number and channel number in the Command
Parameters text box.

3 Click Submit.

--End--

To perform TRAT commands, follow the steps in Procedure 14
“Performing TRAT commands” (page 56).

Note: To issue a detailed call trace select the DEV checkbox.
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Procedure 14
Performing TRAT commands

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a TRAT - Trace calls for an attendant for a customer

b TRAT - Trace calls on a key of an attendant of a customer

c TRAT - Trace attendant calls for a unit

d TRAT - Trace attendant calls on specified key of a unit

2 Enter the customer number and attendant number in the
Command Parameters text box.

3 Click Submit.

--End--

To perform TRIP commands, follow the steps in Procedure 15 “Performing
TRIP commands” (page 56).

Procedure 15
Performing TRIP commands

Step Action

1 Select the following command from the fourth Commands
drop-down list:

a TRIP - Trace calls for IP Phone

2 Enter the required parameters in the Command Parameters text
box.

3 Click Submit.

--End--

Centralized Software Upgrade
Click the Centralized Software Upgrade link in the list of Maintenance
diagnostic tools to open the Centralized Software Upgrade Web page, as
shown in Figure 21 "Centralized Software Upgrade Web page" (page 57).
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Figure 21
Centralized Software Upgrade Web page

To perform Upgrade commands, follow the steps in Procedure 16
“Performing Upgrade commands” (page 57).

Procedure 16
Performing Upgrade commands

Step Action

1 Select the following commands from the first Commands
drop-down list:

a UPGMG - Upgrade IPMG

b UPGMG ALL - Upgrade ALL IPMGs

c UPGMGCOMMIT - Initial Reboot of the MGC based IPMG
after upgrade

d UPGMCOMMIT ALL - Initial Reboot of all the MGC based
IPMG after upgrade

e UPGMGBOOT - Upgrade the bootrom of the IPMG

2 Enter the required parameters in the Command Parameters text
box.
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3 Click Submit.

--End--

To perform Enabling and Disabling commands, follow the steps in
Procedure 17 “Performing Enabling and Disabling commands” (page 58).

Procedure 17
Performing Enabling and Disabling commands

Step Action

1 Select the following commands from the second Commands
drop-down list:

a ENL AUTOUPGMG - Enable Automatic Software Upgrade

b DIS AUTOUPGMG - Disable Automatic Software Upgrade

2 If ENL AUTOUPGMG is used, select either SEQ or SIM from the
drop-down menu.

3 Click Submit.

--End--

To perform Status commands, follow the steps in Procedure 18
“Performing Status commands” (page 58).

Procedure 18
Performing Status commands

Step Action

1 Select the following commands from the third Commands
drop-down list:

a PRT AUTOUPGMG - Displays settings of Automatic Software
Upgrade feature

b UPGMG STAT - Provides display details of the specified
IPMG upgrade status

c UPGMGSETUP - Display the current CSU Setting

d UPGMGABORT - Abort and display centralized software
upgrades

e HELP - Provides a list of all supported commands

2 If UPGMG STAT is used, enter the Superloop # and Shelf # in
the Command Parameters text box.

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



Maintenance 59

3 Click Submit.

--End--

Clock Controller Diagnostics
Click the Clock Controller Diagnostics link in the list of Maintenance
diagnostic tools to open the Digital Trunk Interface and Primary Rate
Interface: Clock Controller Diagnostics Web page as shown in Figure
22 "Digital Trunk Interface and Primary Rate Interface: Clock Controller
Diagnostics Web page" (page 59).

Figure 22
Digital Trunk Interface and Primary Rate Interface: Clock Controller Diagnostics Web page

This Web page is used to maintain the digital trunk interface and the
primary rate interface clock controllers.

The commands available from this Web page correspond to the Clock
Controller data traditionally maintained by using LD 60- Digital Trunk
Interface and Primary Rate Interface Clock Controller.

This Web page shows the status of the Clock Controller card.
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To perform Clock Controller maintenance activities using this Web page
follow the steps in Procedure 19 “Performing Clock Controller maintenance
activities” (page 60).

Procedure 19
Performing Clock Controller maintenance activities

Step Action

1 Select one of the following commands from the Action
drop-down list:

a SSCK - Get Status of the Clock

b ENL CC - Enable the Clock

c DIS CC - Disable the Clock

d TRCK - Set the Clock Controller

e DSCK - Disable the clock for loop

f ENCK - Enable the secondary clock reference for card

g EREF - Enable auto switchover of reference clocks

h IDC - Get card ID of Clock Controller Card

i MREF - Disable switchover of system clocks

j SEFT CC - Execute self test

2 Select a Cabinet number from the In Side drop-down list.

3 Select the appropriate sub-parameters.

4 ClickSubmit.

--End--

Core Common Equipment Diagnostics
Click the Core Common Equipment Diagnostics link in the list of
Maintenance diagnostic tools to open the Core Common Equipment
Diagnostics Web page, as shown in Figure 23 "Core Common Equipment
Diagnostic Web page" (page 61).
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Figure 23
Core Common Equipment Diagnostic Web page

The commands available from this Web page correspond to the Core
Common Equipment data traditionally maintained by using LD 135 - Core
Common Equipment.

To execute status commands using this Web page, follow the steps in
Procedure 20 “Performing Core Common Equipment Status commands”
(page 61).

Procedure 20
Performing Core Common Equipment Status commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a STAT CPU - Core status for both CPUs

b STAT CNI - Status of configured CNI (c=side, s=slot, p=port)

c STAT MEM - Status of SIMMs on both CPs

d STAT EXT - Status of all Extender pair designations

e STAT SUTL - Status of system utility
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2 Enter appropriate Command Parameters wherever applicable.

3 Click Submit.

--End--

To execute CNI commands using this Web page, follow the steps in
Procedure 21 “Performing Core Common Equipment CNI commands ”
(page 62).

Procedure 21
Performing Core Common Equipment CNI commands

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a ENL CNI - Enable CNI card/port (c=side, s=side, p=port)

b DIS CNI - Disable CNI all, card or port

c DSPL - Display active core contents

d DSPL ALL - Display active core contents for all

e IDC CPU - Print card ID for active core

f IDC CNI - Print card ID for CNI on active side

g ENL EXT - Enable specified Extender pair

2 Enter the required parameters in the Commands Parameters
text box.

3 Click Submit.

--End--

To execute test commands using this Web page, follow the steps in
Procedure 22 “Performing Core Common Equipment test commands”
(page 62).

Procedure 22
Performing Core Common Equipment test commands

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a TEST CPU - Test the inactive core

b TEST CNI - Test CNI card/port (c=card, s=slot, p=port)

c TEST IPB - Test backplane on Secondary Interprocessor Bus
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d TEST LCD - Test the LCD display on the active CP card

e TEST LED - Test LEDs

f TEST SUTL - Test system utility

2 Enter appropriate Command Parameters wherever applicable.

3 Click Submit.

--End--

To execute miscellaneous commands using this Web page, follow
the steps in Procedure 23 “Performing Core Common Equipment
miscellaneous commands” (page 63).

Procedure 23
Performing Core Common Equipment miscellaneous commands

Step Action

1 Select one of the following commands from the fourth
Commands drop-down list:

a SCPU - Switch cores

b SPLIT - Put a redundant system into single mode

c CDSP - Clear maintenance displays

d CMAJ - Clear major alarm and reset power fail transfer

e CMIN - Clear the minor alarm for all customers

f CUTOVR - Transfer call processing from active to standby
cores

g JOIN - Synchronize the memory and drives

2 Click Submit.

--End--

To execute status health commands using this Web page, follow the steps
in Procedure 24 “Performing Core Common Equipment status health
commands” (page 63).

Procedure 24
Performing Core Common Equipment status health commands

Step Action

1 Select one of the following commands from the fifth Commands
drop-down list:

a STAT HEALTH HELP - Help for health commands
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b STAT HEALTH - Overall health status

c STAT HEALTH AML - AML health status

d STAT HEALTH DSPDB - DSP Daughterboard health status
(applicable only to systems with Media Gateway Controllers
containing DSP Daughterboards)

e STAT HEALTH IPL - IPL health status

f STAT HEALTH ELAN - ELAN health status

g STAT HEALTH HW - Hardware health status

2 Click Submit.

--End--

To execute Geographic Redundancy commands using this Web page, do
the following:

Procedure 25
Performing Core Common Equipment Geographic Redundancy commands

Step Action

1 Select one of the following commands from the sixth Commands
drop-down list:

a STAT GR - Status of Geographic Redundancy

b TEST GR - Test Geographic Redundancy

c CLR GR - Clear operation for the secondary CS

2 Enter appropriate Command Parameters wherever applicable.

3 Click Submit.

--End--

Core Input/Output Diagnostics
Click the Core Input/Output Diagnostics link in the list of Maintenance
tools to open the Core Input/Output Diagnostics Web page as shown in
Figure 24 "Core Input/Output Diagnostics Web page" (page 65).

This Web page is used to obtain the status of PPP and Ethernet links.
The commands available from this Web page correspond to the tools
traditionally maintained using LD 137 - Core Input/Output Diagnostics.
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Figure 24
Core Input/Output Diagnostics Web page

To perform diagnostic commands using this Web page, follow the steps in
Procedure 26 “Performing Core Input/Output diagnostic commands” (page
65).

Procedure 26
Performing Core Input/Output diagnostic commands

Step Action

1 Use the first Commands drop-down list to perform the following
diagnostic activities:

a STAT - Status of both IOPs and CMDUs and ethernet link

b STAT RDUN - Status of both disks

c STAT FMD - Status of active Fixed Media Devices

d STAT RMD - Status of active Removable Media Devices

2 Click Submit.

3 Use the second Commands drop-down list to perform the
following diagnostic activities:

a DATA RDUN - Sector level check on both hard disks
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b TEST RDUN - Test file level check on both hard disks

4 Click Submit.

5 Use the third Commands drop-down list to perform the following
diagnostic activities:

a IDC - Print IDs of both CMDUs and active IOP

b SDID - Display security device information

6 Click Submit.

--End--

D-channel Diagnostics
Click the D-channel Diagnostics link in the list of Maintenance diagnostic
tools to open the D-Channel Diagnostics Web page as shown in Figure
25 "D-channel Diagnostics Web page" (page 66).

Figure 25
D-channel Diagnostics Web page

This Web page is used to test and maintain D-channel links and D-channel
Interface (DCHI) cards. The commands available from this Web page
correspond to the D-channel data traditionally maintained using the
following overlays:
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• LD 37 - Input/Output Diagnostic

• LD 48 - Link Diagnostic

• LD 96 - D-channel Diagnostic

To execute status commands using this Web page, follow the steps in
Procedure 27 “Performing D-channel status commands” (page 67).

Procedure 27
Performing D-channel status commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a Status for D-Channel (STAT DCH)

b Status for Service Message (STAT SERV)

2 Click Submit.

--End--

To execute disable commands using this Web page, follow the steps in
Procedure 28 “Performing D-channel disable commands” (page 67).

Procedure 28
Performing D-channel disable commands

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a Disable Automatic Recovery (DIS AUTO)

b Disable D-Channel (DIS DCH). Select the ALL check box to
disable all D-Channels.

c Disable Local Loop Back (DIS LLB)

d Disable Remote Loop Back (DIS RLB)

e Disable Test Mode (DIS TEST)

2 Click Submit.

--End--

To execute enable commands using this Web page, follow the steps in
Procedure 29 “Performing D-channel enable commands” (page 68).
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Procedure 29
Performing D-channel enable commands

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a Enable Automatic Recovery (ENL AUTO)

b Enable D-Channel (ENL DCH). To force a loadware
download at the same time, select the FDL check box.

c Enable Local Loop Back (ENL LLB)

d Enable Remote Loop Back (ENL RLB)

e Enable Test Mode (ENL TEST)

2 Click Submit.

--End--

To execute test commands using this Web page, follow the steps in
Procedure 30 “Performing D-channel test commands” (page 68).

Procedure 30
Performing D-channel test commands

Step Action

1 Select one of the following commands from the fourth
Commands drop-down list:

a Test interrupt Generation (TEST 100)

b Test Loop Back (Test 101)

c Test Interrupt Handler (TEST 200)

d Test Interrupt Handler-to-link (TEST 201)

2 Click Submit.

--End--

To execute D-Channel commands using this Web page, follow the steps in
Procedure 31 “Performing D-channel commands” (page 69).
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Procedure 31
Performing D-channel commands

Step Action

1 Select one of the following commands from the fifth Commands
drop-down list:

a EEstablish D-Channel (EST DCH)

b Get Physical Address and switch settings (MAP DCH)

c Reset DCH and Inhibit Signaling (RST DCH)

d Release D-Channel (RLS DCH)

e Switch to Standby D-Channel (SDCH DCH)

2 Click Submit.

--End--

D-Channel Expansion Diagnostics
Click the D-Channel Expansion Diagnostics link in the list of
Maintenance diagnostic tools to open the Link: D-Channel Expansion
Diagnostics Web page as shown in Figure 26 "Link: D-Channel
Expansion Diagnostics Web page" (page 70).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



70 System

Figure 26
Link: D-Channel Expansion Diagnostics Web page

This Web page is used to test and maintain Multipurpose Serial Data Link
(MSDL) cards. The commands available from this Web page correspond
to the MSDL data traditionally configured by using LD 48 - Link Diagnostic.

To perform MSDL diagnostic activities using this Web page, follow the
steps in Procedure 32 “Performing D-channel Expansion MSDL diagnostic
commands” (page 70).

Procedure 32
Performing D-channel Expansion MSDL diagnostic commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a STAT MSDL - Status of MSDL card

b STAT MSDL full - Status MSDL card and available RAM

c SLFT MSDL - Self test on the given MSDL card

d RST MSDL - Power-On rest the given MSDL card
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2 Click Submit.

--End--

To execute disable commands using this Web page, follow the steps in
Procedure 33 “Performing D-channel Expansion disable commands” (page
71).

Procedure 33
Performing D-channel Expansion disable commands

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a DIS MSDL all - Disable the given MSDL card

b DIS MSDL ALL - Disable all ports and then the MSDL card

c DIS MSDL AUDM - Disable MSDL auditing for the MSDL
card

d DIS MSDL DBG - Disable debugger option for the MSDL card

2 Click Submit.

--End--

To execute enable commands using this Web page, follow the steps in
Procedure 34 “Performing D-channel Expansion enable commands” (page
71).

Procedure 34
Performing D-channel Expansion enable commands

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a ENL MSDL - Enable the given MSDL card

b ENL MSDL all - Enable all ports and then the MSDL card

c ENL MSDL AUDM - Enable MSDL auditing for the MSDL
card

d ENL MSDL FDL - Force download loadware to the MSDL
card
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2 Click Submit.

--End--

Digital Trunk Diagnostics
Click the Digital Trunk Diagnostics link in the list of Maintenance
diagnostic tools to open the Digital Trunk Interface and Primary Rate
Interface: Digital Trunk Diagnostics Web page as shown in Figure
27 "Digital Trunk Interface and Primary Rate Interface: Digital Trunk
Diagnostics Web page" (page 72).

Figure 27
Digital Trunk Interface and Primary Rate Interface: Digital Trunk Diagnostics Web page

This Web page is used to test and maintain Digital Trunk Cards. The
commands available from this Web page correspond to the DTI/PRI
data traditionally maintained by using LD 60 - Digital Trunk Interface and
Primary Rate Interface Diagnostics.

Use this Web page to issue maintenance commands on cards, channels,
or routes by using the appropriate command drop-down list and parameter
text box.
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To perform maintenance activities on a Digital Trunk Card using this Web
page, follow the steps in Procedure 35 “Performing maintenance activities
on a Digital Trunk Card” (page 73).

Procedure 35
Performing maintenance activities on a Digital Trunk Card

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a STAT - Get Status of loop(s)

b DISL - Disable network and DTI/PRI cards of loop

c DISI - Disable loop (when all channels are idle

d ENCH - Enable all channels on 2.0 Mb/s DTRI/PRI

e ENLL - Enable network and DTI/PRI cards of loop

f LCNT - List contents of alarm counters on loop(s)

g RCNT - Reset alarm counters of all DTI/PRI loops

h SLFT - Self Test on the loop)

i DSYL - Disable yellow alarm processing for loop

j ENYL - Enable yellow alarm processing for loop

k DLBK - Disable remote loop back test

l RLBK - Close loop at carrier interface point for testing

m RMST - Perform remote loop back test on loop

2 Enter the Loop number in the Command Parameters text box.

3 Click Submit.

--End--

To perform maintenance activities on a Channel belonging to a Digital
Trunk Card using this Web page, follow the steps in Procedure 36
“Performing maintenance activities on a Channel” (page 73).

Procedure 36
Performing maintenance activities on a Channel

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a STAT - Get Status of the channel
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b DSCH - Disable the channel

c ENCH - Enable the channel

d SLFT - Self Test on the channel

e DLBK - Disable remote loop back test on channel

f RLBK - Close channel at carrier interface point

g RMST - Perform far end loop test on Channel

h RSET - Reset thresholds for channel on loop

2 Enter the Loop number and the Channel number, separated by a
space, in the Command Parameters text box.

3 Click Submit.

--End--

To perform maintenance activities on a Digital Trunk Route using this Web
page, follow the steps in Procedure 37 “Performing maintenance activities
on a Digital Trunk Route” (page 74).

Procedure 37
Performing maintenance activities on a Digital Trunk Route

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a LOVF - List Thresholds Overflows for the Route

b CMIN - Clear minor alarm indication for customer

2 Enter the Customer number and the Route number, separated
by a space, in the Command Parameters text box.

3 Click Submit.

--End--

To perform maintenance activities on a card using this Web page, follow
the steps in Procedure 38 “Performing maintenance activities on a card”
(page 74).

Procedure 38
Performing maintenance activities on a card

Step Action

1 Select one of the following commands from the fourth
Commands drop-down list:
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a ATLP - Daily routine automatic card test

b CDSP - Clear maintenance display

2 Enter the 0 or 1 in the Command Parameters text box.

3 Click Submit.

--End--

Digital Trunk Maintenance Diagnostics
Click the Digital Trunk Maintenance Diagnostics link in the list of
Maintenance diagnostic tools to open the Digital Trunk Diagnostics Web
page as shown in Figure 28 "Digital Trunk Diagnostics Web page" (page
75).

Figure 28
Digital Trunk Diagnostics Web page

The commands available from this Web page correspond to the digital
trunk diagnostics traditionally performed by using LD 75 - Digital Trunk
Diagnostics.
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To get status information on a digital trunk using this Web page, follow the
steps in Procedure 39 “Performing status commands on a digital trunk”
(page 76).

Procedure 39
Performing status commands on a digital trunk

Step Action

1 Select one of the following status commands from the first
Commands drop-down list:

a STAT DDCS - Status for all DDCS loops or loop

b STAT DDSL - Status for all DDSLs or DDSL number

c STAT DTCS - Status for all DTCS loops or DTCS loop

d STAT DTRC - Status of RDC on loop

e STAT DTSL - Status of all DTSLs or DTSL number

f STAT DTVC - Status of VDC on loop

g STAT LSSL - Status of LSSL number for APNSS

h STAT LSRC - Status of RDC on Signaling Link number

i STAT LSVC - Status of VDC on Signaling Link number

2 Enter the Loop number in the Command Parameters text box.

3 Click Submit.

--End--

To disable an entity on a digital trunk using this Web page, follow the steps
in Procedure 40 “Performing disable commands on a digital trunk” (page
76).

Procedure 40
Performing disable commands on a digital trunk

Step Action

1 Select one of the following disable commands from the second
Commands drop-down list:

a DIS DDSC - Disable DDSC number

b DIS DDSL - Disable DDSL number

c DIS DTCS - Disable DTCS loop

d DIS DTRC - Disable RDC on Loop

e DIS DTSL - Disable DTSL number
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f DIS DTVC - Disable VDC on loop

g DIS LSSL - Disable LSSL number for APNSS

h DISI DDCS - Disable all Channels on Loop as idle

i DISI DTCS - Disable DTCS loop

2 Enter the appropriate number in the Command Parameters text
box.

3 Click Submit.

--End--

To enable an entity on a digital trunk using this Web page, follow the steps
in Procedure 41 “Performing enable commands on a digital trunk” (page
77).

Procedure 41
Performing enable commands on a digital trunk

Step Action

1 Select one of the following enable commands from the third
Commands drop-down list:

a ENL DDSC - Enable DDSC number

b ENL DDSL - Enable DDSL number

c ENL DTCS - Enable DTCS loop

d ENL DTRC - Enable RDC on Loop

e ENL DTSL - Enable DTSL number

f ENL DTVC - Enable VDC on loop

g ENL LSSL - Enable LSSL number for APNSS

2 Enter the appropriate number in the Command Parameters text
box.

3 Click Submit.

--End--

To perform miscellaneous commands on a digital trunk using this Web
page, follow the steps in Procedure 42 “Performing miscellaneous
commands on a digital trunk” (page 78).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



78 System

Procedure 42
Performing miscellaneous commands on a digital trunk

Step Action

1 Select one of the following enable commands from the fourth
Commands drop-down list:

a CDSP - Clear display on active CPU

b CMIN - Clear minor alarm for all customers

c STRT - Start DDSL number

2 Enter the necessary parameters.

3 Click Submit.

--End--

Emergency Services Diagnostics
Click the Emergency Services Diagnostics link in the list of Maintenance
diagnostic tools to open the Emergency Services Diagnostics Web page
as shown in Figure 29 "Emergency Services Diagnostics Web page" (page
79).
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Figure 29
Emergency Services Diagnostics Web page

To perform Emergency Response Location commands using this Web
page, follow the steps in Procedure 43 “Performing Emergency Response
Location commands” (page 79).

Procedure 43
Performing Emergency Response Location commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a PRT ERL - Print Emergency Response Location

b ENL ERL - Enable ERL

c DIS ERL - Disable ERL

2 Enter the required parameters in the Command Parameters text
box.

3 Click Submit.

--End--
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To perform Subnet Information commands using this Web page, follow the
steps in Procedure 44 “Performing Subnet Information commands” (page
80).

Procedure 44
Performing Subnet Information commands

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a PRT SUBNET - Print Subnet Location

b PRT SUBNET NTH - Print Subnet Locations Starting from
Index #

c PRT SUBNET ERL - Print All Subnet Locations for ERL

d PRT SUBNET ECL - Print All Subnet Locations for ECL

e EST SUBNETLIS - Test Subnet Location

2 Enter the required parameters in the Command Parameters text
box.

3 Click Submit.

--End--

To perform Dynamic Location Identification commands using this Web
page, follow the steps in Procedure 45 “Performing Dynamic Location
Identification commands” (page 80).

Procedure 45
Performing Dynamic Location Identification commands

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a PRT ELIN - Print Dynamic ELIN

b STAT ELIN - Get Status of Dynamic ELIN

c STAT ELIN ACTIVE - Get Status of active Dynamic ELIN

2 Enter the required parameters in the Command Parameters text
box.

3 Click Submit.

--End--
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Ethernet Diagnostics
Click the Ethernet Diagnostics link in the list of Maintenance diagnostic
tools to open the Ethernet Diagnostics Web page as shown in Figure 30
"Ethernet Diagnostics Web page" (page 81).

Figure 30
Ethernet Diagnostics Web page

This Web page is used to maintain Ethernet elements. The commands
available from this Web page correspond to the data traditionally
maintained by using LD 117- Ethernet Quality of Service Diagnostics.

To execute Link status commands, follow the steps in Procedure 46
“Performing Link status commands” (page 81).

Procedure 46
Performing Link status commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a STAT LINK IP - Link Status -- IP
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b STAT LINK SRV - Link Status -- Server

c STAT LINK NAME - Link Status -- Host Name

d STAT LINK NODE - Link Status -- Node ID

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To execute server status commands, follow the steps in Procedure 47
“Performing server status commands” (page 82).

Procedure 47
Performing server status commands

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a STAT SERV - Server Status

b STAT SERV IP - Server Status --IP

c STAT SERV TYPE - Server Status -- Type

d STAT SERV APP - Server Status -- Application

e STAT SERV NAME - Server Status -- Name

f STAT SERV NODE - Server Status -- Node ID

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To execute IP status commands, follow the steps in Procedure 48
“Performing IP status commands” (page 82).

Procedure 48
Performing IP status commands

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a STIP TN - IP Status -- TN
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b STIP TYPE - IP Status -- Type

c STIP ZONE - IP Status -- Zone

d STIP NODE - IP Status -- Node ID

e STIP HOSTIP - IP Status -- Host IP

f STIP ACF - IP Status -- Active Call Failover

g STIP TERMIP - IP Status -- Term IP

h STIP FW - IP Status -- FWID MajorVer MinorVer Filter

i STIP MODL - IP Status -- ModelName

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To execute print commands, follow the steps in Procedure 49 “Performing
print commands” (page 83).

Procedure 49
Performing print commands

Step Action

1 Select one of the following commands from the fourth
Commands drop-down list:

a PRT IPDN - Print DNs with a given IP address

b PRT DNIP Print IP address(es) with a given DN

c PRT IPR - Print information for the given IPMG

d PRT IPMG - Print information for the given IPMG

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To execute Etherset Count commands, follow the steps in Procedure 50
“Performing Etherset Count commands” (page 84).
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Procedure 50
Performing Etherset Count commands

Step Action

1 Select one of the following commands from the fifth Commands
drop-down list:

a ECNT FW - Etherset Count -- FWID MajorVer MinorVer Filter

b ECNT MODL - Etherset Count -- Model

c ECNT PEC - Etherset Count -- PEC

d ECNT ZONE - Etherset Count -- Zone Customer #

e ECNT CARD - Etherset Count -- Loop Shelf Card Customer#

f ECNT NODE - Etherset Count -- Node ID

g ECNT SS - Etherset Count -- HostName

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To execute Reset IP Phone commands, follow the steps in Procedure 51
“Performing Reset IP Phone commands” (page 84).

Procedure 51
Performing Reset IP Phone commands

Step Action

1 Select one of the following commands from the sixth Commands
drop-down list:

a RST ZONE - Reset IP Phone -- Zone START/STOP HH:MM

b RST FW - Reset IP Phone -- FWID START/STOP HH:MM

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To execute IPMG commands, follow the steps in Procedure 52
“Performing IPMG commands” (page 85).
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Procedure 52
Performing IPMG commands

Step Action

1 Select one of the following commands from the seventh
Commands drop-down list:

a STAT IPMG - Print status of the given or all IPMGs

b STAT IPMG SUMMARY - Print status of all IPMGs

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To execute RFC2833 commands, follow the steps in Procedure 53
“Performing RFC2833 commands” (page 85).

Procedure 53
Performing RFC2833 commands

Step Action

1 Select one of the following commands from the eighth
Commands drop-down list:

a STAT RFC2833 - RFC2833 Status - TN

b ENL RFC2833PRT - Enable the info Message Printing

c DIS RFC2833PRT - Disable the info Message Printing

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

Ethernet Quality of Service Diagnostics
Click the Ethernet Quality of Service Diagnostic link in the list of
Maintenancediagnostic tools to open the Ethernet Quality of Service
Diagnostics Web page as shown in Figure 31 "Ethernet Quality of Service
Diagnostics Web page" (page 86).
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Figure 31
Ethernet Quality of Service Diagnostics Web page

This Web page is used to issue commands on elements by using the
appropriate Action drop-down list and the corresponding Zone Number
and Attribute or Level text boxes.

The commands that are available from this Web page correspond to
data traditionally maintained by using LD 117 - Zone Configuration and
Diagnostic.

To perform maintenance activities for Zone Attributes, follow the steps
in Procedure 54 “Performing maintenance activities for Zone Attributes”
(page 86).

Procedure 54
Performing maintenance activities for Zone Attributes

Step Action

1 Select one of the following commands from the Action
drop-down list:

a Print QoS attribute for Zone (PRT AQOS)

b Print Zone IP statistics (PRT ZQOS)
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2 Enter the appropriate value in the corresponding Zone Number
and Attribute text box.

3 Click Submit.

--End--

To perform maintenance activities for Zone Levels, follow the steps in
Procedure 55 “Performing maintenance activities for Zone Levels” (page
87).

Procedure 55
Performing maintenance activities for Zone Levels

Step Action

1 Select one of the following commands from the Action
drop-down list:

a Change Zone Notification Level (CHG ZQNL)

b Print Zone Notification Level (PRT ZQNL)

2 Enter the appropriate value in the corresponding Zone Number
and Level text box.

3 Click Submit.

--End--

Input/Output Diagnostics
Click the Input/Output Diagnostics link in the list of Maintenance
diagnostic tools to open the Input Output Diagnostics Web page as
shown in Figure 32 "Input/Output Diagnostics Web page" (page 88).
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Figure 32
Input/Output Diagnostics Web page

The commands available from this Web page correspond to the
Input/Output diagnostics traditionally performed using LD 37 - Input/Output.

To execute TTY commands, follow the steps in Procedure 56 “Performing
Input/Output TTY commands” (page 88).

Procedure 56
Performing Input/Output TTY commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a STAT TTY - Get status of TTY device(s)

b ENL TTY - Enable TTY

c DIS TTY - Disable TTY

2 Enter the required command parameters in the Command
Parameters text box.
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3 Click Submit.

--End--

To execute Printer commands, follow the steps in Procedure 57
“Performing Input/Output Printer commands” (page 89).

Procedure 57
Performing Input/Output Printer commands

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a STAT PRT - Get status of Printer(s)

b ENL PRT - Enable Printer

c DIS PRT - Disable Printer

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To execute MDSL commands, follow the steps in Procedure 58
“Performing Input/Output MDSL commands” (page 89).

Procedure 58
Performing Input/Output MDSL commands

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a STAT MSDL - Get status of MSDL card(s)

b ENL MSDL - Enable MSDL device

c DIS MSDL - Disable MSDL device

d SLFT MSDL - Self test MSDL device

e RST MSDL - Reset MSDL device

2 Enter the required command parameters in the Command
Parameters text box.
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3 Click Submit.

--End--

To use the miscellaneous commands, do the following:

Step Action

1 Select one of the following commands from the fourth
Commands drop-down list:

a STAT - Get status of all I/O devices in system

b STAT XSM - Get status of the system monitor

c STAT LINK - Get status of CDR data Link(s)

d CMIN - Clear minor alarm for all customers

e CDSP - Clear maintenance display on active CPU

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

Intergroup Switch and System Clock Generator Diagnostics
Click the Intergroup Switch and System Clock Generator Diagnostics
link in the list of Call Server functionalities to open the Intergroup Switch
and System Clock Generator Diagnostics Web page as shown in Figure
33 "Intergroup Switch and System Clock Generator Diagnostics Web
page" (page 91).
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Figure 33
Intergroup Switch and System Clock Generator Diagnostics Web page

The commands available from this Web page correspond to the Intergroup
Switch and System Clock Generator diagnostics traditionally performed
using LD 39.

To use status commands, follow the steps in Procedure 59 “Performing
Intergroup status commands” (page 91).

Procedure 59
Performing Intergroup status commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a STAT FIJI - Status of FIJI on specified Grp, Side

b STAT PER - Status of specified PS card

c STAT SCG - Status of specified SCG card (0 or 1)

d STAT RING - Status of all FIJI cards on specified Ring
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2 Enter the group number and side number in the Command
Parameters text box.

3 Click Submit.

--End--

To use the disable commands, follow the steps in Procedure 60
“Performing Intergroup disable commands” (page 92).

Procedure 60
Performing Intergroup disable commands

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a DIS ALRM - Disable specified Alarm (or all) for FIJI

b DIS FIJI - Disable FIJI in specified Group and Side

c DSPS - Disable specified PS card

d DIS SCG - Disable specified SCG card (0 or 1)

e DIS RING - Disable all FIJI cards on specified Ring

f DIS RALM - Disable all alarms for all RIJI cards in Ring

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To use the enable commands, follow the steps in Procedure 61
“Performing Intergroup enable commands” (page 92).

Procedure 61
Performing Intergroup enable commands

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a ENL ALRM - Enable specified Alarm (or all) for FIJI

b ENL FIJI - Enable FIJI in specified Group and Side

c ENPS - Enable specified PS card

d ENL SCG - Enable specified SCG card (0 or 1)
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e ENL RING - Enable all FIJI cards on specified Ring

f ENL RALM - Enable all alarms for all FIJI cards in Ring

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To use the test commands, follow the steps in Procedure 62 “Performing
Intergroup test commands” (page 93).

Procedure 62
Performing Intergroup test commands

Step Action

1 Select one of the following commands from the fourth
Commands drop-down list:

a TEST 360 - Perform 360 test on FIJI card

b TEST FIJI - Self Test FIJI Card

c TEST BKPL - Test backplane

d TEST CMEM - Test connection memory

e TEST LINK - Perform Link test to identify hardware faults

f TEST ALL - Perform FIJI diagnostic test

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To use the miscellaneous commands, follow the steps in Procedure 63
“Performing Intergroup miscellaneous commands” (page 93).

Procedure 63
Performing Intergroup miscellaneous commands

Step Action

1 Select one of the following commands from the fifth Commands
drop-down list:

a CDSP - Clear Maintenance Display on active CPU

b CMIN - Clear minor alarm for all customers
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c ARCV ON - Set auto-recovery operation for ring

d ARCV OFF - Reset auto-recovery operation for ring

e ALRD ON - Turn on alarm display for all FIJI cards

f ALRD OFF - Turn off alarm display for all FIJI cards

g RSET - Reset thresholds for switchover functionality

h RSTR - Restore Ring(s)

i SCLK - Switchover to the other SCG

j SLCK FRCE - Force clock to switch to other SCG

k SWRG - Switch Call Processing to specified ring

2 If SWRG is selected, enter appropriate Command Parameter.

3 Click Submit.

--End--

MSDL Diagnostics
Click the MSDL Diagnostics link in the list of Maintenance diagnostic tools
to open the Multipurpose Serial Data Link (MSDL) Diagnostics Web
page as shown in Figure 34 "MSDL Diagnostics Web page" (page 95).
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Figure 34
MSDL Diagnostics Web page

The commands available from this Web page correspond to the MSDL
diagnostics traditionally performed by using LD 96 - D-channel.

This Web page is used to perform the following MSDL diagnostic
functions:

• Disable MSDL Device (DIS)

• Enable MSDL Device (ENL)

• Self Test (SLFT)

• Get Status of MSDL Device (STAT)

• Causes Power-On Reset of MSDL Device (RST)

To perform diagnostic activities using this Web page, follow the steps in
Procedure 64 “Performing MSDL diagnostic activities” (page 96).
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Procedure 64
Performing MSDL diagnostic activities

Step Action

1 Select the required Diagnostic Command from the Commands
drop-down list.

2 To update the loadware, select the FDL (Force Download)
check box when the Enable MSDL Device command is selected.

3 To check the status of all MDSL devices, select the Full check
box when the Get Status of MSDL Device command is selected.

4 Enter the required command parameters in the Command
Parameters text box.

5 Click Submit.

--End--

Multifrequency Sender Diagnostics
The Multifrequency Sender Diagnostics Web page is available only on
Large Systems.

Click the Multifrequency Sender Diagnostics link in the list of
Maintenance diagnostic tools to open the Multifrequency Sender
Diagnostics Web page as shown in Figure 35 "Multifrequency Sender
Diagnostics Web page" (page 97).
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Figure 35
Multifrequency Sender Diagnostics Web page

The commands available from this Web page correspond to the
Multifrequency Sender diagnostics traditionally performed by using LD 46.

To use the loop commands, follow the steps in Procedure 65 “Performing
Multifrequency Sender loop commands” (page 97).

Procedure 65
Performing Multifrequency Sender loop commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a STAT - Get Status of MFS loop

b ENLL - Enable loop

c DISL - Disable loop

d MFS - Test and enable MFS loop

2 Enter the required command parameters in the Command
Parameters text box.
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3 Click Submit.

--End--

To use the card commands, follow the steps in Procedure 66 “Performing
Multifrequency Sender card commands” (page 98).

Procedure 66
Performing Multifrequency Sender card commands

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a ENLX - Enable Conf/TDS/MFS card on loop

b DISX - Disable Conf/TDS/MFS card on loop

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit button.

--End--

To use the alarm commands, follow the steps in Procedure 67 “Performing
Multifrequency Sender alarm commands” (page 98).

Procedure 67
Performing Multifrequency Sender alarm commands

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a CMAJ - Clear major alarm and reset power fail

b CDSP - Clear Maint display on active CPU

c CMIN - Clear minor alarm for all customers

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--
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Multifrequency Signaling Diagnostics
Click the Multifrequency Signaling Diagnostics link in the list of
Maintenance diagnostic tools to open the Multifrequency Signaling
Diagnostics Web page as shown in Figure 36 "Multifrequency Signaling
Diagnostics Web page" (page 99).

Figure 36
Multifrequency Signaling Diagnostics Web page

The commands available from this Web page correspond to the
Multifrequency Signaling diagnostics traditionally performed by using LD
54 - Multifrequency Signaling.

To use the card commands, follow the steps in Procedure 68 “Performing
Multifrequency Signaling card commands” (page 99).

Procedure 68
Performing Multifrequency Signaling card commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a STAT - Get status of MFC or MFE card

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



100 System

b DISC - Disable MFC/MFE card

c ENLC - Enable MFC or MFE card

d MIDN - Reset/Initialize all idle MFC or MFE cards

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To use the unit commands, follow the steps in Procedure 69 “Performing
Multifrequency Signaling unit commands” (page 100).

Procedure 69
Performing Multifrequency Signaling unit commands

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a STAT - Get status of specified MFC or MFE unit

b DISU - Disable XMFC/XMFE channel

c ENLU - Enable MFC/MFE channel

d MTST - Invoke loop around test on unit with digit and level

e ATST - Invoke automatic loop test for unit

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To use the miscellaneous commands, follow the steps in Procedure 70
“Performing Multifrequency Signaling miscellaneous commands” (page
100).

Procedure 70
Performing Multifrequency Signaling miscellaneous commands

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a STAT - List all disabled MFC channels in system

b CMIN - Clear minor alarm for all customers
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c CDSP - Clear the mtc display on active CPU

d CMAJ - Clear major alarm and reset power fail transfer

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

Network and Peripheral Equipment Diagnostics
Click the Network and Peripheral Equipment Diagnostics link in the
list of Maintenance diagnostic tools to open the Network & Peripheral
Diagnostics Web page as shown in Figure 37 "Network and Peripheral
Diagnostics Web page" (page 101).

Figure 37
Network and Peripheral Diagnostics Web page

This Web page is used to test and maintain network and peripheral
equipment. The commands available from this Web page correspond
to the data traditionally maintained by using the LD 32 - Network and
Peripheral Equipment Diagnostic.
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These commands are split among separate drop-down lists, grouped by
equipment type.

The command lists are as follows:

• Loop Commands

— Network Loop

– ENLL - Enable network loop

– DISL - Disable network loop

— Super Loop

– STAT - Get status of Superloop

– SUPL - Print data for one or all Superloops

– IDC - Print Card ID for Superloop and associated Controller

– XNTT - Do self-test of Network card for specified Superloop

– ENLL - Enable specified Superloop

– XRST - Reset the specified Superloop

• Shelf Commands

— DISS - Disable module (Small System) Disable the shelf (Large
System)

— ENLS - Enable module (Small System) Enable specified shelf
(Large System)

— LBSY - List TNs of all busy units

— LDIS - List TNs of all disabled units

— LIDL - List TNs of all idle units

— LMNT - List TNs of all maint. busy units

• Card Commands

— General Card Commands

– STAT - Get card status

– ENLC - Enable and reset card

– DISC - Disable card (Small System). Disable peripheral card
(Large System)

– IDC - Print card ID (Small System). Print card ID for PE card
(Large System)

— MISP Card Commands

– STAT - Print status of MISP appl/card

– ENLL - Enable MISL loop
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– ENLL BRIL - Enable BRIL application on MISP loop

– ENLL BRIT - Enable BRIT application on MISP loop

– IDC - Print MISP card ID

– DISL - Disable MISP loop

– DISL BRIL - Disable BRIL application on MISP loop (Large
System)

– DISL BRIT - Disable BRIT application on MISP loop

– DISL BRIE - Disable BRIE application on MISP loop

— BRI BRSC Card Commands

– STAT - Get status of BRI card

– IDC - Print BRSC card and LW version

– DISC BRI - Disable the BRSC BRI application

– DISC - Disable specified card

– ENLC BRI - Enable the BRSC BRI application

– ENLC - Enable specified card

— PS Card Commands

– STAT PER - Get status of PS card

– ENPS - Enable PS card and associated loops

– DSPS - Disable Peripheral Signaling card

— Network Card Commands

– STAT NWK - Check status of N/W card with specified loop

– ENLN - Enable network card with specified loop

– DISN - Disable network card with specified loop

— XPEC Controller Commands

– XPEC - Print data for all or specified Controller(s)

– ENXP - Enable Controller and associated cards

– ENXP XPC - Enable Controller, not the associated cards

– DSXP - Disable Controller and all connected cards

– XPCT - Self-test on Controller

– IDCS - Print card ID for cards

• Unit Commands

— General Unit Commands

– STAT - Get unit status

– ENLU - Enable unit
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– IDU - Print set ID

– DISU - Disable unit

– STAT VTRM - Display virtual trunk unit status

• M39XX Unit Commands

— FDLC - Cancel/stop flash download for M39xx

— FDLU - Conditional download to one M39xx

— FWVU - Print firmware versions on M39xx

— FSUM - Print firmware versions on M39xx

• DSL Commands

— STAT - Get status of SILC or UILC

— ENL AUTO - Enable automatic link recovery

— ENRB - Enable Remote Loop Back for DSL

— DIS AUTO - Disable automatic link recovery

— DISU - Disable the DSL

— DSRB - Disable Remote Loop Back for DSL

— IDC - Print SILC/UILC card ID

— PERR - Print protocol log for the card

— DISC - Disable SILC/UILC card

— FDIS NCAL - Force disconnect the connection

— STAT NCAL - List all current connections - DSL

— PCON - Print configuration and LAPD parameters for specified DSL

— DISI - Disable the card when idle

— DSTS - Disable Disable Remote Loop Back test mode

— ENLC - Enable SILC/UILC card

— EISI - Enable the card when idle

— EISU - Enable specified DSL

— ESRB - Enable Remote Loop Back

— ESTS - Enable Remote Loop Back test mode

— ESTU - Establish D Channel Link

— PLOG - Print protocol log

— PMES - Print Layer 3 message log

— PTAB - Upload and Print Layer 3 message configuration

— PTRF - Print traffic data
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— RLBT - Perform Remote Loop Back test

— RLSU - Release D Channel Link

• Application Commands

— DISL BRIL - Disable and remove BRIL application from MISP card

— DISL BRIT - Disable and remove BRIT application from MISP card

— DISL BRIE - Disable and remove BRIE application from MISP card

— ENLL BRIL - Enable BRI application on MISP Card and force
download of the loadware

— ENLL BRIT - Enable BRIT application on MISP card and force
download of the loadware

— ENLL BRIE - Enable BRIE application on MISP card and force
download of the loadware

— DIS BRIL - Disable BRIL application on MISP Card

— DIS BRIT - Disable BRIT application on MISP Card

— DIS BRIE - Disable BRIE application on MISP Card

— PERR BRIL - Upload error log for BRIL application on MISP Card

— PERR BRIT - Upload error log for BRIT application on MISP Card

— PERR BRIE - Upload error log for BRIE application on MISP Card

— PERR BRIL - Print protocol log for BRIL application on MISP Card

— PERR BRIT - Print protocol log for BRIT application on MISP Card

— PERR BRIE - Print protocol log for BRIE application on MISP card

— STAT BRIL - Get status of MISP card and BRIL application

— STAT BRIT - Get status of MISP card and BRIT application

— STAT BRIE - Get status of MISP card and BRIE application

Use this Web page to issue diagnostic commands on the network and
peripheral equipment by using the appropriate Diagnostic Commands
drop-down list and the corresponding Command Parameters text box.
The required parameters for the selected command are indicated to
the right of the Command Parameters text box after the command is
selected.

To perform maintenance activities using this Web page, follow the steps in
Procedure 71 “Performing Network and Peripheral maintenance activities”
(page 106).
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Procedure 71
Performing Network and Peripheral maintenance activities

Step Action

1 Select a command from one of the Diagnostic Commands
drop-down lists.

2 Enter the appropriate value in the corresponding Command
Parameters text box. The required parameters for the
selected command are indicated to the right of the Command
Parameters box once the command is selected.

3 Click the corresponding Submit button.

--End--

Network and Signaling Diagnostics
Click the Network and Signaling Diagnostics link in the list of
Maintenance diagnostic tools to open the Network & Signaling
Diagnostics Web page as shown in Figure 38 "Network and Signaling
Diagnostics Web page" (page 106).

Figure 38
Network and Signaling Diagnostics Web page
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The commands available from this Web page correspond to the Network
and Signaling diagnostics traditionally performed by using LD 30 - Network
and Signaling.

This Web page is used to perform the following Network and Signaling
diagnostic functions:

• Loop Commands

— ENLL - Enable network loop

— DISL - Disable loop

— LDIS - List disabled loops

— LENL - List enabled loops

— LOOP - Test network memory on loop(s)

— STAT - Get status of all/specified N/W loops

— TTSM - Test TSM of a loop

• Shelf/Card/Unit Commands

— UNTT - Signaling test on specified card or unit

— SHLF - Test loop l, shelf s (Large System)

— CPED - Clear contents of ctrlr maint display (Large System)

— RPED - Read contents of ctrlr maint display (Large System)

— TTWI - Test TSM of the N/W card (Large System)

• BRI Commands

— SLFT - Selftest on ISDN BRI line card

— SLFT - Selftest ISDN BRI line card (Large System)

— SLFT - Selftest on MISP card

— STEI - Query Term Edpt Identifiers and USIDs (Large System)

— TEIT - Perform TEI check on DSL

• Superloop Commands

— ENLL - Enable specified Superloop

— DISL - Disable specified Superloop

— ENLL - Enable sl, download periph s/w ver

• Alarm Commands

— CMAJ - Clear major alarm and reset power fail

— CDSP - Clear Maint display on active CPU

— CMIN - Clear minor alarm for all customers
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To perform diagnostic activities using this Web page, follow the steps in
Procedure 72 “Performing Network and Signaling diagnostic activities”
(page 108).

Procedure 72
Performing Network and Signaling diagnostic activities

Step Action

1 Select the required Diagnostic Command from the drop-down
list.

2 Enter any required Command Parameters. The required
parameters for the selected command are indicated to the right
of the Command Parameters text box once the command is
selected.

3 Click Submit.

--End--

TMDI Diagnostics
T1 Multipurpose Digital Interface (TMDI) cards are used only in CS
1000MSmall Systems. Click the TMDI Diagnostics link in the list of Call
Server diagnostic tools to open the TMDI Diagnostics Web page as
shown in Figure 39 "TMDI Diagnostics Web page" (page 109).
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Figure 39
TMDI Diagnostics Web page

This Web page is used to test and maintain TMDI (DTI/PRI/DCH) cards.
The commands available from this Web page correspond to the TMDI data
traditionally configured by using LD 96 - D-channel.

To perform diagnostic activities using this Web page, follow the steps in
Procedure 73 “Performing TMDI diagnostic activities” (page 109).

Procedure 73
Performing TMDI diagnostic activities

Step Action

1 Select one of the following Actions from the Commands
drop-down list:

a Enable TMDI Card (ENL)

b Disable TMDI card (DIS)

c Reset TMDI card (RST)

d Self Test on TMDI Card (SLFT)

e Get TMDI Status (STAT)

2 Select one of the following Command Parameters:

a FDL
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b FULL

c ALL

3 Click Submit.

--End--

Tone and Digit Switch Diagnostics
Click the Tone and Digit Switch Diagnostics link in the list of
Maintenance diagnostic tools to open the Tone and Digit Switch and
Digitone Receiver Diagnostics Web page as shown in Figure 40 "Tone
and Digit Switch and Digitone Receiver Diagnostics Web page" (page
110).

Figure 40
Tone and Digit Switch and Digitone Receiver Diagnostics Web page

This Web page is used to execute tone, digit switch, and digitone receiver
diagnostics. The commands available from this Web page correspond to
the TMDI data traditionally configured by using LD 34 - Tone and Digital
Switch.
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To perform diagnostic activities using this Web page, follow the steps in
Procedure 74 “Performing Tone and Digit diagnostic activities” (page 111).

Procedure 74
Performing Tone and Digit diagnostic activities

Step Action

1 Select one of the following commands from the Diagnostic
Commands drop-down lists:

• Loop Commands

— STAT - Get status TDS loop

— DISL - Disable tone and digit loop

— DISX - Disable Conf/TDS/MFS card on loop l and l + 1

— ENLX - Enable Conf/TDS/MFS card on loop l and l + 1

— ENLL - Enable tone and digit loop

— MFR - Test ANI Feature Group D Multifrequency receiver
units

— TDS - Test outpulsers and channels on loop

• Card and Unit Commands

— SDTR - Get status of DTR/MFR or XDT card/unit

— DISR - Disable specified TDS/MFS card/unit

— ENLR - Enable the DTR/MFR card/unit

— DTR - Test specified Digitone receiver card/unit

— MFR - Test ANI Multifrequency Card/Unit

• Miscellaneous Commands

— ENLM - Enable all the TDS loops of the given IPMG

— DISM - Disable all the TDS loops of the given IPMG

— CMIN - Clear the minor alarm for all customers

— CDSP - Clear the mtc display on active CPU

— CMAJ - Clear major alarm and reset power fail transfer

— MFR - Test all ANI Feature Group D MFR receiver units

2 Enter any required Command Parameters. The required
parameters for the selected command are indicated to the right
of the Command Parameters text box once the command is
selected.

3 Click the corresponding Submit button.

--End--
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Trunk Diagnostics
Click the Trunk Diagnostics link in the list of Maintenance diagnostic
tools to open the Trunk Diagnostics Web page as shown in Figure 41
"Trunk Diagnostics Web page" (page 112).

Figure 41
Trunk Diagnostics Web page

This Web page is used to test and maintain trunk cards. The commands
available from this Web page correspond to the data traditionally
maintained by using LD 36 - Trunk Diagnostic.

To use the card commands, follow the steps in Procedure 75 “Performing
Trunk card commands” (page 112).

Procedure 75
Performing Trunk card commands

Step Action

1 Select one of the following commands from the first Commands
drop-down list:

a STAT - Get card status
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b ENLC - Enable and reset card

c DISC - Disable card

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To use the unit commands, follow the steps in Procedure 76 “Performing
Trunk unit commands” (page 113).

Procedure 76
Performing Trunk unit commands

Step Action

1 Select one of the following commands from the second
Commands drop-down list:

a ENLU - Enable unit

b LDIC - Number of days since last inc. call

c DISU - Disable unit

d RSET - Reset thresholds for the trunk

e TPPM - Test the specified PPM trunk

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To use the customer route commands, follow the steps in Procedure 77
“Performing Trunk customer route commands” (page 113).

Procedure 77
Performing Trunk customer route commands

Step Action

1 Select one of the following commands from the third Commands
drop-down list:

a LDIC - List days since last incoming call for customer

b LMAX - List trunk with max idle days for customer

c LNDS - List trunks with no disconnect sup. for customer
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d LOVF - List threshold overflows for customer

e RAN - Test recorded announcement device

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

To use the miscellaneous commands, follow the steps in Procedure 78
“Performing Trunk miscellaneous commands” (page 114).

Procedure 78
Performing Trunk miscellaneous commands

Step Action

1 Select one of the following commands from the fourth
Commands drop-down list:

a CMIN - Clear minor alarm for all customers

b CDSP - Clear the mtc display on active CPU

2 Enter the required command parameters in the Command
Parameters text box.

3 Click Submit.

--End--

Zone Diagnostics
Click the Zone Diagnostics link in the list of Maintenance diagnostic tools
to open the Maintenance Commands for Zones Web page as shown in
Figure 42 "Maintenance Commands for Zones Web page" (page 115).
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Figure 42
Maintenance Commands for Zones Web page

This Web page is used to enable and disable zones and to view various
parameters, properties, and behaviors associated with the configured
zones. The commands available from this Web page correspond to
the data traditionally maintained by using LD 117 - Ethernet and Alarm
Management.

This Web page also includes a table that shows the status and settings for
the configured zones.

To perform maintenance activities using this Web page, follow the steps in
Procedure 79 “Performing Zone maintenance activities” (page 115).

Procedure 79
Performing Zone maintenance activities

Step Action

1 Select one of the following commands from the Actions
drop-down list:

a Print Intrazone Statistics per Local Zone (PRT INTRAZONE)
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b Print Bandwidth Property (PRT ZBW)

c Print Description (PRT ZDES)

d Print Dialing Plan and Access Codes (PRT ZDP)

e Print Time Change property (PRT ZTP)

f Show Branch Office Behaviour (STAT ZBR)

g Show Status (STAT ZONE)

h Enable a Zone (ENL ZONE)

i Disable a Zone (DIS ZONE)

j Enable a Zone’s Branch Office Behaviour (ENL ZBR)

k Disable a Zone’s Branch Office Behaviour (DIS ZBR)

l Print Adaptive Network Bandwidth Management and CAC
Parameters (PRT ZCAC)

m Print Interzone Statistics (PRT INTERZONE)

n Reset CAC Statistics (CLR CACR)

o Print Zone Alternate Prefix Information (PRT ZALT)

p Show Alternate Routing Status (STAT ZALT)

q Print Alarm Suppression Time Period (PRT ZAST)

2 Select the Zone Number assigned to a configured zone from
the drop-down list.

3 Click Submit.

--End--

Loops (Common Equipment)
To configure or edit Loops (Common Equipment) information, click the
Core Equipment > Loops link of theSystem branch of the Element
Manager navigator. The Common Equipment Web page opens (see
Figure 43 "Common Equipment Web page" (page 117)).
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Figure 43
Common Equipment Web page

The Common Equipment Web page contains buttons that act as links
to additional Web pages. The following functions can be performed from
these pages:

• add and delete Tone and Digit Switch (TDS) numbers

• add and delete Digital Trunk Interface Loop (DLOP) numbers

• add and delete Conference loop (CONF) numbers

• configure parameters for the following Feature Packages:

— Integrated Digital Access (Package 122)

— 2 Mbit Digital Trunk Interface (Package 129)

— Dial Tone Detection (Package 138)

— 2.0 Mb/s Primary Rate Interface (Package 154)

The information entered in this section corresponds to CEQU (Common
Equipment) data traditionally configured using LD 17 - Configuration
Record 1.
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To save changes made in this section, click Submit at the bottom of the
Common Equipment Web page.

Superloops
To configure or edit Superloop information, click the Core Equipment >
Superloop link of theSystem branch of the Element Manager navigator.
The Superloops Web page opens as shown in Figure 44 "Superloops
Web page" (page 118).

Figure 44
Superloops Web page

The information entered on this Web page corresponds to the Superloop
(SUPL) command available in LD 97 - Configuration Record 2.

To add a Superloop, choose a Superloop Number and type (CARR,
FIBR, IPMG, STD, Phantom, or Virtual) from the pull-down menu, then
click to Add. The Superloop Property Configuration Web page displays,
as shown in Figure 45 "Superloop Property Configuration Web page"
(page 119).
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Figure 45
Superloop Property Configuration Web page

To save changes made in the Superloop properties, click Save at the
bottom of the Web page.

To return to the Superloops Web page as shown in Figure 44
"Superloops Web page" (page 118), click the Superloop link in the
navigation path at the top of the page.

To edit the properties of an existing Superloop, click the Edit button next
to the Superloop entry on the Superloops Web page. The Superloops
Property Configuration Web page for that Superloop opens.

To save changes made in the Superloop properties, click Save at the
bottom of the Web page.
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MSDL/MSIP Cards
The Multipurpose Serial Data Link / Multi-Purpose ISDN Signaling
Processor (MSDL/MSIP) Cards navigation link opens the Fast Download
Control Web page, as shown in Figure 46 "Fast Download Control Web
page" (page 120).

Figure 46
Fast Download Control Web page

The Fast Download Control Web page appears only for large systems.
The page displays the table with the card type and the download type. The
download type for any card can be changed.

To configure download type for a single card, follow the steps in Procedure
80 “Editing Fast Download Control (single card)” (page 120).

Procedure 80
Editing Fast Download Control (single card)

Step Action

1 From the Fast Download Control Web page, click on the card
you want to edit. The Edit Web page for the selected card
opens.

2 Choose the Download type from the drop-down menu list.

3 Click Save or click Cancel to return to the Fast Download
Control Web page.

--End--
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To configure download type for all cards, follow the steps in Procedure 81
“Editing Fast Download Control (all cards)” (page 121).

Procedure 81
Editing Fast Download Control (all cards)

Step Action

1 From the Fast Download Control Web page, click Edit All to
edit all the cards in the list. The Edit All Web page opens.

2 Choose the Download type from the drop-down menu list.

3 Click Save or click Cancel to return to the Fast Download
Control Web page.

--End--

Conference/TDS/Multifrequency Cards
Click on the Conference/TDS/Multifrequency Cards link of the Element
Manager Navigator to open the Conference/TDS/Multifrequency Cards
Web page, as shown in Figure 47 "Conference/TDS/Multifrequency Cards
Web page" (page 121).

Figure 47
Conference/TDS/Multifrequency Cards Web page

Select a Conference Pad from the drop down list, enter a Dual Tone
Multifrequency value and click Save or click Cancel to return to the
System Overview Web page.

Tone Senders and Detectors
Element Manager supports the configuration of Digitone receivers, Tone
Detectors, and Multi Frequency Senders and Receivers. Click the Core
Equipment > Tone Senders And Detectors link in the System branch of
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the Element Manager navigator. The Tone Senders And Detectors Web
page opens, as shown in Figure 48 "Tone Senders and Detectors Web
page" (page 122).

Figure 48
Tone Senders and Detectors Web page

Digitone Receivers
To display details of and to configure Digitone Receivers, from the Tone
Senders And Detectors Web page, click the Digitone Receivers
link. The Digitone Receivers Web page opens, as shown in Figure 49
"Digitone Receivers Web page" (page 122).

Figure 49
Digitone Receivers Web page
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This Web page is used to display details of Digitone Receivers. Users can
view, add, delete, and move Terminal Numbers.

To delete a Digitone Receiver, select the radio button beside the Terminal
Number and click Delete.

To add a Digitone Receiver, click Add. The Add Digitone Receiver Web
page opens, as shown in Figure 50 "Add Digitone Receiver Web page"
(page 123).

Figure 50
Add Digitone Receiver Web page

Enter the Terminal Number of the Digitone Receiver to be added and click
Save.

To move a Digitone Receiver card from one terminal to another, from
the Digitone Receivers Web page, select the radio button beside the
Terminal Number and click Move. The Move Digitone Receiver Web
page opens, as shown in Figure 51 "Move Digitone Receiver Web page"
(page 124).
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Figure 51
Move Digitone Receiver Web page

Enter the Destination Terminal Number and click Save.

To delete a Digitone Receiver, select the radio button beside the Terminal
Number and click Delete.

Multi Frequency Receivers
To display details of and to configure Multi Frequency Receivers, from
the Tone Senders And Detectors Web page, click the Multi Frequency
Receivers link. The Multi Frequency Receivers Web page opens, as
shown in Figure 52 "Multi Frequency Receivers Web page" (page 124).

Figure 52
Multi Frequency Receivers Web page

This Web page is used to display details of Multi Frequency Receivers.
Users can view, add, delete, and move Terminal Numbers.

To delete a Multi Frequency Receiver, select the radio button beside the
Terminal Number and click Delete.
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To add a Multi Frequency Receiver, click Add. The Add Multi Frequency
Receiver Web page opens, as shown in Figure 53 "Add Multi Frequency
Receiver Web page" (page 125).

Figure 53
Add Multi Frequency Receiver Web page

Enter the Terminal Number of the Multi Frequency Receiver to be added
and click Save.

To move a Multi Frequency Receiver card from one terminal to another,
from the Multi Frequency Receivers Web page, select the radio button
beside the Terminal Number and click Move. The Move Multi Frequency
Receiver Web page opens, as shown in Figure 54 "Move Multi Frequency
Web page" (page 125).

Figure 54
Move Multi Frequency Web page
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Enter the Destination Terminal Number and click Save.

Class Modem Units
To display details of and to configure Class Modem Units, from the Tone
Senders And Detectors Web page, click the Class Modem Units link.
The Class Modem Units Web page opens, as shown in Figure 55 "Class
Modem Units Web page" (page 126).

Figure 55
Class Modem Units Web page

This Web page is used to display details of Class Modem Units. Users can
view, add, delete, and move Terminal Numbers.

To delete a Class Modem Unit, select the radio button beside the Terminal
Number and click Delete.

To add a Class Modem Unit, click Add. The Add Class Modem Unit Web
page opens, as shown in Figure 56 "Add Class Modem Unit Web page"
(page 127).
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Figure 56
Add Class Modem Unit Web page

Enter the Terminal Number of the Class Modem Unit to be added and
click Save.

To move a Class Modem Unit card from one terminal to another, from
the Class Modem Unit Web page, select the radio beside the Terminal
Number to move and click Move. The Move Class Modem Units Web
page opens, as shown in Figure 57 "Move Class Modem Units Web page"
(page 127).

Figure 57
Move Class Modem Units Web page

Enter the Destination Terminal Number and click Save.
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Extended Dial Tone Detectors
To display details of and to configure Extended Dial Tone Detectors, from
the Tone Senders And Detectors Web page, click the Extended Dial
Tone Detectors link. The Extended Dial Tone Detectors Web page
opens, as shown in Figure 58 "Extended Dial Tone Detectors Web page"
(page 128).

Figure 58
Extended Dial Tone Detectors Web page

This Web page is used to display details of Extended Dial Tone Detectors.
Users can view, add, delete, and move Terminal Numbers.

To delete an Extended Dial Tone Detector, select the radio button beside
the Terminal Number and click Delete.

To add an Extended Dial Tone Detector, click Add. The Add Extended
Dial Tone Detector Web page opens, as shown in Figure 59 "Add
Extended Dial Tone Detector Web page" (page 129).
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Figure 59
Add Extended Dial Tone Detector Web page

Procedure 82
Adding an Extended Dial Tone Detector

Step Action

1 Enter the Terminal Number of the Extended Dial Tone Detector.

2 Select the Extended Tone Detector Table from the drop-down
list.

3 Check the box beside Dial Tone Detection, if required.

4 Click Save.

--End--

To move an Extended Dial Tone Detector card from one terminal to
another, from the Extended Dial Tone Detectors Web page, select the
radio button beside the Terminal Number to move and click Move. The
Move Extended Dial Tone Detectors Web page opens, as shown in
Figure 60 "Move Extended Dial Tone Detectors Web page" (page 130).
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Figure 60
Move Extended Dial Tone Detectors Web page

Enter the Destination Terminal Number and click Save.

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



131
.

IP Network

Contents
This section contains information on the following topics:

“Introduction” (page 131)

“IP Network” (page 131)

“Node Configuration” (page 131)

“Nodes: Servers, Media Cards” (page 139)

“Media Gateways” (page 149)

“32 Channel Secure Media Card (MC32S) commands” (page 154)

“Zones” (page 161)

“Network Address Translation (NAT)” (page 169)

“Quality of Service Thresholds (QoS)” (page 170)

“Personal Directories” (page 172)

“Interfaces” (page 172)

“Engineered Values” (page 175)

“Emergency Services” (page 181)

“Geographic Redundancy” (page 196)

“Software” (page 198)

Introduction
The IP Network link of the System branch of the Element Manager
navigator enables the user to view the version of software that is installed
on the elements.

IP Network
Node Configuration

To configure or edit Node Summary information, select the Nodes:
Servers, Media Cards link in the IP Network branch of the Element
Manager navigator. The Node Configuration Web page opens (see
Figure 61 "Node Configuration Web page" (page 132)).
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Figure 61
Node Configuration Web page

This Web page also contains buttons that link to additional Web pages.
Follow these links to:

• add a new node

• import node files

• edit node configuration

• view the status of a previous transfer operation, or re-transfer to
selected or failed elements

• delete a node

• add and edit Voice Gateway Channel (VGWC) configuration data on
the media cards

ATTENTION
Make sure that the values for the Node ID in Element Manager/IP Telephony
and in the Call Server/Route Data Block (for the Virtual Trunk) are the same.
If these Node ID values do not match, the IP Peer H.323 virtual trunks do not
establish.

To import a node file, follow the steps in Procedure 83 “Importing node
files” (page 133):
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Procedure 83
Importing node files

Step Action

1 Click Import Node Files.

2 Enter the ELAN (management LAN) network interface IP
Address of the Leader in the text box. This address is used to
retrieve the node files.

3 Click Import.

If the import is successful, information appears in the text area of
the Node Import Files screen and a message box appears.

4 In the message box, click OK to proceed to the Node Summary
Web page, where edit node information can be viewed.

--End--

If any element within the Node fails to transfer either bootp or config files,
the TRANSFER/STATUS button is highlighted in red. It is not necessary
to manually retransfer the files; the next time the pbxlink is opened to
that element, the files are updated. The TRANSFER/STATUS button
is highlighted in yellow if the transfer status of the node elements is
unavailable. Clicking this button opens the Transfer/Status Web page as
shown in Figure 62 "Transfer/Status Web page" (page 134).
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Figure 62
Transfer/Status Web page

This Web page displays the previous status of the node, and the failure
reason for elements in nodes that failed to retrieve configuration files
(bootp.tab and config.ini) from the Call Server side. Node elements that
did not retrieve configuration files continue to display on the transfer
progress status Web page when the IP Telephony node configuration file
is submitted and transferred.

The Transfer/Status Web page displays two buttons:

• Transfer to Selected Elements — re-transfers node configuration files
only to selected elements, regardless of a "Transfer Failed" state.

• Transfer to Failed Elements — transfers node configuration files to
elements in a "Transfer Failed" state.

Note: The Transfer to Failed Elements button appears only
when at least one element on the node failed to transfer either a
bootp.tab or config.ini file in the previous operation. See Figure 63
"Transfer/Status Web page - Failed" (page 135).
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Figure 63
Transfer/Status Web page - Failed

Note: To ensure the element has correct configurations, when an
element is deleted, it should be reconfigured in a mode with relevant
necessary configurations, or physically removed from the network.

To edit the configuration information on an existing node, click Edit located
to the right of the node’s IP address.

To add a new node, enter a number in the New Node text box, and click
Add.

When clicking either the Add button or any of the Edit buttons shown in
the Node Summary Web page, the Edit Web page opens. See, Figure 64
"Edit Web page" (page 136).
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Figure 64
Edit Web page

From this Web page, the following functions can be performed:

• view and edit basic Node information

• view and configure VGW Profile data

• configure Quality of Service (QoS) data

• use LAN configuration to configure the ELAN Call Server IP Address,
the Media Gateway IP Address, the ELAN and TLAN signaling ports
and the ELAN and TLAN broadcast ports
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• view and edit Simple Network Time Protocol (SNTP) Server and Client
information

• view and configure file server access for downloading firmware for the
IP Phones

• monitor Virtual Trunk Network Health Configuration

• view and edit H.323 Settings

• view and edit SIP Gateway Settings, and configure the Re-direct
Server

• perform SIP URI DN Mapping

• view and configure SIP CD Services

• view and configure SIP CTI Services

• edit Converged Desktop Service information

• Microsoft Unified Messaging. For more information, see
Communications Server 1000 and Microsoft Exchange Server 2007
Unified Messaging Fundamentals (NN43001-122) ()

• view and edit Signaling Server information

• view and edit card properties of Voice Gateway Media Cards

For more information, see Transmission Parameters Reference
(NN43001-282)

ATTENTION
Do not assign the same IP address for the Node ID and the TLAN network
interface. The correct IP address must be verified manually. The Node IP
address must be on the same subnet as the TLAN network interface IP
addresses of the Voice Gateway Media Cards. Also, the Voice Gateway Media
Card’s TLAN and ELAN network interfaces must reside on separate logical
subnets.

The IP Telephony Node Edit Web page does not support multiple
customers per node. SIP Converged Desktop Service and SIP URI to
DN Mapping are configurable on a per-node basis. Only one customer is
supported per node.

Enabling SIP
Click the plus sign to the left of the Signaling Servers link on the Edit
Web page (seeEdit Web page ). Double-click the Signaling Server IP
address. The Signaling Server Properties Web page opens (see Figure
65 "Signaling Server Properties Web page" (page 138)).
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Figure 65
Signaling Server Properties Web page

Choose a mode from the following options in the Enable IP Peer
Gateway (Virtual trunk TPS) drop-down list:

• None

• H.323 only

• SIP only

• H.323 and SIP

Enter the Local SIP Port, SIP Domain name, and SIP Gateway User user
name and password.

When the administrator edits the Node and clicks Save and Transfer,
transfer status information is updated and displayed.
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Detailed procedures for performing these tasks are included in IP Peer
Networking Installation and Commissioning (NN43001-313) () .

Note: The configuration of static Loss Plan values is performed using
LD 73 instead of Element Manager. A Dynamic Loss Plan has been
implemented to define the loss value per endpoint connection type. The
loss plan adjusts the Voice Gateway Media Card gateway channel’s
loss for each call by sending pad values to the card.

Default values
The default values in the system are for the North American loss plan.

Non-North American countries
Installation of IP Line 5.5 in countries other than North American countries
requires setting the pad values to that country’s loss plan. If the system is
installed in other countries, the Global PRI package (International 1.5/2.0
Mb/s Gateway package 167) must be used, and the NTP-specified values
must be entered in LD 73. At the PDCA prompt, enter Table 15.

For more information about configuring Loss Plans, see Transmission
Parameters Reference (NN43001-282) () .

Note: When a system is installed in the UK, the CLI command
UKLossPlanSet is entered at the CLI of one card in each node. This
adjusts the loss plan of the IP Phones to the higher transmit levels
required in the UK. For more information, see IP Line Fundamentals
(NN43100-500) () .

Nodes: Servers, Media Cards
Click the IP Network > Maintenance and Reports link in the System
branch of the Element Manager navigator to open the Node Maintenance
and Reports Web page, as shown in Figure 66 "Node Maintenance and
Reports Web page" (page 140).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



140 IP Network

Figure 66
Node Maintenance and Reports Web page

This Web page contains information on configured Signaling Servers and
IP Telephony cards and is arranged by node. Click the plus sign (+)
beside the Node ID number to view the elements assigned to the node.

For more information about IP Telephony, see IP Line Fundamentals
(NN43100-500) () .

Six buttons are located to the right of the TN column for each IP
Telephony element:

• GEN CMD — Launches the General Commands Web page.

• RPT LOG — Launches the Report Utility Web page (for Signaling
Servers) or SYS LOG — Launches the System log file Web page (for
IP Telephony Cards).

• OM RPT — Launches the Operational Management Report Web
page.

• Reset — Resets the element.

Note: When resetting the Signaling Server on which the Web server
is located, wait approximately five minutes before logging in again.

• Virtual Terminal— Opens a Telnet connection to the element over
the Telephony Local Area Network (TLAN) subnet using the element’s
IP Address.

• Status — Displays the status of the element.
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General Commands
Click the GEN CMD button, located beside the information for an IP
Telephony element as shown in Figure 66 "Node Maintenance and
Reports Web page" (page 140), to open the General Commands Web
page for that element. See Figure 67 "General Commands Web page"
(page 141).

Figure 67
General Commands Web page

From this Web page, users can issue commands to selected groups.

To issue an IP Line application command:

Step Action

1 Select a group from the left-hand Group drop-down list.
The corresponding commands for that group display in the
Command drop-down list.

2 Select a Command from the Command drop-down list.

3 Click Run.

The results appear in the box at the bottom of the Web page.

--End--
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Detailed procedures for issuing General Commands can be found in IP
Line Fundamentals (NN43100-500) () .

Commands related to the node password include:

• nodePwdDisable - disables the node password

• nodePwdEnable - enables the node password

• nodePwdShow - displays the node password

• nodeTempPwdClear - clears the temporary node password

• nodePwdSet — sets the node password

• nodeTempPwdSet — sets the temporary node password

Passwords must conform to certain compositional rules.

To set the node password:

Step Action

1 Select nodePwd from the Group drop-down list.

2 Select nodePwdSet from the Command drop-down list.

3 Enter the password in the Node Password text box.

The password must be 6 - 14 characters in length. Valid entries
are digits 0 through 9, and special character *.

4 Click RUN.

If a non-zero length password is configured, all IP Phones that
attempt to register after the password is set display a prompt
requesting the node password before enabling the TN to be
modified.

--End--

A temporary node password can be configured to give temporary user
access to the TN for configuration. A temporary node password removes
the need to distribute the node password and the requirement to change
it afterwards. The temporary node password automatically deletes itself
after it has been used the defined number of times or when the duration
expires, whichever comes first.

To set a temporary node password:
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Step Action

1 Select nodePwd from the Group drop-down list.

2 Select nodeTempPwdSet from the Command drop-down list.

3 Enter the temporary password in the Node Password text box.

The password must be 6 - 14 characters in length. Valid entries
are digits 0 through 9, and special character *.

4 Enter the number of times that you want to enable the temporary
password to be used in the Uses text box (maximum is 1000
times).

5 Enter the duration, in hours, for the temporary password in the
Timeout text box (maximum is 240 hours).

6 Click RUN.

--End--

From the General Commands Web page, any IP address can be pinged
from this element. The default IP address is the address of the Call
Server.

To ping an IP address:

Step Action

1 Verify that the entry in the IP address text box is correct.

2 Enter the number of pings that to send in the Number of Pings
text box.

3 Click Ping.

--End--

Report Log
Click the RPT LOG button, located beside the information for the Signaling
Server as shown in Figure 66 "Node Maintenance and Reports Web page"
(page 140), to open the Node Report Logs Web page for the Signaling
Server (see Figure 68 "Node Report Logs Web page" (page 144)).
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Figure 68
Node Report Logs Web page

The four buttons at the top of this Web page provide one-click access to
the following functions:

• RDOPEN — Opens the latest report file.

• RDSHOW — Shows a summary of the report file.

• RDTAIL — Shows x records up to the newest record in the report file
(where x is the configured display size).

• RDHEAD — Shows x records starting from the oldest record in the
report file (where x is the configured display size).

To view selected detail data on records in the report file, use the text
boxes, the drop-down lists, and the following buttons:

• RDGO — Displays the record specified in the adjacent text box (where
-1 is the oldest record and 1000 is the most recent).

• RD — Browses the report records. Enter the number of records to
skip and the number of records to display in the adjacent text boxes.

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



IP Network 145

• RDS — Browses the report records with (symbolic) memory dump.
Enter the number of records to skip, and select the number of records
to display using the adjacent text box and drop-down list.

• VIEW — Views selected records. Enter a starting record number and
select the number of records to view using the adjacent text box and
drop-down list. Negative numbers indicate records previous to the
starting record.

The results are displayed in the box at the bottom of the Web page.

System log
Click the SYS LOG button, located beside the information for an IP
Telephony card, to open the Syslog Web page for the IP Telephony card,
as shown in Figure 69 "Syslog Web page" (page 145).

Figure 69
Syslog Web page

To view a System log file:

Step Action

1 Select a file using the Syslog File to View drop-down list.
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2 Click VIEW.

--End--

Alternatively, click one of the five buttons below the Syslog File to view the
dialog box:

• LATEST — Displays the most recent record in the system log file.

• SYSLOG.0 — Displays the file /C:/log/syslog.0 located on the Media
Card.

• SYSLOG.1 — Displays the file /C:/log/syslog.1 located on the Media
Card.

• SYSLOG.2 — Displays the file /C:/log/syslog.2 located on the Media
Card.

• SYSLOG.3 — Displays the file /C:/log/syslog.3 located on the Media
Card.

The contents of the file appears in the box at the bottom of the Web page.

Operational Measurement Reports
The OM (Operational Measurement Report) RPT button enables users to
view OM information. Click the OM RPT button, located beside information
for an IP Telephony element as shown in Figure 66 "Node Maintenance
and Reports Web page" (page 140), to open the OM Reports Web page
for that element, as shown in Figure 70 "OM Reports Web page" (page
147).
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Figure 70
OM Reports Web page

To view an OM Report file:

Step Action

1 In the Select File column, click the option button beside the OM
Report to be viewed.

Note: The limit of OM Report files is eight. Only the eight
most recent OM Report files are available on the system.

2 Click View OM File.

--End--

The contents of the file appear in the box at the bottom of the Web page.

Virtual Terminal
The Virtual Terminal is an integral part of the enhanced navigation tools
for Element Manager.
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Click the Virtual Terminal button on the Node Maintenance and Reports
Web page to open the Virtual Terminal window, as shown in Figure 71
"Virtual Terminal window" (page 148).

Figure 71
Virtual Terminal window

The Virtual Terminal is a Web-based window that enables access to
the character-based interfaces supported by the components of the CS
1000system, including all overlays not supported by Element Manager
Web pages. The Virtual Terminal can also be used to add new links to
the system components or other Element Manager servers using the
Bookmarks feature.

ATTENTION
Virtual Terminal requires the Java Runtime Environment (JRE).

To access the Virtual Terminal for a particular IP device:

Step Action

1 Choose the IP device you want to access on the Node
Maintenance and Reports Web page.
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2 Click the Virtual Terminal button beside that node. The Virtual
Terminal window opens, as shown in Virtual Terminal window.

3 Enter the user name and password.

--End--

For more information about accessing and using the Virtual Terminal, refer
to “Virtual Terminals” (page 31).

Media Gateways
To access Media Gateways in Element Manager select the Media
Gateways link in the IP Network branch of Element Manager navigator.
The Media Gateways Web page opens, as shown in Figure 72 "Media
Gateways Web page" (page 149).

Figure 72
Media Gateways Web page

Media Gateway configuration
To view or configure the current settings of a Media Gateway Controller,
select the Media Gateways link in the IP Network branch of Element
Manager navigator. For information about the configuration of the
Media Gateway Controller, refer to Communication Server 1000E
Installation and Commissioning () (NN43041-310), Communication
Server 1000E - Upgrades () (NN43041-458), and Communication Server
1000M and Meridian 1 Large System Installation and Commissioning ()
(NN43021-310).
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Media Gateway Controller commands
Element Manager provides support for executing the Media Gateway
Controller (MGC) command line interface (CLI) maintenance commands.

Note: Not all MGC commands are supported from Element Manager
as they affect basic system configuration parameters and are used by
the system administrator to closely monitor the system using serial
connection.

The following MGC CLI command groups are supported from Element
Manager:

• General — General purpose commands

• System — MGC platform administration and maintenance commands

• Voice Gateway —- Voice Gateway application administration and
maintenance commands

• Special — Special purpose PDT commands

• Security —- Intra-system and cryptographic key support commands

To run MGC commands from Element Manager, select the Media
Gateways link in the IP Network branch of Element Manager navigator.
The Media Gateways Web page opens. See, Figure 72 "Media Gateways
Web page" (page 149).

Procedure 84
Running MGC commands

Step Action

1 Choose an MGC and select General Commands from the More
Actions drop-down list. The General Commands Web page
opens. See, Figure 73 "General Commands" (page 151).

2 Select the MGC CLI command group that you want to access
from the Group drop-down list.

3 Choose a command from the Command drop-down list.

4 Click Run to execute the command.

--End--
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Figure 73
General Commands

General purpose commands
The following General purpose commands are supported from Element
Manager in General Commands Web page:

• hosts — Prints a list of all known hosts on the network

• version — Identifies the version of VxWorks

System platform administration and maintenance commands
The following MGC platform administration and maintenance commands
are supported from Element Manager under the System group in General
Commands Web page:

• mgcInfoShow — Displays basic setup information

• macShow — Display MAC addresses

• diskShow — Display compact flash size

• memShow — Display memory usage

• ethSpeedShow — Show port speed and duplex setting

• dbHwShow — Display the model and revision numbers for installed
DBs

• mgcDbShow — Display information about DSP DB

• rmonStatShow — Display RMON statistics for one port
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• rmonStatShowAll — Display all RMON statistics

• rmonStatReset — Reset RMON statistics for one port

• rmonStatResetAll — Reset all RMON statistics

• swVersionShow — Show software version

• displayShow — Show the faceplate message

• mspVersionShow — Display MSP Device type, ARM code, Voice DSP
Revision, and T.38 Version

Voice Gateway commands
The following Voice Gateway commands under the Voice Gateway group
are supported from Element Manager in General Commands Web page:

• dspNumShow — Displays the number of DSP channels for each DSP
DB

• dspChanStateShow — Lists the state of all the channels on the DSP
DBs

• dspHwCheck — Perform a basic DSP hardware diagnostic check

• dspLoopTest — Perform DSP loopback test for all inactive channels or
for the channels entered

• vgwShow — Show information about busy gateway channels

• vgwCardShow — Show all channel’s information for specified card

• vgwShowAll — Show information about all the gateway channels

• ommShow — Print the current OM data to the console

Special purpose PDT commands
The following Special purpose PDT command is supported from Element
Manager in the General Commands Web page:

• testAlarm — Test SNMP alarm

IP Security commands
The following Intra-system and cryptographic key support commands are
supported from Element Manager under Security group in the General
Commands Web page:

• disInsecureShells — Disables all insecure shells in the system

• disSecureShells — Disable all secure shells in the system

• enlInsecureShells — Enable all insecure shells in the system

• enlSecureShells — Enables all secure shells
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• isecChgPsk — Change ISEC Psk locally

• isecChgLevel — Change ISEC security level locally

• isecNewTarget — Add a new target to the ISEC target list

• isecOutTarget — Delete a target from the ISEC target list

• isecEnlTarget — Enable the target ISEC

• isecDisTarget — Disable the target ISEC

• isecProfileShow — Show all ISEC profiles

• sshKeyActivate — Activate the SSH key

• sshKeyClear — Clears the SSH key

• sshKeyGenerate — Generate the SSH key

• sshKeyShow — Generate the SSH key

• statInsecureShells — Show whether insecure shell access is enabled
or disabled

• statSecureShells — Show whether secure shell access is enabled or
disabled

MGC Report logs
To generate MGC report logs from Element Manager, select the Media
Gateways link in the IP Network branch of Element Manager navigator.
The Media Gateways Web page opens. Choose an MGC and select
Report Log from the More Actions drop-down list. The MGC Report Log
Web page opens, as shown in Figure 74 "MGC Report Logs Web page"
(page 154).

The following buttons at the top of this Web page provide one-click access
to the following functions:

• RDSCONVERT — Convert a report log file to text

• RDPREV — Open the previous log file

• RDNEXT — Open the next log file

• RDOPEN — Open the latest report file

• RDSHOW — Show a summary of the report file

• RDTAIL — Show x records up to the newest record in the report file
(where x is the configured display size).

• RDHEAD — Show x records starting from the oldest record in the
report file (where x is the configured display size).
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To view selected detail data on records in the report file, use the text
boxes, the drop-down lists, and the following buttons:

• RDGO — Displays the record specified in the adjacent text box (where
-1 is the oldest record and 1000 is the most recent).

• RD — Browses the report records. Enter the number of records to skip
and the number of records to display in the adjacent text boxes.

• RDS — Browses the report records with (symbolic) memory dump.
Enter the number of records to skip, and select the number of records
to display using the adjacent text box and drop-down list.

• VIEW — Views selected records. Enter a starting record number and
select the number of records to view using the adjacent text box and
drop-down list. Negative numbers indicate records previous to the
starting record.

Figure 74
MGC Report Logs Web page

For more information about Media Gateway commands see, Software
Input Output Reference — Maintenance (NN43001-711).

32 Channel Secure Media Card (MC32S) commands
Element Manager provides support for executing MC32S command line
interface (CLI) maintenance commands.
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The following MC32S CLI command groups are supported from Element
Manager:

• General — General purpose commands

• System — System commands

• Voice Gateway — Voice Gateway application administration and
maintenance commands

• Iset — IP Phone and LTPS administration and maintenance
commands

• Special — Special purpose (PDT commands)

• Security — Intra-system and cryptographic key support commands

Note: Not all MC32S commands are supported from Element Manager
as they affect basic system configuration parameters and are used by
the system administrator to closely monitor the system using serial
connection.

To run MC32S commands from Element Manager, select the
Maintenance and Reports link in the IP Network branch of Element
Manager navigator. The Node Maintenance and Reports Web page
opens. Click GEN CMD for the MC32S card from the list. The General
Commands Web page opens for the MC32S card, as shown in Figure 75
"MC32S General Commands Web page" (page 155).

Figure 75
MC32S General Commands Web page
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Procedure 85
Running MC32S commands

Step Action

1 Select the MC32S CLI command group that you want to access
from the Group drop-down list.

2 Choose a command from the Command drop-down list.

3 Click Run to execute the command.

--End--

General commands
The following MC32S General purpose commands are supported from
Element Manager under General group in the General Commands Web
page:

• hosts

• version

• ifShow

System commands
The following MC32S System commands are supported from Element
Manager under System group in the General Commands Web page:

• mc32sInfoShow — Display basic setup information

• macShow — Display MAC Addresses

• diskShow — Display compact flash size

• memShow — Display memory usage

• ethSpeedShow — Show port speed and duplex setting

• dbHwshow — Display the model and revision numbers for installed
DBs

• rmonStatShow — Display RMON statistics for one port

• rmonStatShowAll — Display all RMON statistics

• rmonStatReset — Reset RMON statistics for one port

• rmonStatResetAll — Reset all RMON statistics

• IPInfoShow — Display basic setup information

• logConsoleOn — Turn on logging to the console
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• logConsoleOff — Turn off logging to the console

• logShow — Show information about the current logging configuration

• pbxLinkShow — Show PBX link status

• routeAdd — Add a route to the routing tables

• routeShow — Display host and network routing tables

• serialNumShow — Print out card serial number

• swVersionShow — Display software version

• setLeader — Set a leader card

• clearLeader — Clear the leader info in NVRAM

• disiAll — Graceful disable LTPS and VGW

• enaAll — Enable LTPS and VGW (opposite of disiAll)

• firmwareVersionShow — Prints out firmware version number

• itgAlarmTest — Generates ITGXXXX test alarms

• itgCardShow — Show card info

• itgMemShow — Show the memory usage

• displayShow — Show the faceplate message

• mspVersionShow — Display MSP Device type, ARM code, Voice DSP
Revision, and T.38 Version

Voice Gateway commands
The following Voice Gateway commands under Voice Gateway group are
supported from Element Manager in the General Commands Web page:

• dspNumShow — Displays the number of DSP channels for each DSP
DB

• dspChanStateShow — Lists the state of all the channels on the DSP
DBs

• dspHwCheck — Perform a basic DSP hardware diagnostic check

• dspLoopTest — Perform DSP loopback

• vgwCardShow — Show all channel’s information for specified card

• vgwShow — Show information about busy gateway channels

• vgwShowAll — Show information about all the gateway channels

• numChannelsShow — Prints out number of available channels

• ommShow — Print the current OM data to the console
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• resetOm — Reset the operational measurement file timer

• itgChanStateShow — Show State for channels, e.g. busy or idle

IP Phone and LTPS Administration and Maintenance commands (Iset)
The following MC32S Platform IP Phone and LTPS Administration and
Maintenance commands are supported from Element Manager under ISET
group in the General Commands Web page:

• isetReset — Reset registered IP set

• isetResetAll — Reset all registered IP sets

• isetShow — Show general information for all registered sets

• nodePwdSet — Set password for current node

• nodePwdShow — Show node password setting

• nodePwdEnable — Enable node password setting

• nodePwdDisable — Disable node password setting

• nodeTempPwdClear — Clear the temporary password for current node

• nodeTempPwdSet — Set a temporary password for current node

• isetNATShow — Show information about registered sets behind a NAT
router

• isetLocShow — Show location information for all connected sets or
specified set

• isetLocNeedUpdateShow — Show location information for connected
sets that need a location update

• isetCount — Show total number of registered sets based on given
query

• isetGet — Show a list of IP phones based on a given query

• isetFWGet — Show a list of IP phones firmwares based on a given
query

• eStatShow — Show Ethernet statistics for specified IP set

• isetInfoShow — Show DHCP configurations and iset information for
specified IP set

• rTraceRoute — Request specified IP set to trace route a IP address

• rTraceRouteStop — Request a IP set to stop tracing route

• rudpStatShow — Show RUDP/UNIStim statistics for specified IP set

• tpsShow — Show TPS info
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• disTPS — Gracefully switch the registered sets to the other cards in
the same node

• forcedisTPS — Force all registered line TPS to unregister from the
local server

• enlTPS — Causes line TPS application to be enabled and to accept
set registration

• loadBalance — Balance the registration load of sets between node
components

• uftpNodeShow — Show IP telephone f/w download summary of node

• disServices — Gracefully switch the registered resources to the other
servers in the same node

• forcedisServices — Force switch the registered resources to the other
services in the same node

• enlServices — Causes all the services to accept registration of
resources

• servicesStatusShow — Show the status of services

IP Security commands
The following Intra-system and cryptographic key support commands are
supported from Element Manager under Security group in the General
Commands Web page:

• disInsecureShells — Disables all insecure shells in the system

• disSecureShells — Disable all secure shells in the system

• enlInsecureShells — Enable all insecure shells in the system

• enlSecureShells — Enables all secure shells

• isecChgPsk — Change ISEC Psk locally

• isecChgLevel — Change ISEC security level locally

• isecNewTarget — Add a new target to the ISEC target list

• isecOutTarget — Delete a target from the ISEC target list

• isecEnlTarget — Enable the target ISEC

• isecDisTarget — Disable the target ISEC

• isecProfileShow — Show all ISEC profiles

• sshKeyActivate — Activate the SSH key

• sshKeyClear — Clears the SSH key

• sshKeyGenerate — Clears the SSH key
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• sshKeyShow — Display the SSH key

• statInsecureShells — Show whether insecure shell access is enabled
or disabled

• statSecureShells — Show whether secure shell access is enabled or
disabled

Special Purpose PDT commands
The following Special purpose PDT command is supported from Element
Manager under Special group in the General Commands Web page:

• testAlarm — Test SNMP alarm

Report logs
To generate MC32S report logs from Element Manager, select the
Maintenance and Reports link in the IP Network branch of Element
Manager navigator. The Node Maintenance and Reports Web page
opens. Choose an MC32S card and click RPT Log. The Node Report
Logs Web page opens, as shown in Figure 76 "MC32S Node Report Logs
Web page" (page 161).

The following buttons at the top of this Web page provide one-click access
to the following functions:

• RDSCONVERT — Convert a report log file to text

• RDPREV — Open the previous log file

• RDNEXT — Open the next log file

• RDOPEN — Open the latest report file

• RDSHOW — Show a summary of the report file

• RDTAIL — Show x records up to the newest record in the report file
(where x is the configured display size).

• RDHEAD — Show x records starting from the oldest record in the
report file (where x is the configured display size).

To view selected detail data on records in the report file, use the text
boxes, the drop-down lists, and the following buttons:

• RDGO — Displays the record specified in the adjacent text box (where
-1 is the oldest record and 1000 is the most recent).

• RD — Browses the report records. Enter the number of records to skip
and the number of records to display in the adjacent text boxes.
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• RDS — Browses the report records with (symbolic) memory dump.
Enter the number of records to skip, and select the number of records
to display using the adjacent text box and drop-down list.

• VIEW — Views selected records. Enter a starting record number and
select the number of records to view using the adjacent text box and
drop-down list. Negative numbers indicate records previous to the
starting record.

Figure 76
MC32S Node Report Logs Web page

For more information about MC32S commands see, Software Input Output
Reference - Maintenance (NN43001-711).

Zones
To configure or edit zone information, click the Zones link in the IP
Network branch of the Element Manager navigator. The Zones Web page
opens (see Figure 77 "Zones Web page" (page 162)).
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Figure 77
Zones Web page

Note: Zone 0 is not included in the selection box listing the Zones in
Element Manager. Zone 0 should never be used or configured. There
are no bandwidth restrictions in Zone "0" and Bandwidth Management
parameters cannot be configured. However, if Zone 0 was configured
through the CLI (which should not be done), Delete functionality for
Zone 0 is available in Element Manager to enable the deletion of Zone 0.

The user can view a spreadsheet populated with the configuration values
of the Zone Basic Property and Bandwidth Management pages of all the
configured zones in the Call Server. Click the Configuration Spreadsheet
link. A Microsoft Excel spreadsheet opens, which can be saved to the
user’s local drive.

Note: All rows must be entered sequentially in the Microsoft Excel
spreadsheet, if a blank row is encountered further rows are not taken
into account.

From the Zones Web page, add Zones by selecting a Zone number from
the drop-down list and clicking to Add.
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This Web page also contains links to the six categories of Zone
configuration data for each Zone configured. Click the plus sign to the left
of next to the Zone number to see the following:

• Basic Property and Bandwidth Management

• Adaptive Network Bandwidth Management and CAC

• Alternate Routing for Calls between IP Stations

• Branch Office Dialing Plan and Access Codes

• Branch Office Emergency Service Information

• Branch Office Time Difference and Daylight Saving Time Property

For information on configuring the MG 1000B, see Branch Office
Installation and Commissioning (NN43001-314) () .

To edit basic properties, click the Zone Basic Property and Bandwidth
Management link. The Zone Basic Property and Bandwidth
Management Web page opens. See Figure 78 "Zone Basic Property and
Bandwidth Management Web page" (page 163).

Figure 78
Zone Basic Property and Bandwidth Management Web page
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The information entered on this Web page corresponds to the ZONE,
ZBRN, and ZDES data traditionally configured using LD 117 - Ethernet and
Alarm Management.

To save changes made in Zone Basic Property and Bandwidth
Management parameters, click Submit at the bottom of the Web page.

To return to the Zones Web page, click the Zones link in the navigation
path at the top of the Web page.

To configure the Adaptive Network Bandwidth Management feature, click
the Adaptive Network Bandwidth Management and CAC link. The
Adaptive Network Bandwidth Management and CAC Web page opens,
as shown in Figure 79 "Adaptive Network Bandwidth Management and
CAC Web page" (page 164).

Note: Do not configure ANBWM for Zone 0 or Virtual Trunk zones.
ANBWM is not supported in Zone 0 or VTRK zone.

Figure 79
Adaptive Network Bandwidth Management and CAC Web page
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If the Adaptive Network Bandwidth Management feature is enabled using
the Enable Call Admission Control Feature (STATE) check box, then
the other parameters can be adjusted as required:

• QoS Response Time Increase (ZQRT) - Bandwidth limit increment, as
a percentage of the QoS factor for the zone

• QoS Response Time Interval (ZQRTI) - Time (in minutes) between
bandwidth limit increments

• Warning Alarm Threshold (ZQWAT) - A QoS value, which is lower than
this value, but higher than the Critical (Unacceptable) Alarm Threshold,
triggers a Major Alarm.

• Critical Alarm Threshold (ZQUAT) - A QoS value, which is lower than
this value, triggers an Unacceptable (Critical) Alarm.

• R Alarm Coefficient (CR) - Value used to calculate the QoS value for
the zone.

• Packet Loss Alarm Coefficient (CPL) - Value used to calculate the QoS
value for the zone.

• Delay Alarm Coefficient (CD) - Value used to calculate the QoS value
for the zone.

• Jitter Alarm Coefficient (CJ) - Value used to calculate the QoS value
for the zone.

• Coefficient of QoS (CQoS) - Value used to calculate the overall QoS
value for the zone.

• Recent Validity Time Interval (CACVT) - Amount of time (in hours) for
zone-to-zone record validity. Once this interval expires, records for
unused zones are purged from the tables.

To configure the Alternate Routing feature, click the Alternate Routing
for Calls between IP Stations link. The Alternate Routing for Calls
between IP Stations Web page opens, as shown in Figure 80 "Alternate
Routing for Calls between IP Stations" (page 166).
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Figure 80
Alternate Routing for Calls between IP Stations

• Select the Enable Alternate Routing feature (ENL_ZALT) check box
to enable the Alternative Call Routing for NBWM feature.

• Enter a maximum of 7 digits in Alternate Routing Prefix Digits
(ALTPrefix).

• Select the Re-route for All Calls (ALL_CALLS) check box to enable
the feature for all calls.

• Enter an Alarm Suppression Time Period (ZAST).

• Click Submit to enter the data.

To edit dialing plan and access code parameters for a Zone’s MG 1000B
offices, click the Branch Office Dialing Plan and Access Codes link on
the Zones Web page. The Zone Dialing Plan and Access Codes Web
page opens. See Figure 81 "Zone Dialing Plan and Access Codes Web
page" (page 167).
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Figure 81
Zone Dialing Plan and Access Codes Web page

The information entered on this Web page corresponds to the Zone Dialing
Plan and Access Codes (ZACB) command available in LD 117 - Ethernet
and Alarm Management.

To save changes made in Zone Dialing Plan and Access Code
parameters, click Submit at the bottom of the Web page.

To return to the Zones Web page, click the Zones link in the navigation
path at the top of the page.

To access the time difference and daylight saving time properties for a
Zone’s MG 1000B Offices, click the Branch Office Time Difference and
Daylight Saving Time Property link on the Zone List Web page. The
Time Difference and Daylight Saving Time Property Web page opens
(see Figure 82 "Time Difference and Daylight Saving Time Property Web
page" (page 168)).
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Figure 82
Time Difference and Daylight Saving Time Property Web page

The information entered on this Web page corresponds to the ZTDF and
ZDST command data traditionally configured using LD 117 - Ethernet and
Alarm Management.

To save changes made in Time Difference and Daylight Saving Time
properties, click Submit at the bottom of the Web page.

To return to the Zones Web page, click the Zones link in the navigation
path at the top of the page.

Host and Route Tables
Host and Route tables are located on the Ethernet LAN configuration
page, that is used to configure and list the Ethernet LAN settings of the
Call Server.
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Network Address Translation (NAT)
To configure or edit Network Address Translation (NAT) information, click
the Network Address Translation link in the IP Network branch of the
Element Manager navigator. The Network Address Translation (NAT)
Web page opens, as shown in Figure 83 "Network Address Translation
(NAT) Web page" (page 169).

Figure 83
Network Address Translation (NAT) Web page

The information entered on this Web page corresponds to data traditionally
configured using LD 117 - Ethernet and Alarm Management.

To configure the Echo Server 1 and 2 IP addresses and port numbers,
enter the values in corresponding input fields.

Note: Echo Server 1 and 2 default IP addresses use the TLAN network
interface IP address of the LTPS card.

Enter the NAT session timeout value. Click the Submit button to save the
changes. For more information, see IP Line Fundamentals (NN43100-500)
() .
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Quality of Service Thresholds (QoS)
The threshold values chosen provide accurate statistics without
unnecessary network loading. If you increase your sample rate or your
sample duration you will utilize/consume more of the bandwidth.

Nortel recommends that you use the default values. You can change
thresholds depending on the voice quality level you want to have without
alarms reported. For example, Call Packet Loss Unacceptable Threshold
(UPKL) - default is 7% (entered as 70).

The zone basis threshold parameters allow for an overall level of alerts
based on aggregated data for the zone. QoS samples are collected from
active sets in the zone periodically by polling or received asynchronously,
depending on the set firmware. The statistics received are compared
to the call basis thresholds and violations are counted. The zone basis
threshold parameters define the level at which alarms are sent out. These
indicate the percentage of the samples that may exceed the defined per
call thresholds for the different QoS metrics. For example, if the zone
threshold for a particular metric is set to 2%, then zone alarms are issued
if over 2% of the samples for that metric exceed the per call unacceptable
threshold set for that metric.

The zone defaults for the warning items are higher than those for the
unacceptable items (20% compared to 2%). The assumption is that the
per call warnings thresholds are set at levels such that several warning
alarms are normally issued. However, an overall problem with the
zone should only be indicated if there are a significant number of such
violations. On the other hand, there should be almost no unacceptable
alarms and it is appropriate that these be set to a far lower zone
percentage threshold.

The per call thresholds should be first adjusted to a level appropriate for
the installation. After that the zone thresholds should be set, taking into
consideration the per call threshold settings. If the per call thresholds are
set low then more violations are to be expected, and the zone thresholds
should be set higher to compensate. The converse is true for high per call
threshold settings.

To configure or edit Quality of Service Threshold information, click the
Quality of Service Thresholds (QoS) link in the IP Network branch
of the Element Manager navigator. The Quality of Service (QoS)
Thresholds Web page opens (see Figure 84 "Quality of Service (QoS)
Thresholds Web page" (page 171)).
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Figure 84
Quality of Service (QoS) Thresholds Web page

From this Web page, Quality of Service (QoS) Thresholds can be viewed
and edited. Every node in the system has the same threshold values.

The information entered on this Web page corresponds to data traditionally
configured using LD 117 - Ethernet and Alarm Management.

The threshold parameters are grouped as follows:

• QoS Zone Basis Threshold Parameters

• QoS Call Basis Threshold Parameters
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To save changes made to the threshold parameters, click Submit at the
bottom of the Web page.

For more information, see Software Input Output Reference - Maintenance
(NN43001-711) () .

ATTENTION
Changes to Quality of Service parameters do not take effect until a Call Server
data dump is performed.

Personal Directories
The Personal Directories, Redial List, and Callers List feature runs on
either a leader or follower Signaling Server. It can run on the same
Signaling Server as Element Manager if the number of users is less than
1000. If the Signaling Server supports more than 1000 users, use a
separate Signaling Server.

For more information about Personal Directories, Redial List, and Callers
List, see IP Line Fundamentals (NN43100-500) () .

Interfaces
Element Manager supports the Value Added Server and Property
Management System data blocks traditionally configured in LD 17.

Value Added Server
Click the Interfaces > Value Added Server link in the System branch of
the Element Manager navigator. The Value Added Server Web page
opens as shown in Figure 85 "Value Added Server Web page" (page 173).
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Figure 85
Value Added Server Web page

To add a Value Added Server, click Add. The Add Value Added Server
Web page opens, as shown in Figure 86 "Add Value Added Server Web
page" (page 173).

Figure 86
Add Value Added Server Web page

To associate a Value Added Server with a configured Application Module
Link, click Application Module Link. The Application Module Link Web
page opens, as shown in Figure 87 "Application Module Link Web page"
(page 174).
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Figure 87
Application Module Link Web page

Enter the parameters for the new Value Added Server and click Save.

To associate a Value Added Server with a configured Application Module
Link over Ethernet, from the Add Value Added Server Web page click
Ethernet LAN Link. The Ethernet Link Web page opens, as shown in
Figure 88 "Ethernet Link Web page" (page 174).

Figure 88
Ethernet Link Web page

Enter the parameters for the new Value Added Server and click Save.
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Property Management System
Click the Interfaces > Property Management System link in the System
branch of the Element Manager navigator. The Property Management
System Web page opens, as shown in Figure 89 "Property Management
System Web page" (page 175).

Figure 89
Property Management System Web page

Enter the parameters for the new Property Management System and click
Save.

Engineered Values
The configuration of the system depends on the value of certain
parameters. To configure and edit system parameters, click the
Engineered Values link in the System branch of the Element Manager
navigator. The Engineered Values Web page appears as shown in Figure
90 "Engineered Values Web page" (page 176).
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Figure 90
Engineered Values Web page

To configure the input/output buffer and queue allocations for various
devices and applications, click Buffer and Queue Management. The
Buffer and Queue Management Web page appears as shown in Figure
91 "Buffer and Queue Management Web page" (page 177).
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Figure 91
Buffer and Queue Management Web page

Enter the desired parameters within the ranges indicated and click Save.

To configure the allocation of Call Registers for specific applications,
from the Engineered Values Web page click Call Registers. The Call
Registers Web page appears as shown in Figure 92 "Call Register Web
page" (page 178).
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Figure 92
Call Register Web page

Enter the desired parameters within the ranges indicated and click Save.

To configure idle set display information, from the Engineered Values
Web page click Idle Set Display. The Idle Set Display Web Page
appears as shown in Figure 93 "Idle Set Display Web page" (page 179).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



Engineered Values 179

Figure 93
Idle Set Display Web page

Enter the desired display information and click Save.

To configure Call Detail Recording parameters, from the Engineered
Values Web page click Call Detail Recording. The Call Detail
Recording Web page appears as shown in Figure 94 "Call Detail
Recording Web page" (page 180).
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Figure 94
Call Detail Recording Web page

Enter the desired parameters and click Save.

To configure other hardware and software parameters, from the
Engineered Values Web page click Miscellaneous Parameters. The
Miscellaneous Parameters Web page appears as shown in Figure 95
"Miscellaneous Parameters Web page" (page 181).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



Emergency Services 181

Figure 95
Miscellaneous Parameters Web page

Enter the desired parameters and click Save.

Emergency Services
Element Manager supports the Emergency Services Client Mobility
feature, which allows users to manage the location of phones, and to
process emergency calls according to the caller’s current data.

Service Parameters
The Service Parameters Web page allows users to modify system-wide
configuration settings.

Click the Emergency Services > Service Parameters link in the
System branch of the Element Manager navigator to open the Service
Parameters Web page, as shown in Figure 96 "Service Parameters Web
page" (page 182).
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Figure 96
Service Parameters Web page

• Choose a Location Information Service from the first drop-down list.

— If Internal Subnet Location Information Service is selected, the
Lookup Private Address for Subnet check box is displayed.

— If External Discovery Manager is selected, the External Location
Update Timeout text box is displayed.

• Enter a Dynamic ELIN Timeout value.

• Check Reuse oldest ELIN during overflow, if necessary.

• Click Submit.

Access Numbers and Routing
The Access Numbers and Routing Web page allows users to process
Emergency Service information which are specific to each Customer.

Click the Emergency Services > Access Numbers and Routing link in
the System branch of the Element Manager navigator to open the Access
Numbers and Routing Web page, as shown in Figure 97 "Access
Numbers and Routing Web page" (page 183).
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Figure 97
Access Numbers and Routing Web page

To add an Emergency Services Directory Number, click Add. The Add
Emergency Services Directory Number Web page opens, as shown in
Figure 98 "Add Emergency Services Directory Number Web page" (page
184).
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Figure 98
Add Emergency Services Directory Number Web page

To edit an existing Emergency Services Directory Number, from the
Access Numbers and Routing Web page click the Entry#. The Edit
Emergency Services Directory Number Web page opens, as shown in
Figure 99 "Edit Emergency Services Directory Number Web page" (page
185).
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Figure 99
Edit Emergency Services Directory Number Web page

To edit the CLID configuration for a Customer, select a Customer from
the Choose a customer drop-down list and click Edit. The Edit Access
Numbers and Routing Web page opens, as shown in Figure 100 "Edit
Access Numbers and Routing Web page" (page 186).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



186 IP Network

Figure 100
Edit Access Numbers and Routing Web page

To add a new CLID configuration for a Customer, from the Access
Numbers and Routing Web page click Add. The Add Access Numbers
and Routing Web page opens, as shown in Figure 101 "Add Access
Numbers and Routing Web page" (page 187).
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Figure 101
Add Access Numbers and Routing Web page

Choose a Customer from the Customer Number drop-down list.
Complete the information in the remaining fields and click Submit.

To delete the CLID configuration for a customer, from the Access
Numbers and Routing Web page click Delete.

Response Locations
Click the Emergency Services > Emergency Response Locations link
in the System branch of the Element Manager navigator to open the
Emergency Response Location Web page, as shown in Figure 102
"Emergency Response Location Web page" (page 188).
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Figure 102
Emergency Response Location Web page

This Web page allows users to add, enable, disable, or delete Emergency
Response Locations (ERLs).

To add an ERL, click the radio button for the ERL and click Add.

To enable an ERL, click the radio button for the ERL and click Enable.

To disable an ERL, click the radio button for the ERL and click Disable.

To delete an ERL, click the radio button for the ERL and click Delete.

To edit an ERL, click the ERL number. The Edit Emergency Response
Location Web page opens, as shown in Figure 103 "Edit Emergency
Response Location Web page" (page 189).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



Emergency Services 189

Figure 103
Edit Emergency Response Location Web page

To add an ERL, from the Emergency Response Location Web page
click Add. The Add Emergency Response Location Web page opens,
as shown in Figure 104 "Add Emergency Response Location Web page"
(page 190).
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Figure 104
Add Emergency Response Location Web page

Enter the information for the new ERL and click Submit.

Subnet Information
The Subnet Location Information Web pages allow users to modify subnet
information.

Click the Emergency Services > Subnet Information link in the System
branch of the Element Manager navigator to open the Subnet Location
Information Service Web page, as shown in Figure 105 "Subnet Location
Information Service Web page" (page 191).
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Figure 105
Subnet Location Information Service Web page

The Maintenance section contains a link to the Emergency Services
Diagnostics Web page. See “Emergency Services Diagnostics” (page
78).

The Configuration section lists the configured subnet entries. To delete a
configured Subnet Location, select the appropriate radio button beside an
IP Address and click Delete.

To edit a configured Subnet Location, click the Subnet Location IP
Address. The Edit Subnet Location Information Web page opens, as
shown in Figure 106 "Edit Subnet Location Information Web page" (page
192).
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Figure 106
Edit Subnet Location Information Web page

To add a Subnet Location, from the Subnet Location Information
Service Web page click Add. The Add Subnet Location Information
Web page opens, as shown in Figure 107 "Add Subnet Location
Information Web page" (page 193).
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Figure 107
Add Subnet Location Information Web page

Enter the information for the new Subnet Location and click Submit.

Dynamic ELIN
The Dynamic Identification Web pages allow users to modify Dynamic
Emergency Location information.

Click the Emergency Services > Dynamic ELIN link in the System
branch of the Element Manager navigator to open the Dynamic ELIN Web
page, as shown in Figure 108 "Dynamic ELIN Web page" (page 194).
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Figure 108
Dynamic ELIN Web page

This Web page lists the configured Dynamic ELINs.

To delete an ELIN, click the radio button for the ELIN and click Delete.

To add an ELIN, click Add. The Add Dynamic Location Identification
Number Web page opens, as shown in Figure 109 "Add Dynamic Location
Identification Number Web page" (page 194).

Figure 109
Add Dynamic Location Identification Number Web page
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Enter the information for the new ELIN and click Submit.

Virtual Office Phone
The Virtual Office Phone Web pages allow users to maintain lists of
mapped and unused Virtual Office TNs.

Click the Emergency Services > Virtual Office Phone link in the System
branch of the Element Manager navigator to open the Virtual Office
Phone Web page, as shown in Figure 110 "Virtual Office Phone Web
page" (page 195).

Figure 110
Virtual Office Phone Web page

To delete a Mapped Virtual Office TN, click the radio button for the
Customer and click Delete.

To Add a Mapped Virtual Office TN, click Add, enter the information for the
new Virtual Office TN, and click Save.

This Web page includes two sections listing Mapped Virtual Office TN
Pools and Virtual Office TNs in use.
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Geographic Redundancy
Geographic Redundancy is available only on CPP II, CPP IV and CP-PM
systems.

Database Replication Control
To configure or edit Database Replication information, click the
Geographic Redundancy > Database Replication Control link in
the System branch of the Element Manager navigator. The Database
Replication Control Web page opens as shown in Figure 111 "Database
Replication Control Web page" (page 196).

Figure 111
Database Replication Control Web page

On the Database Replication Control Web page, users can configure:

• Rule Number for backup and Restore

• Automatic Replication Backup (ABKUP)

• Automatic Replication restore

• Automatic Sysload
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State Control
To configure State Control information, click the Geographic Redundancy
> State Control link in the System branch of the Element Manager
navigator. The State Control Web page opens as shown in Figure 112
"State Control Web page" (page 197).

Figure 112
State Control Web page

On the State Control Web page, users can configure:

• Associated Secondary Call Server

• Threshold1 (Number Of IP phones registered)

• Threshold2 (Number of Media Gateways registered)

• Short Term Failure Timeout in minutes

• Fault Clearance Timeout in minutes

• Secondary CS Deactivation Mode

The information entered on this Web page corresponds to the commands
available in LD 117.
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For more information about Geographic Redundancy, see System
Redundancy Fundamentals (NN43001-507) () .

Software
The Software link of the System branch of the Element Manager
navigator can be used to perform patching of the Call Server or the Media
Gateway.

To have access to the patching feature, you must enter the administration
password configured in LD 17 and have PDT access. Patches can be
downloaded from the Nortel web site using any web browser.

For MGC and VGMC loadware distribution and functionality instructions,
refer to the "Enterprise Voice Solutions Patch Reference and Best Practice
Guidelines" located on the Enterprise Solutions PATCH Library (ESPL)
page at www.nortel.com/espl. Authorized users can log in to the ESPL
using their e-mail address as Login ID, SAM ID or Norpass password.
If the user does not have access to the ESPL page, it will show as "Not
available". Users who do not have access can contact Nortel ESPL
support for assistance, or can follow the New User Registration link from
the main ESPL Login page.

Call Server PEPs
Perform Call Server patching by clicking the Software > Call Server PEPs
link in the System branch of the Element Manager navigator. The Call
Server Web page opens, as shown in Figure 113 "Call Server Web page"
(page 199).
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Figure 113
Call Server Web page

From the Call Server Web page, the user can:

• load and activate a new Product Enhancement Package (PEP)

• get the status of a single PEP or all PEPs (PSTAT)

• activate a single PEP or all PEPs (PINS)

• deactivate a single PEP or all PEPs (POOS)

• remove a single PEP or all PEPs (POUT)

• view the details on a PEP (PLIS)

The PEP Setting section at the top left of the Web page enables the
user to select files and choose settings. Clicking the right arrow (->>)
button moves PEP files into the PEP Bin section. Clicking the left arrow
(<<-) button moves PEP files out of the PEP Bin section. Click Load
and Activate to submit the selected PEP to the call server. Results are
displayed at the bottom of the screen.

Note: The user can download only 15 PEP files at a time. To install
more than 15 PEPs on a single entity, the user must run the utility again.
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All PEP commands require the PEP ID. After selecting the PEP command
from the drop-down list, enter the PEP ID in the text box.

The Apply to All check box is enabled for all commands with the
exception of the PLIS command. Clicking the Submit button executes the
command. Results are displayed at the bottom of the screen.

PEP Management can be applied to Call Servers. Element Manager
enables users to load Matrix DepLists (MDP) to the Call Server and
manage the MDPs by using the Management DepList commands. Click
the Dependency lists radio button. See Figure 114 "Call Server Web
page - Dependency Lists" (page 201).

For Dependency List distribution and functionality instructions, refer to
the "PEP Dependency tools" section located on the Enterprise Solutions
PATCH Library (ESPL) page at www.nortel.com/espl. Authorized users
can log in to the ESPL using their e-mail address as Login ID, SAM ID
or Norpass password. If the user does not have access to the ESPL
page, it will show as "Not available". Users who do not have access can
contact Nortel ESPL support for assistance, or can follow the New User
Registration link from the main ESPL Login page.
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Figure 114
Call Server Web page - Dependency Lists

PEP lists are populated with individual PEPs contained in an update
when a Matrix DepList is opened. The Refresh command refreshes the
contents of an MDP on a target system and enables the user to load
MDPs properly.

Each PEP in the Matrix DepList has its own PEP handle and can be
uninstalled, similar to current multipatch functionality.

• Enterprise Voice Solutions Patch Reference and Best Practice
Guidelines.

• PEP Dependency Tools

• Matrix Dependency List User Guide (X21 Rls 4.0 and higher)

• Enhanced Patch Audit and DepList Generation Tool

• Upgrades" - Meridian ISSP Report and Conflict Checker (MIRCC)

• Communication Server 1000 / Meridian 1 PEP Tools

• Multimedia PEP Tools

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



202 IP Network

• Business Communications Manager (BCM) PEP Tools

• Serviceability Updates and Loadware/Firmware Distribution Tools

Loading and Activating PEP Settings on the Call Server

Step Action

1 Select the User PEPs radio button on the Call Server page.

2 Click Browse. The Choose file window opens.

3 Choose a file to be downloaded and click Open.

4 Enter the number of Days PEP vulnerable to sysload.

5 Enter the In service initialize threshold.

6 Enter the In service days to monitor inits.

7 Click the -->> (right arrow) button to move the PEP files into the
PEP Bin section.

8 Click Load and Activate to submit the selected PEPs to the call
server. Results are displayed at the bottom of the screen.

--End--

Additional Commands

From the Select Command drop down box select one of the following:

• PEP Status (PSTAT) - Shows the status of the PEP

• PEP In-Service (PINS) - Places the PEP in service

• PEP Out-Of-Service (POOS) - Takes the PEP out of service

• PEP Out (POUT) - Unloads the PEP

• PEP List (PLIS) - Lists information about the PEP

Once the appropriate command has been selected, select either PEP ID
and enter the PEP ID that you want to execute the command on or select
Apply to All to execute the selected command on all of the PEPs. Once
this has been completed, select Submit.

Loading and Activating Dependency lists on the Call Server

Step Action

1 Select the Dependency lists radio button on the Call Server
page.

2 Click Browse. The Choose file window opens.
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3 Choose a file to be downloaded and click Open.

4 Click Load and Activate to submit the selected Deplist to the
call server.

--End--

Once the appropriate command has been selected, select theDeplist
Name that you would like to execute the command on. Once this has been
completed, select Submit.

The following other changes can be executed when loading a Deplist:

• Enter the number of Days PEP vulnerable to sysload

• Enter the In service initialize threshold

• Enter the In service days to monitor inits

WARNING
Service updates that contain many PEPs can take time to
install.

Media Gateway PEPs
Software

The Software link of the System branch of the Element Manager
navigator can also be used to upload and store files, upgrade firmware,
and perform patching activities.

File Upload
The file upload function enables users to upload and store loadware
and firmware files on the Signaling Server. These files can then be
downloaded to network elements, using the functions available under the
Software > Voice Media Gateway Card link in the System branch of the
navigator.

For more information about the file upload function, see IP Line
Fundamentals (NN43100-500) () .

IP Phone Firmware
The Software > IP Phone Firmware link in the System branch of the
Element Manager navigator allows users to upgrade IP Phone firmware.
For more information, see IP Line Fundamentals (NN43100-500) () .
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Servers and Media Cards
Click the Software > Servers, Media Cards PEPs link in the System
branch of the Element Manager navigator to open the Servers and Media
Cards Web page as shown in Figure 115 "Servers and Media Cards Web
page" (page 204).

Figure 115
Servers and Media Cards Web page

From this Web page the following functions can be performed:

• load and activate a new PEP

• view the status of a single PEP or all PEPs (PSTAT)

• activate a single PEP or all PEPs (PINS)

• deactivate a single PEP or all PEPs (POOS)

• remove a single PEP or all PEPs (POUT)

• view the details on a PEP (PLIS)

The PEP Setting section at the top left of the Web page enables users
to select files and choose settings.
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Procedure 86
Loading and Activating PEP Settings to the Signaling Server

Step Action

1 Select the correct Element type and then Platform type.

2 Click Browse.

The Choose file window opens.

3 Choose a file to be downloaded and click Open.

4 Enter the number of Days PEP vulnerable to sysload.

5 Enter the In service initialize threshold.

6 Enter the In service days to monitor inits.

7 Click the -->> (right arrow) button to move the PEP files into the
PEP Bin section.

8 Click Load and Activate to submit the selected PEPs to the call
server.

Results are displayed at the bottom of the screen.

--End--

Clicking the -->> (right arrow) button moves PEP files into the PEP Bin
section. Likewise, clicking the <<-- (left arrow) button moves PEP files out
of the PEP Bin section. Click Load and Activate to submit the selected
PEPs to the call server. Results are displayed at the bottom of the screen.

Note: A maximum of 15 PEP files can be downloaded at a time. If
more than 15 PEPs must be installed on a single entity, the utility must
be run again.

Click the PSTAT button to open the Type Web page for the selected
element. See Figure 116 "Type Web page" (page 206).
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Figure 116
Type Web page

All PEP commands require the PEP ID. After selecting the PEP Command
from the drop-down list, enter the PEP ID in the text box.

The Apply to All check box is enabled for all commands with the
exception of the PLIS command. Clicking the Submit button executes the
command. Results are displayed at the bottom of the screen.

Procedure 87
Loading and Activating Dependency lists on the Signaling Server

Step Action

1 Select the Dependency lists radio button on the Servers and
Media Cards page.

2 Select the Element type from the drop down menu

3 Select the Platform type from the drop down menu

4 Click the Browse button. The Choose file window opens.

5 Choose a file to be downloaded and click Open.

6 Select an Element from the list of elements under the
appropriate node that you would like to apply the Deplist to.
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7 Click Transfer to submit the selected Deplist to the Signaling
Server. The Deplist is uploaded to the selected Element.

8 From the MDP Commands drop down menu select one of the
following commands and select Submit.

--End--

Additional Commands:

• Install Deplist (MDP REFRESH) - To install the deplist

• Show Status (MDP Stat) - To find out the transfer status of the deplist

• Revert Deplist (MDP REVERT) - To remove the current PEPs and
possibly install previous PEPs
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Customers, Routes and Trunks

Contents
This section contains information on the following topics:

“Introduction” (page 209)

“Customers” (page 209)

“Route and Trunk Configuration” (page 235)

“Routes and Trunks” (page 235)

“D-channels” (page 246)

“Digital Trunk Interface” (page 250)

Introduction
The Customers and Routes and Trunks branches of the Element
Manager navigator are used to launch Web pages that enable the user to
configure and edit data relating to customers and their equipment.

Customers
When the user clicks the Customers branch of the Element Manager
navigator, the Customers Web page opens, as shown in Figure 117
"Customers Web page" (page 210). To configure customer data, click the
Customer Number.
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Figure 117
Customers Web page

To add a new customer, click Add.

The Basic Configuration Web page opens, as shown in Figure 118
"Basic Configuration Web page" (page 210).

Figure 118
Basic Configuration Web page

The information entered in this Web page corresponds to Default
Customer Data Block information traditionally configured using LD 15 -
Customer Data Block.
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Enter the required information in the three fields and click Save.

The Edit Web page opens, as shown in Figure 119 "Edit Customer Web
page" (page 211).

Figure 119
Edit Customer Web page

This Web page contains links to Web pages where users can configure
additional parameters for each route data block.

Application Module Link
The Application Module Link Web page allows users to configure the
Application Module Link data block for a customer. Click Application
Module Link to open this Web page, as shown in Figure 120 "Application
Module Link Web page" (page 212).
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Figure 120
Application Module Link Web page

Enter the Value Added Service Identifier and Group status events
information and click Save.

Call Detail Recording
The Call Detail Recording Web page allows users to configure the Call
Detail Recording data block for a customer. Click Call Detail Recording to
open this Web page, as shown in Figure 121 "Call Detail Recording Web
page" (page 213).
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Figure 121
Call Detail Recording Web page

Enter the appropriate information and click Save.

Call Party Name Display
The Call Party Name Display Web page allows users to configure the
Call Party Name Display data block for a customer. Call Party Name
Display names for Incoming Digit Conversion (IDC) are supported on this
Web page. Click Call Party Name Display to open this Web page, as
shown in Figure 122 "Call Party Name Display Web page" (page 214).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



214 Customers, Routes and Trunks

Figure 122
Call Party Name Display Web page

Enter the appropriate information and click Save.

Note: The Static Allocation of name storage check box will be
checked and not editable if the BGD package is enabled.

Call Redirection
The Call Redirection Web page allows users to configure the Call
Redirection data block for a customer. Click Call Redirection to open this
Web page, as shown in Figure 123 "Call Redirection Web page" (page
215).
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Figure 123
Call Redirection Web page

Enter the appropriate information and click Save.

Click Redirection Holidays to open the Redirection Holidays Web page,
as shown in Figure 124 "Redirection Holidays Web page" (page 216).

This Web page displays holiday redirections for existing dates and allows
users to add, edit, or delete holidays.
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Figure 124
Redirection Holidays Web page

To add a holiday, click Add. The Add Date of Holiday Web page opens,
as shown in Figure 125 "Add Date of Holiday Web page" (page 216).

Figure 125
Add Date of Holiday Web page

Use this Web page to configure holiday redirections for a customer. Enter
the holiday information and click Save.

Centralized Attendant Service
The Centralized Attendant Service Web page allows users to centralize
their attendant services at a single location. From the Edit Web page,
click Centralized Attendant Service to open this Web page, as shown in
Figure 126 "Centralized Attendant Service Web page" (page 217).
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Figure 126
Centralized Attendant Service Web page

Enter the appropriate information and click Save.

To edit the Attendant Incoming Call Indicators, click the Main attendant
radio button, and click Incoming Call Indicators. The Edit Attendant ICI
Web page opens, as shown in Figure 127 "Edit Attendant ICI Web page"
(page 218).
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Figure 127
Edit Attendant ICI Web page

Enter the appropriate information and click Save.

Controlled Class of Service
The Controlled Class of Service Web page allows users to configure the
Controlled Class of Service data block for a customer. Click Controlled
Class of Service to open this Web page, as shown in Figure 128
"Controlled Class of Service Web page" (page 219).
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Figure 128
Controlled Class of Service Web page

Enter the appropriate information and click Save.

Flexible Feature Codes
The Flexible Feature Codes Web page allows users to configure the
Flexible Feature Codes (FFC) data block for a customer. To access the
Flexible Feature Codes Web page for a customer, click the Flexible
Feature Codes link of the Edit Web page to open the Web page shown in
Figure 129 "Flexible Feature Codes Web page" (page 220).
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Figure 129
Flexible Feature Codes Web page

To configure Change Flexible Feature Code end-of-dialing indicator, select
the Change Flexible Feature Code end-of-dialing indicator checkbox.

Enter the appropriate information and click Save.

Flexible Feature Code Entries
To access Flexible Feature Code Entries click on the Flexible Feature
Code Entries hyperlink. The Search for Flexible Feature Code Entries
Web page opens as shown in Figure 130 "Search for Flexible Feature
Code Entries Web page" (page 221).

Note: To access Flexible Feature Code Entries Web page for a
Customer the FCC data block must be configured, see Procedure
91 “Configuring Flexible Feature Codes” (page 222). If you click the
Flexible Feature Code Entries hyperlink before configuring the FCC
data block, the message "FCC Block is not configured. Click on [OK]
to configure the FCC block for the customer." appears. Click OK to
automatically configure the FCC data block and open the Flexible
Feature Code Entries Web page.
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Figure 130
Search for Flexible Feature Code Entries Web page

To search for specific Flexible Feature Codes, follow the steps in
Procedure 88 “Searching for Flexible Feature Codes” (page 221).

Procedure 88
Searching for Flexible Feature Codes

Step Action

1 Click the Flexible feature code type radio button to activate
search for Flexible Feature Codes.

2 Click the Look up hyperlink. The Flexible Feature Code
Lookup pop up window appears.

3 Click the check box of the required features and click Assign.
The selected feature prompt names are displayed in the Specific
Feature Code type input box.

4 Click Search. The datagrid lists only the codes for the selected
feature.

--End--

To search for Flexible Feature Codes by Value, follow the steps in
Procedure 89 “Searching for Flexible Feature Codes by Value” (page 222).
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Procedure 89
Searching for Flexible Feature Codes by Value

Step Action

1 Enter the configured Flexible Feature Code value in the Value
input box.

2 Check the Value radio button, the Search button is enabled.

3 Click the Search button. The flexible feature code, type, and the
value are listed in the datagrid.

--End--

To search for Flexible Feature Codes using Advanced Search, follow the
steps in Procedure 90 “Searching for Flexible Feature Codes (Advanced)”
(page 222).

Procedure 90
Searching for Flexible Feature Codes (Advanced)

Step Action

1 Enter the wildcard character * before or after the search text in
the ‘Flexible feature code type’ input box.

2 Check the Flexible feature code type radio button, the Search
button is enabled.

3 Click the Search button. All the flexible feature code type with
the configured values that match the given search text are listed
in the datagrid.

--End--

To configure Flexible Feature Codes for a customer, follow the steps in
Procedure 91 “Configuring Flexible Feature Codes” (page 222).

Procedure 91
Configuring Flexible Feature Codes

Step Action

1 In the Flexible Feature Codes Web page, check the box
Flexible Feature Confirmation Tone and Conference
European Des Postes Tel (CEPT) defaults. The Replacement
for * in CEPT default codes appears as a sub prompt for
Conference European Des Postes Tel (CEPT) defaults prompt
and should be enabled only when Conference European Des
Postes Tel (CEPT) defaults prompt is checked.
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2 To complete the configuration, click Save.

3 Click Cancel to cancel the action. The Edit Web page is
displayed.

--End--

To add Flexible Feature Codes to the Customer, follow the steps in
Procedure 92 “Adding Flexible Feature Codes” (page 223).

Procedure 92
Adding Flexible Feature Codes

Step Action

1 Click on the Flexible Feature Code Entries hyperlink on the
Flexible Feature Code Web page. The Flexible Feature Code
Entries Web page opens.

2 Click Add in the Flexible Feature Code Entries Web page. The
Add Flexible Feature Code Web page opens.

3 Click the Look up hyperlink adjacent to the Flexible feature
code type input box. The Flexible Feature Code Lookup
popup window opens and lists all the Flexible Feature Codes.

4 Click on a Flexible Feature Code to add to the Flexible feature
code type input box.

5 Enter a value in the Value box.

6 Click Save, to add the Flexible Feature Code. The new Flexible
Feature Code is displayed in the Flexible Feature Code Entries
Web page.

--End--

Feature Options
The Feature Options Web page allows users to configure the Feature
Options data block for a customer. Click Feature Options to open this
Web page, as shown in Figure 131 "Feature Options Web page" (page
224).
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Figure 131
Feature Options Web page

To configure Boss Secretary Filtering Enhancement, select the Boss
Secretary Filtering Enhancement checkbox.

To configure Virtual Office Automatic Logout, select the Enable Virtual
Office Automatic Logout checkbox

To configure Conference Display, select the Change conference display
configurations checkbox.

Enter the appropriate information and click Save.

Listed Directory Numbers
The Listed Directory Numbers Web page allows users to configure
the Listed Directory Numbers data block for a customer. Click Listed
Directory Numbers to open this Web page, as shown in Figure 132
"Listed Directory Numbers Web page" (page 225).
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Figure 132
Listed Directory Numbers Web page

To configure attendant consoles associated with Listed Directory Numbers,
select the Departmental listed directory number checkbox.

Enter the appropriate information and click Save.

Mobile Service Directory Number
The Mobile Service Directory Numbers Web page allows users to view,
edit, add, and delete Mobile Service Directory Numbers. Click Mobile
Service Directory Numbers to open this Web page, as shown in Figure
133 "Mobile Service Directory Numbers Web page" (page 226). For
more information about Mobile Directory Service Numbers and Mobile
Extension, refer to Features and Services Fundamentals - Book 4 of 6 ()
(NN43001-106-B6).
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Figure 133
Mobile Service Directory Numbers Web page

ISDN and ESN Networking
The ISDN and ESN Networking Web page allows users to configure the
ISDN and ESN Networking data block for a customer. Click ISDN and
ESN Networking to open this Web page, as shown in Figure 134 "ISDN
and ESDN Networking Web page" (page 227).
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Figure 134
ISDN and ESDN Networking Web page

Enter the appropriate information and click Save.

To configure Calling Line Identification (CLID) parameters, click Calling
Line Identification Entries. The Calling Line Identification Entries Web
page opens, as shown in Figure 135 "Calling Line Identification Entries
Web page" (page 227).

Figure 135
Calling Line Identification Entries Web page
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To search for a CLID, enter the CLID Range and click Search.

To add a CLID, click Add. The New Calling Line Identification Web
page opens, as shown in Figure 136 "New Calling Line Identification Web
page" (page 228).

Figure 136
New Calling Line Identification Web page

Enter the parameters for the new CLID and click Save.

Night Service
The Night Service Web page allows users to configure the Night Service
data block for a customer. Click Night Service to open this Web page, as
shown in Figure 137 "Night Service Web page" (page 229).
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Figure 137
Night Service Web page

Enter the appropriate information and click Save.

Feature Packages
The Feature Packages Web page allows users to view and edit the
parameters associated with feature packages. Click Feature Packages to
open this Web page.

Click the plus sign located to the left of the Feature Packages heading to
expand the feature packages, as shown in Figure 138 "Feature Packages
Web page" (page 230).
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Figure 138
Feature Packages Web page

Note: The only feature packages whose parameters can be viewed
and edited are those that have been enabled on the system. Feature
packages cannot be removed or added from Element Manager.

Click the plus sign located to the left of the feature package name to
view and edit the parameters associated with the feature package.
For feature packages that are not equipped for the customer, Element
Manager includes a button labeled To Order. This button provides a link
to information on how to order the feature package.

Enter the appropriate information and click Save.

ATTENTION
If configuring M3900 System Initiated Language (Package 386) and Japanese
is selected as the default language, the user must explicitly configure the
set-to-set-messages (MSG 1 to MSG10). Otherwise, the customer information
does not load when clicking Submit and does not display.
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Intercept Treatments
The Intercept Treatments Web page allows users to configure the
Intercept Treatments data block for a customer. Click Intercept
Treatments to open this Web page, as shown in Figure 139 "Intercept
Treatments Web page" (page 231).

Figure 139
Intercept Treatments Web page

Enter the appropriate information and click Save.

To configure additional prompts for Intercept Treatments, click Additional
Treatment Options . The Intercept Treatments Options Web page
opens, as shown in Figure 140 "Intercept Treatments Options Web page"
(page 232).
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Figure 140
Intercept Treatments Options Web page

To edit an Intercept Treatment for a customer, click the Condition. The
Edit Web page for that Condition is displayed, as shown in Figure 141
"Edit Condition Web page" (page 232).

Figure 141
Edit Condition Web page

Enter the appropriate information and click Save.
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Multi Party Operations
The Multi Party Operations Web page allows users to configure the Multi
Party Operations data block for a customer. Click Multi Party Operations
to open this Web page, as shown in Figure 142 "Multi Party Operations
Web page" (page 233).

Figure 142
Multi Party Operations Web page

Enter the appropriate information and click Save.

Recorded Overflow Announcement
The Recorded Overflow Announcement Web page allows users
to configure the Recorded Overflow Announcement data block for a
customer. Click Recorded Overflow Announcement to open this Web
page, as shown in Figure 143 "Recorded Overflow Announcement Web
page" (page 234).
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Figure 143
Recorded Overflow Announcement Web page

Enter the appropriate information and click Save.

Timers
The Timers Web page allows users to configure the Timers data block
for a customer. Click Timers to open this Web page, as shown in Figure
144 "Timers Web page" (page 235).
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Figure 144
Timers Web page

Enter the appropriate information and click Save.

Note: The Attendant forward no answer timer and Attendant
forward buzz tone must be even numbers.

Route and Trunk Configuration
There are three options in the Routes and Trunks branch of the Element
Manager navigator.

Routes and Trunks
Click the Routes and Trunks link on the Routes and Trunks branch of
the Element Manager navigator to open the Routes and Trunks Web
page, as shown in Figure 145 "Routes and Trunks Web page" (page 236).
From this Web page, users can view information on existing customers,
routes, and trunks.
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Figure 145
Routes and Trunks Web page

This Web page also contains buttons that link to additional Web pages.
Follow these links to

• add a new route

• edit route data

• add a new trunk

• edit trunk data

• delete multiple trunks

Route Properties
Click the Edit button beside a Route row to open the Route Property
Configuration Web page for the selected customer and route. See Figure
146 "Route Property Configuration Web page" (page 237).

Note: If there are a large number of routes or trunks, this Web page
can be slow to load.
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The information entered in the Basic Configuration section of this Web
page corresponds to Route Data Block information traditionally configured
using LD 16 - Route Data Block.

Note: H.323 and SIP must not use the same route.

For information on configuring routes, see IP Peer Networking Installation
and Commissioning (NN43001-313) () .

Figure 146
Route Property Configuration Web page

Basic Configuration
In the Basic Configuration section of this Web page (see Figure 147
"Basic Configuration for routes" (page 238)), the following functions can be
performed:

• Assign a Route Number (ROUT) using the drop-down list.

• Enter a Designation (DES) for the route.

• Select a Trunk Type (TKTP) from the drop-down list.
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• Use the drop-down list to indicate that the trunk is Incoming and/or
Outgoing (ICOG).

• Assign an Access Code (ACOD) to the trunk route.

Element Manager may request that users enter data for additional
parameters, depending on what is entered in the Basic Configuration
fields. Choices in the drop-down lists for every parameter in the Basic
Configuration fields are determined by the data entered above that field.

Figure 147
Basic Configuration for routes

To save changes made in this section, click Submit at the bottom of the
Route Property Configuration Web page.

Basic Route Options
In the Basic Route Options section (see Figure 148 "Basic Route Options
configuration" (page 239)), use the check boxes to activate the following
options for this route:

• Billing Number Required (BILN)

• Call Detail Recording (CDR)
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• Controls or timers (CNTL)

• Conventional (TIE trunk only) (CNVT)

• Incoming DID Digit Conversion (IDC)

• Process Notification Networked Calls (PNNC)

In addition, use the drop-down list to select a Multi-frequency Compelled or
MFC Signaling (MFC) type.

Note: The route used in this example is a TIE trunk route. The inputs
requested by Element Manager vary depending on the responses to
earlier input requests, including Trunk Type (TKTP).

Depending on which boxes are selected in the preceding list, Element
Manager requests that users enter data for additional parameters, as
shown in Figure 148 "Basic Route Options configuration" (page 239).

Figure 148
Basic Route Options configuration

To save changes made in this section, click Submit at the bottom of the
Route Property Configuration Web page.
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Network Options
Figure 149 "Network Options for routes" (page 240) provides an example
of the input requested in the Network Options section for the route shown
in Figure 146 "Route Property Configuration Web page" (page 237). The
actual input that Element Manager requests varies depending on the type
of route and the responses to earlier input requests.

Figure 149
Network Options for routes

To save changes made in this section, click Submit at the bottom of the
Route Property Configuration Web page.

General Options
Figure 150 "General Options for routes" (page 241) provides an example
of the input requested in the General Options section for the route shown
in Figure 146 "Route Property Configuration Web page" (page 237). The
actual input that Element Manager requests varies depending on the type
of route and the responses to earlier input requests.
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Figure 150
General Options for routes

To save changes made in this section, click Submit at the bottom of the
Route Property Configuration Web page.

Advanced Configurations
Figure 151 "Advanced Configurations for routes" (page 242) provides an
example of the input requested in the Advanced Configurations section
for the route shown in Figure 146 "Route Property Configuration Web
page" (page 237). The actual input that Element Manager requests varies
depending on the type of route and the responses to earlier input requests.
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Figure 151
Advanced Configurations for routes

To save changes made in this section, click Submit at the bottom of the
Route Property Configuration Web page.

New Trunk Configuration
Click the Add Trunk button beside a Customer Row or a Trunk Row to
open the New Trunk Configuration Web page for the selected customer,
route, and trunk, as shown in Figure 152 "New Trunk Configuration Web
page" (page 243).
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Figure 152
New Trunk Configuration Web page

The New Trunk Configuration Web pages are divided into two
categories:

1. Basic Configuration

2. Advanced Trunk Configurations

Basic Configuration
In the Basic Configuration section of these Web pages (see Figure 152
"New Trunk Configuration Web page" (page 243)), users can perform the
following tasks:

• Enter a Designator field (DES) for the trunk.

• Select an Extended Trunk (XTRK) card type from the drop-down list.

• Edit the route or member number in the Route number, Member
number (RTMB) text box. The range is 0-4000.

• Use the Level 3 Signaling (SIGL) drop-down list to select a Level 3
signaling method.
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• Use the Start arrangement Incoming (STRI) drop-down list to select
a start arrangement for incoming calls.

• Use the Start arrangement Outgoing (STRO) drop-down list to select
a start arrangement for outgoing calls.

• Use the Increase or decrease the member numbers (INC)
drop-down list to select either increasing channel numbers and
member numbers or increasing channel numbers and decreasing
member numbers.

• Click the Class of Service (CLS) Edit button to view Class of
Service information for the trunk. See Figure 153 "Class of Service
Configuration Web page" (page 244).

Figure 153
Class of Service Configuration Web page

Note: The member used in this example is a TIE trunk. The inputs
requested by Element Manager may vary depending on the responses
to earlier input requests.

To save changes made in this section, click Submit at the bottom of the
New Member Configuration Web page.
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Advanced Trunk Configurations
Figure 154 "Advanced Configurations for trunks" (page 245) provides an
example of the input requested in the Advanced Trunk Configurations
section for the TIE Trunk shown in Figure 152 "New Trunk Configuration
Web page" (page 243).

Figure 154
Advanced Configurations for trunks

Note: The member used in this example is a TIE trunk. The inputs
requested by Element Manager may vary depending on the responses
to earlier input requests.

To save changes made in this section, click Submit at the bottom of the
Web page.

Delete multiple trunk members
Click Multi-Del located beside a member row to open the Delete multiple
trunk members Web page for the selected member, as shown in Figure
155 "Delete multiple trunk members page" (page 246). On this Web page,
the information for the Parent Route is read-only.
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Figure 155
Delete multiple trunk members page

To delete multiple trunk members using this Web page:

Step Action

1 Use the Set starting TN to be deleted drop-down list to
determine the start of the deletion list.

2 Use the Set total trunk number to be deleted drop-down list to
indicate the total number of trunks to be deleted (up to 32).

3 Click Delete.

--End--

D-channels
Click the D-Channels link on the Routes and Trunks branch of the
Element Manager navigator to open the D-Channels Web page. This Web
page allows users to configure or edit D-channel information, as shown in
Figure 156 "D-Channels Web page" (page 247).
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Figure 156
D-Channels Web page

Maintenance
This sections contains links to the following commands:

• D-Channel Diagnostics (LD 96)

• Network and Peripheral Equipment (LD 32, Virtual D-Channels)

• MSDL Diagnostics (LD 96)

• TMDI Diagnostics (LD 96)

• D-Channel Expansion Diagnostics (LD 48)

For more information about these commands, see “System” (page 39).

Configuration
From the D-Channels Web page users can view basic information on
existing D-channels.
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This Web page also contains buttons that link to additional Web pages.
Follow these links to do the following:

• add a new D-channel

• edit D-channel data

To add a new D-channel, select a number from the Choose a D-channel
Number drop-down list, select a D-channel type from the type drop-down
list, and click to Add. To edit the configuration information on an existing
D-channel, click the Edit button located to the right of the Description field.

Click the to Add button, or any of the Edit buttons, to open the
D-Channels Property Configuration Web page for that channel, as
shown in Figure 157 "D-Channels Property Configuration Web page" (page
248)).

Note: H.323 and SIP can use the same D-channel.

Figure 157
D-Channels Property Configuration Web page

In the D-Channels Property Configuration Web page, users can:

• Enter information on the Basic Configuration Web page.
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— The information entered in this section corresponds to ADAN
and ADAN DCH (Action Device and Number, D-channel and
back-up D-channels) data traditionally configured using LD
17 - Configuration Record 1. In addition to basic D-channel
configuration, additional information can be entered for optional
settings in the following two categories:

– Basic D-channel options (BSCOPT)

– Advanced D-channel options (ADVOPT)

These options are shown in Figure 158 "Basic and Advanced D-Channel
options" (page 249).

Figure 158
Basic and Advanced D-Channel options

• Configure information on the Feature Packages Web page.

— Digital Private Networking Signaling System 1 (Package 123)

— Virtual Network Services (Package 183)

To save changes made in this section, click Submit at the bottom of the
D-channels Property Configuration Web page.
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Digital Trunk Interface
When the user clicks the Digital Trunk Interface link on the Routes
and Trunks branch of the Element Manager navigator, the Digital
Trunk Interface Web page opens, as shown in Figure 159 "Digital Trunk
Interface Web page" (page 250). This Web page allows the user to
configure or edit Digital Trunk Interface information.

Figure 159
Digital Trunk Interface Web page

From this Web page, users can access additional Web pages to perform
the following functions:

• configure Digital Trunk Interface Data Block (DDB) information

• configure System Timer (SYSTI) parameters for:

— 2.0 Mb Primary Rate Interface (PRI2)

— 2.0 Mb Digital Trunk Interface (DTI2)

• configure Loop Timer (LPTI) parameters for:

— 2.0 Mb Primary Rate Interface (PRI2)

— 2.0 Mb Digital Trunk Interface (DTI2)

• configure PAD Category (PAD) parameters for:
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— 1.5 Mb Primary Rate Interface (PRI)

— 1.5 Mb Digital Trunk Interface (DTI)

— 2.0 Mb Primary Rate Interface (PRI2)

— 2.0 Mb Digital Trunk Interface (DTI2)

— Basic Rate Line Interface (BRIL)

— Basic Rate Trunk Interface (BRIT)

• configure ABCD Bit Signaling Category (ABCD) parameters for the 2.0
Mb Digital Trunk Interface (DTI2)

To configure or edit Digital Trunk Interface Data Block (DDB) information,
click Digital Trunk Interface Data Block (DDB). The Threshold Set List
Web page opens. See Figure 160 "Threshold Set List Web page" (page
251).

Figure 160
Threshold Set List Web page

From this Web page, users can access additional Web pages to perform
the following functions:
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• edit Clock Controller Basic Properties

• add a Threshold Set Index

• edit an existing Threshold Set Block

Users can edit Clock Controller properties by clicking the Edit button next
to the Clock Controller Basic Properties button. The Clock Controller
Basic Properties Web page opens, as shown in Figure 161 "Clock
Controller Basic Properties Web page" (page 252).

Figure 161
Clock Controller Basic Properties Web page

Users can then enter the required information in the text boxes.

To add or edit a Threshold Set Index, follow the steps in Procedure 93
“Adding or editing a Threshold Set Index” (page 252).

Procedure 93
Adding or editing a Threshold Set Index

Step Action

To add a Threshold Set Index
1 Select a Threshold Set Index from the drop-down list.

2 Click to Add.
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To edit the configuration information in an existing Threshold Set
Block, click Edit located to the right of the index number.

--End--

When the to Add button or a Threshold Set Index Edit button is clicked on
Figure 160 "Threshold Set List Web page" (page 251), the Threshold Set
Block Web page for that index opens, as shown in Figure 162 "Threshold
Set Block Web page" (page 253).

Figure 162
Threshold Set Block Web page

The information entered in this section corresponds to DDB (Digital Trunk
Interface Data Block) information traditionally configured using LD 73 -
Digital Trunk Interface.

To save changes made in this section, click Submit at the bottom of the
Threshold Set Block Web page.
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Dialing and Numbering Plans

Contents
This section contains information on the following topics:

“Introduction” (page 255)

“Electronic Switched Network” (page 255)

“Network Routing Service and NRS Manager” (page 258)

“Flexible Code Restriction” (page 263)

“Incoming Digit Translation” (page 266)

Introduction
Element Manager enables users to configure the Dialing and Numbering
Plans for the Call Server and the Network Routing Service (NRS)
Manager. The information configured in the Dialing and Numbering Plans
corresponds to the Command Line Interface (CLI) prompts and responses
for Electronic Switched Network (ESN) data traditionally configured in LD
86, LD 87, and LD 90.

For more information about the overlays referred to in this chapter, see
Software Input Output Administration (NN43001-611) () and Software Input
Output Reference - Maintenance (NN43001-711) () .

Electronic Switched Network
To configure or edit the Dialing and Numbering Plan for the Electronic
Switched Network, click the Electronic Switched Network link in the
Dialing and Numbering Plans branch of the Element Manager navigator.
The Electronic Switched Network (ESN) Web page appears as shown
in Figure 163 "Electronic Switched Network (ESN) Web page" (page 256).
From this Web page users can configure the Dialing and Numbering Plan
for each customer on the Electronic Switched Network.
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Element Manager provides access to the following Dialing and Numbering
Plan parameters:

• Network Control & Services

• Coordinated Dialing Plan (CDP)

• Numbering Plan (NET)

Figure 163
Electronic Switched Network (ESN) Web page

Network Control and Services
Under Network Control and Services, users can click the links to configure
or modify the parameters associated with the following items:

• Network Control Parameters (NCTL)

• ESN Access Codes and Parameters (ESN)

• Digit Manipulation Block (DGT)

• Route List Block (RLB)

• Incoming Trunk Group Exclusion (ITGE)

• Network Attendant Services (NAS)
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The Network Control Parameters (NCTL) that are configurable using
Element Manager correspond to data traditionally configured in LD 87. The
settings for the remaining five items under Network Control & Services
correspond to CLI prompts and responses in LD 86.

To view the total free and used Location Codes (LOCs), click Customer
xx > Network Control & Services > ESN Access Codes and Basic
Parameters. The ESN Access Codes and Basic Parameters Web
page appears as shown in Figure 164 "ESN Access Codes and Basic
Parameters Web page" (page 257).

Figure 164
ESN Access Codes and Basic Parameters Web page

This feature has its own packaging (LOCX). The package must be added
under Customers > Customer xx Property Configuration > Feature
Packages. This package can be activated only when the FNP package
is enabled.
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Coordinated Dialing Plan
Under Coordinated Dialing Plan (CDP), users can click links to configure or
modify parameters associated with the following codes:

• Local Steering Code (LSC)

• Distant Steering Code (DSC)

• Trunk Steering Code (TSC)

The Coordinated Dialing Plan parameters that are configurable using
Element Manager correspond to data traditionally configured in LD 87.

Numbering Plan
Under Numbering Plan (NET), users can click links to configure or modify
parameters associated with the following codes:

• Home Area Code (HNPA)

• Home Location Code (HLOC)

• Location Code (LOC). Maximum number of LOCs is 16 000.

• Numbering Plan Area Code (NPA)

• Exchange (Central Office) Code (NXX)

• Special Number (SPN)

• Network Speed Call Access Code (NSCL)

These codes can also be configured using the prompts and responses
in LD 90.

Numbering Plan (NET) is also used to configure the following two LD 87
features:

• Free Calling Area Screening (FCAS)

• Free Special Number Screening (FSNS)

Network Routing Service and NRS Manager
On VxWorks, Network Routing Service (NRS) Manager can be launched
from Element Manager. On Linux, NRS Manager is launched from the
Enterprise Common Manager framework.
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The NRS Manager is a Web-based application that runs on the Signaling
Server. The purpose of the NRS Manager is as follows:

• It populates the location and registration database.

• It adds the appearance of the proxy in the customer network.

• It facilitates a translation database, for phone numbers contained within
the SIP Uniform Request Identifier (URI) to present a well formed,
syntactically correct, phone number to the location service within the
proxy.

For more information about NRS and NRS Manager, see Network Routing
Services Installation and Commissioning (NN43001-564) () .

All systems in the network are registered with the NRS. The NRS runs on
an Enterprise Translations Server and provides routing services to several
service provider networks. The hierarchy consists of:

• Service Domain — represents a service provider network

• Level 1 Domain (User Data Protocol) — represents a sub-domain in a
service domain, and is referred to as the L1-domain

• Level 0 Domain (Coordinated Dialing Plan) — represents a sub-domain
in an L-1 domain, and is referred to as the L0-domain.

• Gateway Endpoint — represents a gateway, and exists within an
L0-domain.

• User Endpoint — represents a SIP Pone. It exists with the L0 domain.
A site can have many SIP Phones.

• Routing Entry — represents a range of addresses that a gateway can
terminate calls to, and exists within a gateway.

• Collaborative Server — a server in another network zone that can be
used to resolve requests when the NRS cannot find a match in its
numbering plan database.

For redundancy purposes, the NRS translation servers can be organized
into hierarchical clusters.

The NRS handles a centralized numbering plan for the network. This
enables simplified management of the network. The NRS supports H.323,
SIP, and Network Connection Server (NCS) protocols. The NRS can
provide NRS features to other H.323- and SIP-compliant endpoints (for
example, IP Trunk 4.0 endpoints).

NRS Manager must be running Microsoft Internet Explorer 6.00 or later.
Netscape Navigator is not supported. Click the Network Routing Service
link in the Dialing and Numbering Plans branch of the Element Manager
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navigator to access the NRS Manager as shown in Figure 165 "Network
Routing Service (NRS) configuration Web page" (page 260). The format of
the NRS URL is http://<NRSM_server_IP_address>/nrs.

Figure 165
Network Routing Service (NRS) configuration Web page

An alternate way to connect to the NRS is to enter the NRS IP address
followed by /nrs as a URL from any Web browser on the network. For
example, enter http://47.11.249.84/nrs.

Specifying the complete URL and including nrs is important. The NRS can
be co-resident with other applications running on the Signaling Server
platform. If other Signaling Server applications (for example, Terminal
Proxy Server) also use a Web-based management tool, then those
management tools can use the URL http://47.11.249.84/tps.

The Network Routing Service Manager login Web page opens (see
Figure 166 "NRS Manager login Web page" (page 261)). Enter the user
name and password and click Login.
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Figure 166
NRS Manager login Web page

The NRS Home Web page opens (see Figure 167 "NRS Home Web
page" (page 262)).
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Figure 167
NRS Home Web page

Access levels
NRS Manager provides two levels of access:

1. Monitor access. Enables the user to view configuration data and
view the output from performance monitoring functions. The user
cannot modify any NRS configurations or settings, including monitor
login user name and password.

2. Administrator access. Enables full administrative access to the NRS
Manager. All configuration entries can be updated and full write access
is given to the database, including the ability to change all system
passwords.

When logging in using Administrator access, NRS opens with the Web
page shown in Figure 167 "NRS Home Web page" (page 262).

Monitor access
When accessing the NRS Manager as a monitor, users can view
configuration data and reports from the performance monitoring functions.
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Administrator access
To make changes to the NRS configuration, log into the NRS Manager
using administrator access. In addition to the monitoring functionality
available with Guest access, administrators can access configuration and
administration functions.

Use the NRS Manager to:

• configure system-wide settings

• configure NRS server settings

• provision Network Numbering Plans (Service Domains, L1 Domains,
L0 Domains, Gateway Endpoints, routing entries, default routes, and
collaborative servers)

• test Numbering Plans

• perform NRS server actions

• perform database actions

• perform Gatekeeper/NRS data conversion

• perform SIP phone context mapping

• view database sync and database status reports

• configure users

For detailed information on performing these procedures and managing
the NRS using Element Manager, see IP Peer Networking Installation and
Commissioning (NN43001-313) () .

Flexible Code Restriction
To configure or edit Flexible Code Restriction information, click the
Flexible Code Restriction link in the Dialing and Numbering Plans
branch of the Element Manager navigator. The Flexible Code Restriction
Web page opens, as shown in Figure 168 "Flexible Code Restriction Web
page" (page 264).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



264 Dialing and Numbering Plans

Figure 168
Flexible Code Restriction Web page

This Web page contains Edit FCR buttons that link to Flexible Code
Restriction Property Web pages for each of the customers configured on
the Call Server.

To view the list of Flexible Code Restriction Trees for a customer, click the
Edit FCR button located beside the customer number. The Flexible Code
Restriction Property Web page for the selected customer opens (see
Figure 169 "Flexible Code Restriction Property Web page" (page 265)).
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Figure 169
Flexible Code Restriction Property Web page

The Flexible Code Restriction Property Web page contains buttons that
link to Code Restriction Tree Configuration Web pages for each Code
Restriction Tree Number (CRNO). If there is an existing configuration
for the CRNO, the button is labeled Edit CRNO. If a configuration has
not been defined for the CRNO, the button is labeled New CRNO. Click
the Edit CRNO/New CRNO button to open the Code Restriction Tree
Configuration Web page for the corresponding CRNO, as shown in
Figure 170 "Code Restriction Tree Configuration Web page" (page 266).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



266 Dialing and Numbering Plans

Figure 170
Code Restriction Tree Configuration Web page

By entering values in the appropriate text boxes, users can:

• add or edit digit sequences to be enabled

• add or edit digit sequences to be denied

The information entered in this section corresponds to data traditionally
configured using LD 49 - Flexible Code Restriction and Incoming Digit
Conversion.

To save changes made in the configuration for this Code Restriction Tree,
click Submit at the bottom of the Web page.

Incoming Digit Translation
To configure or edit Incoming Digit Translation information, click the
Incoming Digit Translation link in the Dialing and Numbering
Plans branch of the Element Manager navigator. The Incoming Digit
Translation Web page opens, as shown in Figure 171 "Incoming Digit
Translation Web page" (page 267).
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Figure 171
Incoming Digit Translation Web page

This Web page contains Edit IDC buttons that link to Incoming Digit
Conversion Property Web pages for each of the customers configured on
the Call Server.

To view the list of Incoming Digit Conversion Trees for a customer, click
the Edit IDC button located beside the customer number. The Incoming
Digit Conversion Property Web page for the selected customer opens.
See Figure 172 "Incoming Digit Conversion Property Web page" (page
268).
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Figure 172
Incoming Digit Conversion Property Web page

The Incoming Digit Conversion Property Web page contains buttons
that link to Digit Conversion Tree Configuration Web pages for each
Digit Conversion Tree Number (DCNO). If there is an existing configuration
for the DCNO, the button is labeled Edit DCNO. If a configuration has
not been defined for the DCNO, the button is labeled New DCNO. Click
the Edit DCNO/New DCNO button to open the Digit Conversion Tree
Configuration Web page for the corresponding DCNO. From this Web
page, users can configure Incoming Digit Conversion data.
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Figure 173
Digit Conversion Tree Configuration Web page

The information entered in this section corresponds to data traditionally
configured using LD 49 - Flexible Code Restriction and Incoming Digit
Conversion.
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Phones

Contents
This section contains information on the following topics:

“Introduction” (page 271)

“Database Update” (page 272)

“Station Fast Sync feature” (page 273)

“Templates” (page 273)

“Search Phones” (page 277)

“Add Phones” (page 280)

“Edit Phones” (page 290)

“Import Telephones” (page 294)

“Move Phones” (page 300)

“Retrieve Phones” (page 301)

“Delete Phones” (page 302)

“Swap Phones” (page 303)

“Courtesy Change” (page 304)

“Reports” (page 305)

Introduction
Element Manager enables users to configure Phones for the Call Server.
The information configured in this chapter corresponds to the Command
Line Interface (CLI) prompts and responses for Telephone Administration
traditionally configured in LD 10 and LD 11.

Additional information is retrieved from the Call Server for validation
purposes and they correspond to Print Routines traditionally performed
in LD 20, LD 21, LD 22 and LD 95.
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For more information about the overlays referred to in this chapter, see
Software Input Output Administration (NN43001-611)and Software Input
Output Reference - Maintenance (NN43001-711).

Note: The Phones link (BCC) can only be accessed through ECM.

Database Update
When launching Phones for the very first time, the application
automatically performs a Database Update in the background. A message
is displayed to the user: “Please wait for requested page to load while
system properties are being updated.”. The user can proceed to Phones
configuration after the update has been completed.

The Database Update can be manually activated by clicking on the
Properties link of the Phones branch of the Element Manager navigator
and clicking on Update of the Database Update section of the Properties
Web page.

The Database Update Web page opens, as shown in Figure 174
"Database Update Web page" (page 272)

Figure 174
Database Update Web page

The Last Updated field displays the timestamp of the last update
performed.

Note: It is recommended to perform an update before managing
phones to retrieve configuration changes in packages, customer data
blocks and CPND customer blocks.
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Station Fast Sync feature
The Station Fast Sync feature keeps the Phones database synchronized
with the PBX. This feature monitors and logs station data changes on the
CS 1000 PBX.

An SNMP trap is sent from the Call Server to Element Manager with error
code MGMT0001. To enable this functionality, configure the Element
Manager IP address as an SNMP trap destination in LD 117. See
Communication Server 1000 Fault Management - SNMP (NN43001-719).

When Element Manager receives the notification, it retrieves any changes
or deletes the TN/DN as required.

A log entry is created for each Fast Sync notification received.

Note: Nortel recommends that a manual “Retrieve and Reconcile All”
function is executed occasionally to ensure data consistency with the
Call Server. The fast sync auto update process relies on SNMP traps
and overlay access to maintain the data. Blocked or dropped SNMP
traps and overlay conflicts could result in a data mismatch between the
Call Server and EM.

Templates
Element Manager enables users to access Templates which contain
attributes common to a CS1000 phone type. Once a Template is created,
you can use it to apply these common attributes to a group of phones,
without having to repetitively define the same value for each phone. In
general, using a Template is a more efficient method of adding large
numbers of phones than maintaining each phone individually.

The administration pages for Templates are organized as a link named
Templates inside the Phones section of EM navigator.

Click the Templates link to open the Templates Web page as shown in
Figure 175 "Templates Web page" (page 274). The Templates Web page
lists all available Templates by name, to what type of phone they apply
and, the time and date of the last update. The action bar has buttons to
add and delete Templates.
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Figure 175
Templates Web page

Create a Template
To add a Template click Add on the Templates Web page. The Template
Details Web page opens as shown in Figure 176 "Template Details Web
page" (page 275). The telephone type 500-Analog Standard is shown as
the default. The user must select the telephone type to be used for the
Template they create.
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Figure 176
Template Details Web page

The fields marked with an asterisk (*) are mandatory and must be filled.

The Template name identifies the Template. If there is already a Template
present with the same name as specified, then an error message,
Template name already in use. Please specify another Template name is
displayed to the user after attempting to save the new Template.

The features and key features available on the Template Details Web
page are based on the selected phone type. The available features and
key features change based on the phone type the user selects. Since
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the Templates are not system specific, all the phone features and keys
applicable to the selected phone type are available for configuration in the
Template Details Web page.

Note: The user can enter a partial DN as part of the key configuration
parameter. This enables a phone configured with this Template to pick
up a DN as per the partial DN definition.

The user can configure all the required parameters and click Save to save
the Template. Clicking on Save takes the user back to the Templates
Web page, and the view is refreshed to display the newly added Template.

Templates are global in nature. Once a Template is created, it can be
used to add phones in any system. When a Template is used for adding
a phone, only those keys and features which are valid for the system in
context are displayed in the Phone Details Web page.

View/Update a Template
To view Template details, click the Template name link in the Templates
Web page. The Template Details Web page opens displaying the
selected Template.

If necessary the user can modify the Template and click Save to save the
changes.

Note: When a user updates a Template, the phones associated with
this Template are not automatically updated. See, “Update phones
using the phone Templates” (page 287).

Delete a Template
The user can select any Template from the Templates Web page and
click Delete to delete the Template.

The user is asked to confirm the deletion operation. When the user clicks
OK, the selected Template is deleted immediately. If the user clicks
Cancel, the delete action is cancelled and the user is returned to the
Templates Web page.

Note 1: When a user selects a second Template to delete but then
clicks Cancel, another message is displayed, and the user must click
Retry or Cancel a second time to return to the Template Web page.

Note 2: When a user deletes a Template it automatically remove its
association with phones. But the phones are not deleted.
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Search Phones
The Phones functions performed using Element Manager are accessed
from the Search for Phones Web page. A user can perform a search for
phones based on the following criteria:

• Prime DN

• Phone Type

• Terminal Number

• Designation

• Customer

• Template

• UXID

For example, choosing Phone Type as a criteria and selecting a type of
phone from the Value drop-down list, performs a search for all phones of
the type selected. Procedure 94 “Search for phones” (page 277) describes
searching for phones using Template as the criteria.

Procedure 94
Search for phones

Step Action

1 Click the Phones branch of the Element Manager navigator to
open this Web page, as shown in Figure 177 "Search for Phones
Web page" (page 278).
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Figure 177
Search for Phones Web page

2 Select Template as the criteria from the Criteria drop-down list.

3 Enter a Value for the Template to search for.

4 Click Search. For example, when the value from the drop-down
list is ABDA the Search for Phones Web page displays the
phones attached to the specified Template as shown in Figure
178 "Search for Phones Web page" (page 279).
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Figure 178
Search for Phones Web page

--End--

To perform a search using additional criteria, click the Advanced link in
the top right hand corner. The Advanced Search for Phones Web page
opens, as shown in Figure 179 "Advanced Search for Phones Web page"
(page 280).
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Figure 179
Advanced Search for Phones Web page

Enter the criteria for the advanced search and click Search.

Add Phones
To add a single phone, follow the steps in Procedure 95 “Add Single
Phone” (page 280).

Procedure 95
Add Single Phone

Step Action

1 From the Search for Phones Web page, click Add.

The New Phones Web page opens, as shown in Figure 180
"New Phones Web page" (page 281) .
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Figure 180
New Phones Web page

2 Enter 1 in the Number of phones box.

3 Select the customer with which this telephone will be associated
from the Customer drop-down list.

4 Select the Phone Type from the drop down list.

5 Select Default value for DES and type the value in the text box.

6 If the phone type is analog, select Automatically assign DN
to automatically assign the next DN from the given starting DN
value.

Note 1: Click the Magnifying Glass to look up a DN.
Note 2: The user can only select Automatically assign DN
for analog phone types.

7 Select Automatically assign TN to automatically assign the
next available TN from the given starting TN value.

Note 1: Click the Magnifying Glass to look up a TN
Note 2: When using this option, the maximum number of
phones that can be added is 32 as only the TN Unit value is
incremented.

8 Click Preview

The Phone Details Web page opens, as shown in Figure 181
"Phone Details Web page" (page 282).
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Figure 181
Phone Details Web page

9 Select another customer from the Customer Number drop-down
list.

The default Customer Number will be that chosen on the New
Phones Web page, but can be changed if desired.

10 If the Terminal Number field is empty, click on the magnifying
glass icon and select an available TN.

11 Enter or update the DES value in the Designation field.
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12 Choose the desired features in the Features section.

13 Choose the desired keys in the Keys section.
Note 1: If the phone type is an analog phone, the Keys
section is not available.
Note 2: When Single Call Ringing (SCR) is selected for Key 0
the telephone icon (Match DN) appears. You can launch the
Match DN Web page which displays all UEXT/desktop phones
already configured with the same DN. If the user selects any
phone and clicks Assign then FDN, HUNT, NCOS, TGAR,
and CLS features of the selected phone are copied to the
phone being configured/edited.

14 Click Validate to save and validate the new telephone.

The status of the Validation process appears, listing any
validation errors that occur. If there are validation errors, repeat
the relevant sections of this procedure to correct the errors.

15 Click Save to add the new telephone to the database.

Note: Click Cancel to undo the last action performed on the
page. You can click the Cancel repeatedly to continue to
undo actions performed.

--End--

If the user selects the Copy from TN radio button on the New Phones
Web page, the new Phone will assume the properties of the specified TN,
with the following exceptions:

• The Default value for DES if specified takes precedence

• The Automatically assign DN if enabled takes precedence.

• The Automatically assign TN if enabled takes precedence.

The user can Add Phones using the Template selection field. The
Template selection field displays all the Templates. This enables the user
to add a new phone using a Template selected from the Template type
drop-down list. When a phone is added using a Template, the phone to
Template association is stored in the database.

A partial DN specified in the Template is ignored if Auto Assign DN is
switched on and when a starting DN is specified.
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When Auto Assign DN is switched on and when a starting DN is specified,
the starting DN overwrites the existing partial DN specified in the
Template. The message, “The current DN is the specified starting DN. It is
not the partial DN specified in the Template” is displayed indicating that the
starting DN overwrites the partial DN specified in the Template.

When Auto Assign DN is switched off, a Partial DN specified in the
Template becomes the DN. The Add Phones fails unless the user corrects
the DN. The message, “The current DN is the partial DN specified in the
Template. The DN must be modified to successfully add the phone.” is
displayed.

To add multiple phones, follow the steps in Procedure 96 “Add Multiple
Phones” (page 284).

Procedure 96
Add Multiple Phones

Step Action

1 From the Search for Phones Web page, click Add.

The New Phones Web page opens, as shown in Figure 182
"New Phones Web page" (page 284).

Figure 182
New Phones Web page
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2 Enter the number of phones to be added in the Number of
phones field.

The user can add up to 100 phones at a time.

3 Select the customer with which these telephones are associated
from the Customer drop-down list.

4 Select Default value for DES and type the value in the text box.

5 Select Automatically assign DN to automatically assign the
next available Direct Inward Dialing (DID) DN in the Customer
Numbering Plan for the specific system.

6 Select Automatically assign TN to automatically assign
the next available TN (Loop, Shelf, Card, Port or Unit) to the
specified telephones as defined in the Hardware database for
the specific system.

7 Click Preview.

The Preview Phones Web page opens, as shown in Figure 183
"Preview Phones Web page" (page 285).

Figure 183
Preview Phones Web page

This Web page lists the attributes of each new phone based on
the selections entered in the New Phones Web page in previous
steps.

8 If the Customer number is incorrect, select the correct value
from the drop-down list.
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9 If the DES field is empty or incorrect, type in the correct value.

10 If the DN field is missing or incorrect, type in the correct value.

11 If the TN field is missing or incorrect, type in the correct value.

12 Click Finish to add the phones to the database.

--End--

The user can select a Template to add multiple phones.

To add multiple analog phones when Auto Assign DN is switched on and
when starting DN is specified, the starting DN is incremented and used.
For example, if the starting DN is 100 and the user adds 3 phones then
100, 101, and 102 are the DNs. This is displayed in the Preview Phones
Web page and user is allowed to edit it.

To add multiple analog phones when Auto Assign DN is switched off,
the Partial DN specified in the Template becomes the DN. Add multiple
phones fails unless the user corrects the DN. The message “The current
DN is the partial DN specified in the Template. The DN must be modified
to successfully add the phone.” is displayed.

To add multiple digital or virtual phones when Auto Assign DN is switched
on and when starting DN is specified, the starting DN is incremented
and used. For example if the starting DN is 100 and we try to add 3
phones then 100, 101 and 102 will be the DNs. This is not displayed in the
Preview Phones Web page so the user cannot modify the DNs.

To add multiple digital or virtual phones when Auto Assign DN is switched
off, the user is prevented from using the Template with partial DN for
adding multiple digital or virtual phones. The error message “Multiple
phone addition is not allowed since the Template selected has a partial
DN” is displayed indicating that this scenario is not allowed. However, no
restriction is placed on the addition of phones if the Template does not
contain a partial DN.

Edit phones
Use the Edit feature to edit a single telephone or multiple telephones.

Note: Only one field (mnemonic) can be updated at a time. Depending
on the field to be updated, the Old Value and New Value fields are text
boxes or drop-down lists. If you select a Key field to update, additional
old and new value fields are displayed corresponding to the parameters
of the Key field.

Click the Phones branch of the Element Manager navigator to open the
Search for Phones Web page.
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To edit a single phone or multiple telephones, follow Procedure 97 “Editing
single or multiple telephones” (page 287).

Procedure 97
Editing single or multiple telephones

Step Action

1 To search for phones to edit, select a search criteria from the
Criteria drop-down list

2 Sort the resultant set of phones by phone type.

3 Click the box beside the phones to update.

4 Select Edit from the <more actions> drop-down list. The Bulk
Phone Edit Web page opens.

5 In the edit Field, select the field (mnemonic) to update. Some
selected fields require the user to enter other values.

6 Enter the old value in the Old Value text box or select it from
the Old Value drop-down list. If you are updating a Key field,
enter the old value of any parameter to be changed in the
corresponding box on the left side.

7 Enter the new value in the New Value text box or select it from
the New Value drop-down list. If you are updating a Key field,
enter the new value of any parameter to be changed in the
corresponding box on the right side.

8 Click Save to complete the edit or click Cancel to undo changes
and return to the Search for Phones Web page.

--End--

Update phones using the phone Templates
The association of phones to a Template simplifies the bulk change ability
for users. This association enables a change to the Template content to
be applied to all phones having that Template.

The Bulk Phone Edit Web page allows the user to update the phone from
Templates. The value Template of the edit Field drop-down list, enables
the user to update the phone based on the value present in the Template.

In the edit Field, if the value selected is Template, then the Old Value
field displays an asterisk. The New Value field displays all the Templates
configured for the phone type of the selected phone as seen in Figure 184
"Bulk Phone Edit Web page" (page 288).
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Figure 184
Bulk Phone Edit Web page

The Template is considered the master during this update. All configured
phone attributes are overwritten with the attributes present in the selected
Template. The CPND name configured in the phone is retained during the
update.

Note 1: If the selected phones to be updated are of different phone
types, then the Template field is not available in the edit Field
drop-down list. The following properties of the phone cannot be
changed while doing an update using Templates. These properties
are set differently for every telephone and updating it from Template is
not supported.

• Designator (DES) – This property is part of General Properties
section of phone details page

• Station Control Password (SCPW) – This property is part of
Features section of phone details page.

• Directory number parameter of any key feature

In addition, there are certain properties, which are not part of the
Template, and can be changed in the phone. Below is the list of those
properties:
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• • Terminal Number (TN) - This property is part of General
Properties section of phone details page.

• • Call Party Name Display (CPND) - This property is part of
Keys section of phone details page.

• • Voice Mail Box (VMB) - This property is part of Keys section
of phone details page.

Note 2: If a Template has a partial DN configured, updating a phone
with the Template using the Edit functionality is not allowed. The error
message “Editing phones is not allowed since the Template selected
has a partial DN” is displayed. However, no restriction is placed on the
editing of phones if the Template does not contain partial DN.

The user is able to associate a Template to those phones that are not
associated with a Template. To associate a Template to those phones that
are not associated with a Template follow Procedure 98 “Associating a
Template to Phones” (page 289).

Procedure 98
Associating a Template to Phones

Step Action

1 Search for phones that are not associated to any Templates.

2 Sort the resultant set of phones by phone type.

3 Select phones to be updated.

4 Select Edit from the <more actions> drop-down list. The Bulk
Phone Edit Web page opens.

5 In the edit Field, specify the value to be updated as Template.

6 In the Old Value field, select Asterisk (*).

7 In the New Value field, select the Template to be associated.

8 Click Save to complete the edit or click Cancel to undo changes
and return to the Search for Phones Web page.

--End--

Note: Updating the phone may drive an update to the account in
Subscriber Manager depending on the attributes that are updated.
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Phone properties that can be changed without breaking the
Template association
Certain phone properties should be set differently for every telephone
and therefore changing these properties does not break the telephone to
Template association. Below is the list of those properties:

• Designator (DES) – This property is part of General Properties section
of phone details page.

• Station Control Password (SCPW) – This property is part of Features
section of phone details page.

• Directory number parameter of any key feature.

In addition, there are certain properties, which are not part of the
Template, and can be changed in the phone. Below is the list of those
properties:

• Terminal Number (TN) – This property is part of General Properties
section of phone details page

• Call Party Name Display (CPND) – This property is part of Keys
section of phone details page.

• Voice Mail Box (VMB) – This property is part of Keys section of phone
details page.

Edit Phones
Use the Edit feature to edit a single telephone or multiple telephones.

Note: Only one field (mnemonic) can be updated at a time. Depending
on the field to be updated, the Old Value and New Value fields are text
boxes or drop-down lists. If you select a Key field to update, additional
old and new value fields are displayed corresponding to the parameters
of the Key field.

Edit single or multiple phones
Click the Phones branch of the Element Manager navigator to open the
Search for Phones Web page.

To edit a single phone or multiple phones, follow Procedure 99 “Editing
single or multiple phones” (page 290).

Procedure 99
Editing single or multiple phones

Step Action

1 To search for phones to edit, select a search criteria from the
Criteria drop-down list
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2 Sort the resultant set of phones by phone type.

3 Click the box beside the phones to update.

4 Select Edit from the <more actions> drop-down list. The Bulk
Phone Edit Web page opens.

5 In the edit Field, select the field (mnemonic) to update. Some
selected fields require the user to enter other values.

6 Enter the old value in the Old Value text box or select it from
the Old Value drop-down list. If you are updating a Key field,
enter the old value of any parameter to be changed in the
corresponding box on the left side.

7 Enter the new value in the New Value text box or select it from
the New Value drop-down list. If you are updating a Key field,
enter the new value of any parameter to be changed in the
corresponding box on the right side.

8 Click Save to complete the edit or click Cancel to undo changes
and return to the Search for Phones Web page.

--End--

Update phones using the phone Templates
The association of phones to a Template simplifies the bulk change ability
for users. This association enables a change to the Template content to
be applied to all phones having that Template.

The Bulk Phone Edit Web page allows the user to update the phone from
Templates. The value Template of the edit Field drop-down list, enables
the user to update the phone based on the value present in the Template.

In the edit Field, if the value selected is Template, then the Old Value
field displays an asterisk. The New Value field displays all the Templates
configured for the phone type of the selected phone as seen in Figure 185
"Bulk Phone Edit Web page" (page 292).
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Figure 185
Bulk Phone Edit Web page

The Template is considered the master during this update. All configured
phone attributes are overwritten with the attributes present in the selected
Template. The CPND name configured in the phone is retained during the
update.

Note 1: If the selected phones to be updated are of different phone
types, then the Template field is not available in the edit Field
drop-down list. The following properties of the phone cannot be
changed while doing an update using Templates. These properties
are set differently for every telephone and updating it from Template is
not supported.

• Designator (DES) – This property is part of General Properties
section of phone details page

• Station Control Password (SCPW) – This property is part of
Features section of phone details page.

• Directory number parameter of any key feature

In addition, there are certain properties, which are not part of the
Template, and can be changed in the phone. Below is the list of those
properties:
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• • Terminal Number (TN) - This property is part of General
Properties section of phone details page.

• • Call Party Name Display (CPND) - This property is part of
Keys section of phone details page.

• • Voice Mail Box (VMB) - This property is part of Keys section
of phone details page.

Note 2: If a Template has a partial DN configured, updating a phone
with the Template using the Edit functionality is not allowed. The error
message “Editing phones is not allowed since the Template selected
has a partial DN” is displayed. However, no restriction is placed on the
editing of phones if the Template does not contain partial DN.

The user is able to associate a Template to those phones that are not
associated with a Template. To associate a Template to those phones that
are not associated with a Template follow Procedure 100 “Associating a
Template to Phones” (page 293).

Procedure 100
Associating a Template to Phones

Step Action

1 Search for phones that are not associated to any Templates.

2 Sort the resultant set of phones by phone type.

3 Select phones to be updated.

4 Select Edit from the <more actions> drop-down list. The Bulk
Phone Edit Web page opens.

5 In the edit Field, specify the value to be updated as Template.

6 In the Old Value field, select Asterisk (*).

7 In the New Value field, select the Template to be associated.

8 Click Save to complete the edit or click Cancel to undo changes
and return to the Search for Phones Web page.

--End--

Note: Updating the phone may drive an update to the account in
Subscriber Manager depending on the attributes that are updated.
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Phone properties that can be changed without breaking the
Template association
Certain phone properties should be set differently for every telephone
and therefore changing these properties does not break the telephone to
Template association. Below is the list of those properties:

• Designator (DES) – This property is part of General Properties section
of phone details page.

• Station Control Password (SCPW) – This property is part of Features
section of phone details page.

• Directory number parameter of any key feature.

In addition, there are certain properties, which are not part of the
Template, and can be changed in the phone. Below is the list of those
properties:

• Terminal Number (TN) – This property is part of General Properties
section of phone details page

• Call Party Name Display (CPND) – This property is part of Keys
section of phone details page.

• Voice Mail Box (VMB) – This property is part of Keys section of phone
details page.

Import Telephones
Telephones can be imported into the phone database by using the import
operation. The Import Telephones feature allows the user to import
telephone data into the database from a comma separated value (CSV)
file. The Import Telephones Web page is launched by first clicking the
Phones link in EM navigator and then clicking Import from the Search
for Phones Web page, as shown in Figure 186 "Search for Phones Web
page" (page 295).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



Database Update 295

Figure 186
Search for Phones Web page

The Import Telephones Web page opens, as shown in Figure 187 "Import
Telephones Web page" (page 295).

Figure 187
Import Telephones Web page
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Specifications for CSV file

• The data file must be in standard ASCII Comma Separated Value
(CSV) format.

• The first line in the CSV file should contain a list of fields which need
to be imported.

• Subsequent lines in the CSV file should contain data values for each
of the fields being imported and should be in the same order as their
corresponding field names appear in the first line.

Figure 188
Example Contents of CSV file

The valid field names which can be used while importing data into the
database are listed in the Available fields list in Fields selection section
of Reports UI. Click the Reports link of the Phones branch of the Element
Manager navigator, to access the Report UI. See, “Reports” (page 305).
For more information refer to, Software Input/Output - Administration ()
(NN43001-611).

Mandatory Fields
The first column of the import file must be either TN or PRIMEDN. The first
column is used as a key to identify the telephones to be updated.

Table 2
Mandatory Fields

OPERATION MANDATORY FIELDS

Update an existing
telephone record

TN (Terminal Number) or PRIMEDN (Prime Directory Number)

Add a new telephone
record

TN (Terminal Number), PHONE (Phone type), CUST (Customer
Number), and DES (Designation)
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Add a IP Phone record TN (Terminal Number), PHONE (Phone type), CUST (Customer
Number), DES (Designation), and ZONE (Zone)

Add DCS TN (Terminal Number), PHONE (Phone type), DES (Designation),
CUST (Customer Number), PRIMEDN (Prime Directory Number),
FTR_CFW (Forward All Calls), DMC (DECT Mobility Controller), and
IDNX (Index on DMC)

If PRIMEDN is used as first column, import process can be used only for
updating telephones.

If TN is used as first column, import can be used to either add or update
a telephone.

If for a TN, a matching telephone is found then; its configuration is updated
using data from the import file. If no matching telephones are found for
a TN, then, a new telephone is added to database, if all the mandatory
parameters for telephone configuration are specified in the import file.

Note: When DCS sets are to be added, the user cannot assign a TN to
the phone. The TN is automatically assigned by the call server once the
set is successfully added. So in case of DCS sets, the business logic
still allows the set to be imported if the TN field is left blank. If a TN is
assigned for DCS set, import will ignore the user specified TN.

Data requirements for importing Keys, CPND names and VMB
To import keys, the field name used in CSV file should be of the format
Key <number>where,<number>is the key number. For example, to import
Key 10, the field name should be Key10 The value for key should be
specified in the following format:

<mnemonic> [<parameters>] [MARP] [ANIE(<value>)] [CPND_FIRS
T_NAME (<value>) CPND_LAST_NAME(value) CPND_LANG(value)
CPND_DISPLAY_FORMAT(value) [VMB_CLASS_OF_SERVICE(value)
VMB_SECOND_DN(value) VMB_THIRD_DN(value) VMB_KEEP_MES
SAGES(value)]

The entries indicated in square brackets ([]) are optional and can be
specified by user based on key mnemonic and import requirements:

• <mnemonic> – Represents key feature mnemonic to be assigned to
the key.

• <parameters> – Represents the key parameters. The values
mentioned in this section are dependent on key feature mnemonic.
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• MARP – If specified indicates that DN specified in the <parameters>
section should be MARPed on the key.

• ANIE(<value>) – Specifies the value for ANIE entry. The <value>
represents the ANIE entry value.

The set of sections whose names start with CPND_ can be used to import
CPND name for the DN specified in <parameters> section. To import new
CPND names, a nonblank value should be specified for at least one of the
two name fields:

• PND_FIRST_NAME and CPND_LAST_NAME. To update existing
CPND names using import, the user can choose to specify values
for only those fields which need to be updated. It is not mandatory to
specify a value for all fields.

• CPND_FIRST_NAME – This section can be used to specify CPND first
name for the DN specified in <parameters> section.

• CPND_LAST_NAME – This section can be used to specify CPND last
name for the DN specified in <parameters> section.

• CPND_LANG – This section can be used to specify CPND language
for the CPND name.

• CPND_DISPLAY_FORMAT – This section can be used to specify
CPND display format for the CPND name.

The set of sections whose names start with VMB__ can be used to import
VMB configuration data for the DN specified in the <parameters> section.
It is not mandatory to specify values for all fields; a user can specify a
value only for those fields which needs to be updated:

• VMB_CLASS_OF_SERVICE – This section can be used to specify the
class of service value for VMB.

• VMB_SECOND_DN – This section can be used to specify second DN
for the VMB.

• VMB_THIRD_DN – This section can be used to specify the third DN
for the VMB.

• VMB_KEEP_MESSAGES – This section can be used to specify the
preference for keep messages field of VMB.

The valid values which can be used are the same as accepted by PBX
overlays.
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Figure 189
Example of a CSV file to import

Data requirements for importing Single Line Features
Single line features (FTR) can be imported by specifying the field name
in format FTR_<mnemonic>, where <mnemonic> is the mnemonic for a
single line feature, and by specifying the value in the format <mnemonic>
<parameters>.

Figure 190
Example of a CSV file of FTR data to import for a DCS phone

Figure 191
Example of a CSV file of FTR data to import for an analog phone
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Data requirements for importing DN for analog telephones
DN field for analog telephones can have MARP and ANIE settings and
also, CPND and VMB configuration. A DN field for analog telephones can
be imported by specifying the field name as DN and by specifying the
value in the following format:

DN<DNvalue> [MARP] [ANIE(<value>)] [CPND_FIRST_NAME
(<value>) CPND_LAST_NAME(value) CPND_LANG(value)
CPND_DISPLAY_FORMAT(value)] [VMB_CLASS_OF_SERVICE(value)
VMB_SECOND_DN(value) VMB_THIRD_DN(value) VMB_KEEP_MES
SAGES(value)]

To Import phones, follow the steps in Procedure 101 “Import Telephones”
(page 300).

Procedure 101
Import Telephones

Step Action

1 Click the Phones link in EM navigator. The Search for Phones
Web page opens.

2 Click Import to launch the Import Telephones Web page.

3 Specify the name of the file from which the telephone details are
to be imported by using the browse button or by entering the file
name. The file must be a .CSV file.

4 Click Save .

--End--

When complete, the status of the import operation is displayed to the user.
The user can get an initial format of the CSV file by generating a Report in
CSV format using the Reports link of the Phones branch of the Element
Manager navigation page.

Move Phones
The user can move a telephone to another TN with the same property
values. To do this, follow the steps in Procedure 102 “Move Phones”
(page 301).
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Procedure 102
Move Phones

Step Action

1 From the Search Results section of the Search for Phones
Web page, select Move from the <more actions> drop-down
list.

The Move TN Web page opens, as shown in Figure 192 "Move
TN Web page" (page 301).

Figure 192
Move TN Web page

2 Enter the TN to move the Phone and click Submit.

--End--

Retrieve Phones
The Retrieve Phones function will synchronize data from the Call Server
to the Phones database. To do this, follow the steps in Procedure 103
“Retrieve Phones” (page 301).

Procedure 103
Retrieve Phones

Step Action

1 From the Search for Phones Web page, click Retrieve.
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2 The Retrieve Options Web page opens, as shown in Figure 193
"Retrieve Options Web page" (page 302).

Figure 193
Retrieve Options Web page

3 Select one of the Retrieve Options, as follows:

Select Phones selected to retrieve the phones selected in the
phone Search Results section.

Select All phones and reconcile to retrieve the phones.

Select Custom and enter any combination of search criteria as
required to retrieve phones meeting those criteria.

4 Click Submit.

--End--

Delete Phones
To delete Phones, follow the steps in Procedure 104 “Delete Phones”
(page 302).

Procedure 104
Delete Phones

Step Action

1 From the Search for Phones, search for telephones based on a
search criteria.

2 Click the boxes beside all the telephones to delete.
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3 Click Delete.

4 Click OK to confirm the deletion of the telephones selected or
click Cancel to cancel the operation.

--End--

Swap Phones
When the user performs a swap, two telephones exchange their TNs. The
following limitations apply to the swap operation:

• The user can swap only two telephones at a time.

• The telephones to be swapped must belong to the same customer.

• The telephones to be swapped must have compatible TN types. For
example, the user cannot swap an analog (500/2500-type) telephone
with a digital telephone.

• Swapping is not supported for DCS telephones. Element Manager
does not control the allocation of virtual TNs for DCS telephones.

• If the sync status of one of the telephones to be swapped is New, it
must be swapped with another telephone with a synchronization status
of New.

• The telephones to be swapped must have the same VCE or DTA Class
of Service.

• Swapping is not supported for IP Phones.

• Swapping is not supported with the BFS feature.

• Swapping is not supported if one of the telephones is an ACD set in
the acquired state.

• Swapping is not supported for telephones with a branch office link.

Procedure 105
Swap Phones

Step Action

1 From the Search for Phones, search for telephones based on a
search criteria.

2 From the list of telephones, select the two phones to be
swapped.

3 Select Swap from the <more actions> drop-down list.

The changes are submitted to the database.

--End--
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Courtesy Change
The Courtesy Change feature checks the telephone’s busy/idle status
before transmitting the changes to the switch. If the telephone is busy,
the change is not transmitted, as this disconnects the active call and the
following error message is transmitted: Telephone is busy. Changes are
not transmitted.

Before a phone is transmitted to the call server, the overlay 32 STAT
command is used to check the idle/busy status of the telephone. If the
phone is busy, then the changes are not committed to the switch and the
user will have to perform the operation again.

It is recommended to turn off this feature before doing an bulk import
operation.

Enabling and disabling the Courtesy Change feature
The Courtesy Change feature can be turned on or off from the existing
Properties page.

To enable or disable the Courtesy Change feature select the Properties
link of the Phones branch of the Element Manager navigator and select
either Enable or Disable as required.
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Figure 194
Properties Web page

Note: Turning on the Courtesy Change feature significantly impacts the
performance of bulk add, delete or import operations. It is recommended
to turn off the courtesy feature before such operations.

Reports
Element Manager provides users with the ability to construct complex
SQL queries against the Phones database. The results can be in either
HTML or CSV format. If HTML format is selected, only a maximum of 1000
records will be displayed.

Click the Reports link of the Phones branch of the Element Manager
navigator. The Edit a Report Web page opens, as shown in Figure 195
"Edit a Report Web page" (page 306).
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Figure 195
Edit a Report Web page

Enter the desired criteria and report format. Click Generate Report to
generate the report.
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Tools

Contents
This section contains information on the following topics:

“Introduction” (page 307)

“Backup and Restore” (page 307)

“Date and Time” (page 316)

“Logs and Reports” (page 319)

Introduction
The following Call Server Tools can be accessed through Element
Manager:

• Backup and Restore

• Call Server Initialization

• Date and Time

• Logs and Reports

Backup and Restore
The Backup and Restore link of the Tools branch of the Element
Manager navigator provides access to Call Server Backup and Restore
functions, as well as Personal Directories Backup and Restore functions.

Call Server
In the Services branch of the Element Manager navigator, click Backup
and Restore > Call Server. The Call Server Backup and Restore Web
page opens (see Figure 196 "Call Server Backup and Restore Web page"
(page 308)).
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Figure 196
Call Server Backup and Restore Web page

Note: Backup Rules and Backup Schedules are available only on CPP
II, CPP IV, and CP-PM systems.

Backup
To back up the Call Server, click the Backup link on the Call Server
Backup and Restore Web page. The Call Server Backup Web page
opens, as shown in Figure 197 "Call Server Backup Web page" (page
309).
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Figure 197
Call Server Backup Web page

Select Backup from the Action drop-down list and click Submit. The Call
Server Backup Waiting Web page opens to indicate that the backup is
in progress.

The Backup function invokes a data dump and writes the Call Server data
to the primary and internal backup drives.

The Backup function performs the same task as the EDD CLI command
traditionally configured in LD 43.

A summary of the results of the EDD appears at the bottom of the Call
Server Backup Web page.

Performing manual database replication
To manually invoke the database replication process on a Small System,
on the Call Server Backup Web page select Backup Clear from the
Action drop-down list, and click Submit.

To manually invoke the database replication process on a Large System,
select Backup According to Rule from the Action drop-down list, and
click Submit. The Backup Rule Number drop-down list appears. In the
Backup Rule Number drop-down list, enter the Backup Rule number to
use for the restore operation. Click Submit.

For more information about backing up and restoring databases for
Geographic Redundancy, see System Redundancy Fundamentals
(NN43001-507) () .
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Restore
The Call Server Restore function restores the backed-up files from the
internal backup device to the primary device. The Restore function
performs the same task as the CLI RIB command traditionally configured
in LD 43.

WARNING
The process to restore data using the Element Manager
interface is immediate. There is no warning or detailed
information provided on the specifics of the data to be restored.

Also, note that a "cold start" of the system is required before the
restored data is in effect.

Click the Restore link on the Call Server Backup and Restore Web
page. The Call Server Restore Web page opens (see Figure 198 "Call
Server Restore Web page" (page 310)).

Figure 198
Call Server Restore Web page

Select Restore from Backup Data (RES) in the Action drop-down list,
and click Submit.

Note: The database for Element Manager IP Telephony is updated
immediately after the restore. Other call server databases require a
cold start after the restore.

For information about the server databases and when they were created,
select Database issue and creation date in the Action drop-down list,
and click Submit. The information is displayed in the text area below the
command.
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To manually invoke a database restore process, select Restore
According to Rule (RSR X Y) from the Action drop-down list. The
Backup Rule Number and Restore Version drop-down lists appear, as
well as the Apply Filtering checkbox.

In the Backup Rule Number drop-down list, enter the Backup Rule
number to use for the restore operation.

For more information about backing up and restoring databases for
Geographic Redundancy, see System Redundancy Fundamentals
(NN43001-507) () .

Backup Rules
To add or edit a Backup Rule, click the Backup Rules link on the Call
Server Backup and Restore Web page. The Backup Rules Web page
opens as shown in Figure 199 "Backup Rules Web page" (page 311).

Figure 199
Backup Rules Web page

To view a log of backup attempts, select a Backup Rule and click
History. The Backup History Web page opens. This Web page displays
information for each backup attempt based on the given Backup Rule.
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To add a Backup Rule, click Add on the Backup Rules Web page. The
Add Backup Rule Web page opens. To edit a Backup Rule, click the
Backup Rule Number. The Edit Backup Rule Web page opens, as
shown in Figure 200 "Edit Backup Rule Web page" (page 312).

Figure 200
Edit Backup Rule Web page

The following Backup Rule Types are available:

• Fixed Media Device

• Removable Media Device

• FTP

• Secondary Call Server

For more information about configuring backup rules for Geographic
Redundancy, see System Redundancy Fundamentals (NN43001-507) () .

Backup Schedules
Backup schedules provide the user with the ability to schedule backup
operations associated with a specified backup rule. To add or edit a
Backup Schedule, click the Backup Schedules link on the Call Server
Backup and Restore Web page. The Backup Schedules Web page
opens as shown in Figure 201 "Backup Schedules Web page" (page 313)
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Figure 201
Backup Schedules Web page

To add a Backup Schedule, click Add. The Add Backup Schedule Web
page opens. To edit a Backup Schedule, click the Schedule Number. The
Edit Backup Schedule Web page opens, as shown in Figure 202 "Edit
Backup Schedule Web page" (page 314).
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Figure 202
Edit Backup Schedule Web page

Each backup schedule defines a total of six associated parameters, as
follows:

• Backup Schedule Number — up to ten backup schedules can be
defined, numbered from one to ten.

• Backup Rule — specifies the backup rule number associated with
this backup schedule. The backup rule number must be previously
configured.

• Frequency — defines how often the scheduled backup operation
occurs. The default is D. Not more than one backup schedule can be
defined with Frequency set to the value A. Options are:

— M (monthly)

— W (weekly)

— D (daily)

— A (automatic — immediately after every EDD)

• Day — specifies the day on which the backup occurs with a default
value of SU. When Frequency is M, the range is 1 to 31 with a default
value of 1. This parameter does not apply when Frequency is set to
either of the values D or A. When Frequency is W, the range is the
days of the week as follows:

— SU

— MO

— TU
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— WE

— TH

— FR

— SA

• Hour — specifies the hour in the day on which the backup occurs. The
range is 0 to 23, with a default of 3. This parameter does not apply
when FREQ is set to the value A.

• Minute — specifies the minute in the hour in the day on which the
backup occurs. The range is 0 to 59.

To update Backup Schedules, click Automatic Schedules. The Update
Backup Schedules Web page opens, as shown in Figure 203 "Update
Backup Schedules Web page" (page 315).

Figure 203
Update Backup Schedules Web page

Backup schedules are supported only on CP PII, CP PIV and CP-PM
systems. A backup schedule can be created, modified, deleted, and
printed by the respective command options NEW, CHG, OUT, and PRT.

Personal Directories Backup and Restore
For information on Backup and Restore functions of Personal Directories,
“Personal Directories” (page 172).
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Date and Time
The Date and Time function enables users to use Element Manager to
modify the system’s current time and date. The Date and Time function
performs the same task as the CLI STAD command traditionally configured
in LD 02.

Note 1: The date and time configured in either Element Manager or LD
02 is synchronized to all primary Signaling Servers and IP Telephony
Leaders within the system. Users can specify, on a node basis, whether
the Simple Network Time Protocol (SNTP) server (running on the
primary Signaling Server) or the IP Telephony Leader cards actively
push the date and time to the SNTP clients (IP Line 4.0/Voice Gateway
cards and other Signaling Servers) or if the SNTP clients pull the date
and time from the SNTP server.

Note 2: Synchronization can be set to occur on a regular interval, when
modifications are made, or during a data dump, including a midnight
routine data dump. As part of the Node configuration, users can specify
how the date and time are propagated within the Node by configuring
the primary Signal Servers or IP Telephony Leaders to run in broadcast
mode or listen mode.

Note 3: Users must have SEC_ADMIN privileges to change date and
time.

Click the Date and Time link in the Tools branch of the Element Manager
navigator. The System Date and Time Web page opens, as shown in
Figure 204 "System Date and Time Web page" (page 317).
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Figure 204
System Date and Time Web page

To modify the date and time, click Set. The Edit Date and Time Web
page opens, as shown in Figure 205 "Edit Date and Time Web page"
(page 318).
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Figure 205
Edit Date and Time Web page

Enter the current Date and Time.

To account for an adjustment due to Daylight Savings Time, select
the Adjust for Daylight Savings checkbox and enter the appropriate
information.

To adjust the time of day due to a fast or slow system clock, enter the
appropriate information in the Daily time adjustment section.

To save changes, click Save.

Network Time Synchronization
The Network Time Synchronization feature is ensures that all time stamps
in a network are synchronized from one source.

To configure Network Time Synchronization parameters, in the Network
Time Synchronization section click Configure. The Network Time
Synchronization Web page opens, as shown in Figure 206 "Network
Time Synchronization Web page" (page 319).
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Figure 206
Network Time Synchronization Web page

Enter the appropriate information and click Save.

Logs and Reports
For information on IP Telephony Node Maintenance and Reports, see
“Nodes: Servers, Media Cards” (page 139).

In addition, information about the database status and synchronization are
available under the Reports tab in NRS Manager. For more information
about these reports, refer to IP Peer Networking Installation and
Commissioning (NN43001-313) () .

To display information on all IP Phones configured in the system, click the
Logs and Reports > IP Phone Location link in the Tools branch of the
Element Manager navigator. The IP Phone Location Web page opens, as
shown in Figure 207 "IP Phone Location Web page" (page 320).
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Figure 207
IP Phone Location Web page

Enter the search criteria in the Search for IP Phone Location section and
click Search. The results matching the criteria entered are displayed in the
IP Phones Found section.

To view a list of software feature packages, click the Logs and Reports
> Equipped Feature Packages link in the Tools branch of the Element
Manager navigator. The Equipped Feature Packages List Web page
opens as shown in Figure 208 "Equipped Feature Packages List Web
page" (page 321).
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Figure 208
Equipped Feature Packages List Web page

To view a list of Peripheral Software Version Data, including the loadware
version of the Media gateway Controller (MGC) card, click the Logs and
Reports > Peripheral Software Version Data link in the Tools branch of
the Element Manager navigator. The Peripheral Software Version Data
Web page opens as shown in Figure 209 "Peripheral Software Version
Data Web page" (page 322).
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Figure 209
Peripheral Software Version Data Web page

To view a list of System Licence Parameters, click the Logs and Reports
> System Licence Parameters link in the Tools branch of the Element
Manager navigator. The System Licence Parameters Web page opens
as shown in Figure 210 "System Licence Parameters Web page" (page
323).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



Logs and Reports 323

Figure 210
System Licence Parameters Web page

Operational Measurements
Element Manager provides users with regularly scheduled reports on
system traffic. To access these reports, click the Logs and Reports >
Operational Measurements link in the Tools branch of the Element
Manager navigator. The Call Server Operational Measurements Web
page opens, as shown in Figure 211 "Operational Measurements Web
page" (page 324).
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Figure 211
Operational Measurements Web page

System Traffic
To display details of the system’s Traffic reports, click System Traffic. The
System Traffic Web page opens, as shown in Figure 212 "System Traffic
Web page" (page 325).
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Figure 212
System Traffic Web page

To display a report, click the Report Title. The report displays in a new
window.

To enable a report, select the report and click Enable.

To disable a report, select the report and click Disable.

To configure Threshold information, click Thresholds. The Thresholds
Web page is displayed.

To configure report schedules, click Schedules. The Report Schedule
Web page is displayed.

Customer Traffic
To display details of the Traffic reports for each Customer configured in the
system, click Customer Traffic. The Customer Traffic Web page opens,
as shown in Figure 213 "Customer Traffic Web page" (page 326).
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Figure 213
Customer Traffic Web page

To display Traffic reports for a Customer, select the Customer from the
drop-down list.

To enable a report for the selected Customer, select the report and click
Enable.

To disable a report for the selected Customer, select the report and click
Disable.

To configure Threshold information for the selected Customer, click
Thresholds. The Thresholds Web page is displayed.

To configure report schedules for the selected Customer, click Schedules.
The Report Schedule Web page is displayed.

Traffic Parameters
To configure Traffic Parameters for the system, click Traffic Parameters.
The Edit Traffic Parameters Web page opens, as shown in Figure 214
"Edit Traffic Parameters Web page" (page 327).
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Figure 214
Edit Traffic Parameters Web page

Select a Line Load Control Level from the drop-down list.

Enter the Blocking Probabilities.

Choose a Customer from the Feature Key Customer drop-down list and
click Save.

Note: If the Line Load Control Level is set to Off, the Blocking
Probabilities are disabled.

Quality of Service
Click Quality of service to open the Ethernet Quality of Service
Diagnostics Web page. For more information, see “Ethernet Quality of
Service Diagnostics” (page 85)

Bandwidth Management
Click Bandwidth Management to open the Maintenance Commands for
Zones Web page. For more information, see “Zone Diagnostics” (page
114)

Individual Traffic Measurement
To configure lines and trunks for Individual Traffic Measurement, click
Individual Traffic Measurement. The Individual Traffic Measurement
Web page opens, as shown in Figure 215 "Individual Traffic Measurement
Web page" (page 328).

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



328 Tools

Figure 215
Individual Traffic Measurement Web page

To add a terminal for Individual Traffic Measurement, click Add. The Add
TN Web page opens, as shown in Figure 216 "Add TN Web page" (page
328).

Figure 216
Add TN Web page
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Enter the TNs to be added in the TN text box. Enter up to five TNs and
click Save.

Note: The TNs must be separated by a comma.
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Security
For information on Security features available in Element Manager, see
Security Management Fundamentals (NN43001-604) () .
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Certificate Management

Contents
“Overview” (page 333)

“Creating a new certificate request” (page 334)

“Processing a pending certificate response” (page 335)

“Deleting a pending certificate request” (page 335)

“Creating a self-signed certificate” (page 336)

“Assigning an existing certificate” (page 337)

“Importing a certificate and its private key” (page 338)

“Creating a certificate renew request for the current certificate” (page 338)

“Removing the current certificate” (page 339)

“Replacing the current certificate” (page 339)

“Exporting the current self-signed certificate” (page 340)

“Exporting the current certificate and its private key” (page 341)

“SSL/TSL security configuration” (page 341)

Overview
When accessing Element Manager through Enterprise Common
Manager, Certificate Management is provided by the framework. For
more information, see Enterprise Common Manager Fundamentals
(NN43001-116).

This chapter describes Certificate Management in Element Manager when
accessed on VxWorks.
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This section contains information on the Element Manager SSL/TLS
Service Management Wizard, which guides users through the certificate
management and Transportation Layer Security (TLS) configuration
process.

Creating a new certificate request
When Element Manager is first deployed, no certificate is installed. The
TLS service for the Element Manager is disabled.

Follow the steps in Procedure 106 “Creating a new certificate request”
(page 334) to create a new certificate request.

Procedure 106
Creating a new certificate request

Step Action

1 Log in using the non-secure mode.

2 Click Configure.

The Server Certificate Web page appears.

3 Select the Create a new certificate request to be signed by
Certificate Authority radio button and click Next.

The Name and Security Settings Web page appears.

4 Enter a Friendly Name for the certificate.

5 Select a bit length from the Bit length drop-down list.

6 Click Next.

The Organization Information Web page appears.

7 Enter an Organization and Organization Unit and click Next.

The Your Server’s Common Name Web page appears

8 Enter a Common Name and click Next.

The Geographical Information Web page appears.

9 Enter a Country/Region.

10 Enter a State/Province.

11 Enter a City/Locality.

12 Click Next.

The Certificate Request Summary Web page appears.

13 Click Commit to download the certificate request to a local file.

The X.509 Certificate Request Web page appears.
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14 Click Close to close the wizard.

--End--

Processing a pending certificate response
The certificate request file is submitted to a Certificate Authority. The
Certificate Authority sends a response in a text file.

Follow the steps in Procedure 107 “Processing a pending certificate
response” (page 335) to process the pending certificate response file.

Procedure 107
Processing a pending certificate response

Step Action

1 On the SSL/TLS Service Configuration Web page, click
Configure.

The Server Certificate Web page appears.

2 Select the Process the pending request and install the
certificate option button and click Next.

The Process a Pending Request Web page appears.

3 Copy the contents of the text file received from the certificate
authority.

4 Click Commit.

The Certificate Summary Web page appears.

5 Click Finish.

--End--

To verify that the Certificate Authority is trusted by Internet Explorer,
choose Tools > Internet Options > Content > Certificates. The Trusted
Certificate Authority List Web page appears.

If the Certificate Authority is not in the trusted Certificate Authority list of
Internet Explorer, a Security Alert Web page appears when accessing
Element Manager using SSL or TLS.

The user must then log in using the secure mode.

Deleting a pending certificate request
Follow the steps in Procedure 108 “Deleting a pending certificate request”
(page 336) to delete a pending certificate request.
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Procedure 108
Deleting a pending certificate request

Step Action

1 On the SSL/TLS Service Configuration Web page, click
Configure.

The Server Certificate Web page appears.

2 Select the Delete the pending request option button and click
Next.

The Delete a Pending Request Web page appears.

3 Click Finish.

--End--

Creating a self-signed certificate
Follow the steps in Procedure 109 “Creating a self-signed certificate” (page
336) to create a self-signed certificate.

Procedure 109
Creating a self-signed certificate

Step Action

1 On the SSL/TLS Service Configuration Web page, click
Configure.

The Server Certificate Web page appears.

2 Select the Create a new self-signed certificate option button
and click Next.

The New Self-Signed Certificate Web page appears.

3 Click Next.

The Name and Security Settings Web page appears.

4 Enter a Friendly Name for the certificate.

5 Select a bit length from the Bit length drop-down list.

6 Click Next.

The Organization Information Web page appears.

7 Enter an Organization and Organization Unit and click Next.

The Your Server’s Common Name Web page appears.

8 Enter a Common Name and click Next.

The Geographical Information Web page appears.
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9 Enter a Country/Region.

10 Enter a State/Province.

11 Enter a City/Locality.

12 Click Next.

The Certificate Request Summary Web page appears.

13 Click Commit.

The X.509 Certificate Request Web page appears.

14 Click Close to close the wizard.

If the Security Alert Web page appears, click Yes.

Note: The user can also export the self-signed certificate and
distribute it into the trusted Certificate Authority list of Internet
Explorer.

--End--

Assigning an existing certificate
To assign an existing certificate to the Element Manager’s Web site, follow
the steps in Procedure 110 “Assigning an existing certificate” (page 337).

Procedure 110
Assigning an existing certificate

Step Action

1 On the SSL/TLS Service Configuration Web page, click
Configure.

The Server Certificate Web page appears.

2 Select the Assign an existing certificate option button and click
Next.

The Available Certificate Web page appears.

3 Select a certificate from the list of available certificates and click
Next.

The Certificate Summary Web page appears.

4 Click Finish.

--End--

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



338 Certificate Management

Importing a certificate and its private key
Follow the steps in Procedure 111 “Importing a certificate and its private
key” (page 338) to import a certificate and its private key.

Procedure 111
Importing a certificate and its private key

Step Action

1 On the SSL/TLS Service Configuration Web page, click
Configure.

The Server Certificate Web page appears.

2 Select the Import a certificate and its private key from a PEM
encoded file option button and click Next.

The Import Certificate Password Web page appears.

3 Enter the password of the certificate file and click Commit.

The Import Certificate Web page appears.

4 Copy the contents of the text file received from the certificate
authority.

5 Click Commit.

The Certificate Summary Web page appears.

6 Click Finish.

--End--

Creating a certificate renew request for the current certificate
The X.509 certificate has an expiration date. A warning message is shown
if the expiration date is less than one month away. To create a certificate
renewal request, follow the steps in Procedure 112 “Creating a certificate
renew request” (page 338).

Procedure 112
Creating a certificate renew request

Step Action

1 On the SSL/TLS Service Configuration Web page, click
Configure.

The Server Certificate Web page appears.

2 Select the Create a certificate renew request option button and
click Next.

The Certificate Request Summary Web page appears.
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3 Click Commit to download the certificate request to a local file.

The X.509 Certificate Request Web page appears.

4 Click Close to close the wizard.

--End--

Removing the current certificate
To remove a current certificate, follow the steps in Procedure 113
“Removing the current certificate” (page 339).

Procedure 113
Removing the current certificate

Step Action

1 On the SSL/TLS Service Configuration Web page, click
Configure.

The Server Certificate Web page appears.

2 Select the Remove the current certificate option button and
click Next.

The Remove a Certificate Web page appears.

3 Click Finish.

Note: All client sessions must be terminated before the
removing operation can take effect.

--End--

Replacing the current certificate
To replace the current certificate, follow the steps in Procedure 114
“Replacing the current certificate” (page 339).

Note: The security context of the Web SSL service will change to the
new certificate when there is no active HTTPS connection.

Procedure 114
Replacing the current certificate

Step Action

1 On the SSL/TLS Service Configuration Web page, click
Configure.
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The Server Certificate Configuration Wizard Web page
appears.

2 Select the Replace the current certificate option button and
click Next.

The Available Certificate Web page appears.

3 Select a certificate from the list and click Next.

The Certificate Summary Web page appears.

4 Click Close to close the wizard.

--End--

Exporting the current self-signed certificate
When the current certificate is self-signed, it can be exported. Using
SSL and TLS protocol, the certificate file can be used to set up a trust
relationship between different parties.

To export the current self-signed certificate, follow the steps in Procedure
115 “Exporting the current self-signed certificate” (page 340).

Procedure 115
Exporting the current self-signed certificate

Step Action

1 On the SSL/TLS Service Configuration Web page, click
Configure.

The Server Certificate Configuration Wizard Web page
appears.

2 Select the Export the current self-signed certificate option
button and click Next.

The Export Self-signed Certificate Summary Web page
appears.

3 Click Download.

The Certificate Content Web page appears. Copy the contents
of the text box and save it as a plain text file. When exporting the
self-signed certificate, name the file with extension .cer. The file
can then be installed in the trusted certificate list of the client.

4 Click Close to close the wizard.

--End--
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Exporting the current certificate and its private key
The current certificate and its private key can be exported. A password
is required to encrypt the file. Use the same password that was used to
import the file.

Follow the steps in Procedure 116 “Exporting the current certificate” (page
341) to export the current certificate and its private key.

Procedure 116
Exporting the current certificate

Step Action

1 On the SSL/TLS Service Configuration Web page, click
Configure.

The Server Certificate Configuration Wizard Web page
appears.

2 Select the Export the current certificate and its private key
option button and click Next.

The Export Certificate Password Web page appears.

3 Enter the password and click Next.

The Export Current Certificate and Private Key Summary
Web page appears.

4 Click Download.

The Certificate Content Web page appears. When exporting
the certificate and private key, import the file to another server.

5 Click Close to close the wizard.

--End--

SSL/TSL security configuration
When a certificate is installed on Element Manager, the SSL/TLS usage
rule is set to "Always" by default.

If "Always" is selected, all user traffic must use SSL/TLS. If "UserChoice"
is selected, users can choose between secure and non-secure sessions
when they log in.

The user can configure the TCP port used by the SSL and TLS service by
entering a value in the SSL/TLS field. The default value is 443.

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



342 Certificate Management

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



343
.

Login banner support
The Login banner feature displays a security warning banner in the login
page of Element Manager on VxWorks. When a user logs into the ECM
framework to access EM, they see a similar security warning banner.

Element Manager on VxWorks has a provision to modify the banner. This
modification gets reflected on the Call Sever where the master copy is
maintained.

Procedure 117
Edit banner information

Step Action

1 Login to Element Manager on VxWorks with Level 2 and PDT
1 or higher access privileges.

2 Select Login Options > Access Warning from the left
navigation pane.

3 On the Access Warning Web page, click Edit.

4 Change the banner information present in the text area.

5 To save the new information, click Save.

6 Click OK. The configuration is saved on the Call Server.

7 Logout of Element Manager and the EM login page is displayed
with the updated banner information.

--End--
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Support

Contents
This section contains information on the following topics:

“Introduction” (page 345)

“Help” (page 345)

“Release Notes” (page 346)

Introduction
The following Support features can be accessed through Element
Manager:

• Help

• Release Notes

Help
Element Manager provides context-sensitive online Help. To access Help,
click the Help link located in the top right corner of the Element Manager
Web pages. The Help Web page shown in Figure 217 "Help Web page"
(page 346) opens.
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Figure 217
Help Web page

Release Notes
A Release Note can describe a design change or a product feature that
was discovered after market release. Often, a Release Note describes
how to work around a product limitation. Click the Release Notes link to
access the Web-based Helmsman Express application.

Nortel Communication Server 1000
Element Manager System Reference — Administration

NN43001-632 02.14
7 November 2008

Copyright © 2008 Nortel Networks

.



347
.

Appendix A
WARNING
Do not contact Red Hat for technical support on your Nortel
version of the Linux base operating system. If technical support
is required for the Nortel version of the Linux base operating
system, contact Nortel technical support through your regular
channels

This section governs the use of the Red Hat Software and any updates
to the Red Hat Software, regardless of the delivery mechanism and is
governed by the laws of the state of New York in the U.S.A. The Red Hat
Software is a collective work under U.S. Copyright Law. Subject to the
following terms, Red Hat, Inc. (“Red Hat”) grants to the user (“Customer”)
a license to this collective work pursuant to the GNU General Public
License. Red Hat Enterprise Linux (the “Red Hat Software”) is a modular
operating system consisting of hundreds of software components. The end
user license agreement for each component is located in the component’s
source code. With the exception of certain image files identified below, the
license terms for the components permit Customer to copy, modify, and
redistribute the component, in both source code and binary code forms.
This agreement does not limit Customer’s rights under, or grant Customer
rights that supersede, the license terms of any particular component.
The Red Hat Software and each of its components, including the source
code, documentation, appearance, structure and organization are owned
by Red Hat and others and are protected under copyright and other
laws. Title to the Red Hat Software and any component, or to any copy,
modification, or merged portion shall remain with the aforementioned,
subject to the applicable license. The “Red Hat” trademark and the
“Shadowman” logo are registered trademarks of Red Hat in the U.S. and
other countries. This agreement does not permit Customer to distribute
the Red Hat Software using Red Hat’s trademarks. If Customer makes
a commercial redistribution of the Red Hat Software, unless a separate
agreement with Red Hat is executed or other permission granted, then
Customer must modify any files identified as “REDHAT-LOGOS” and
“anaconda-images” to remove all images containing the “Red Hat”
trademark or the “Shadowman” logo. As required by U.S. law, Customer
represents and warrants that it: (a) understands that the Software is
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subject to export controls under the U.S. Commerce Department’s Export
Administration Regulations (“EAR”); (b) is not located in a prohibited
destination country under the EAR or U.S. sanctions regulations (currently
Cuba, Iran, Iraq, Libya, North Korea, Sudan and Syria); (c) will not export,
re-export, or transfer the Software to any prohibited destination, entity, or
individual without the necessary export license(s) or authorizations(s) from
the U.S. Government; (d) will not use or transfer the Red Hat Software
for use in any sensitive nuclear, chemical or biological weapons, or
missile technology end-uses unless authorized by the U.S. Government
by regulation or specific license; (e) understands and agrees that if it is
in the United States and exports or transfers the Software to eligible end
users, it will, as required by EAR Section 740.17(e), submit semi-annual
reports to the Commerce Department’s Bureau of Industry & Security
(BIS), which include the name and address (including country) of each
transferee; and (f) understands that countries other than the United States
may restrict the import, use, or export of encryption products and that it
shall be solely responsible for compliance with any such import, use, or
export restrictions. Red Hat may distribute third party software programs
with the Red Hat Software that are not part of the Red Hat Software.
These third party programs are subject to their own license terms. The
license terms either accompany the programs or can be viewed at
http://www.redhat.com/licenses/. If Customer does not agree to abide by
the applicable license terms for such programs, then Customer may not
install them. If Customer wishes to install the programs on more than one
system or transfer the programs to another party, then Customer must
contact the licensor of the programs. If any provision of this agreement
is held to be unenforceable, that shall not affect the enforceability of the
remaining provisions. Copyright © 2003 Red Hat, Inc. All rights reserved.
"Red Hat" and the Red Hat "Shadowman" logo are registered trademarks
of Red Hat, Inc. "Linux" is a registered trademark of Linus Torvalds. All
other trademarks are the property of their respective owners.
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Index

32 Channel Secure Media Card 9

A
ABCD Bit Signaling Category 251
ABKUP 196
access levels 262
ACOD 238
ADAN 249
add Bookmark 35
Advanced Configurations 241
Advanced Trunk Configuration 245
ADVOPT 249
AML Diagnostics 49
ATLP 75
ATST 100

B
Background Signaling and Switching

diagnostics 52
Backup 307
Basic Rate Line Interface 251
Basic Rate Trunk Interface 251
Basic Route Options 238
BILN 238
Bookmarks

delete 37
edit 36

Bookmarks, add 35
Branch Office

Basic Property and Bandwidth
Management 164

Branch Office (553-3001-214) 163
BRSC 103
BSCOPT 249

C
Call Server 17, 28, 40, 46, 255, 264

backup 309
restore 310

Call Server Select by Functionality 46
Call Server Select by Overlay 47
Call Trace Diagnostics 53
cancel 29, 40
CDR 238
CDSP 63, 78, 90, 101, 107, 111, 114
Centralized Software Upgrade 56
CHG ZQNL 87
clock controller 59, 252
Clock Controller Diagnostic 59
CLR GR 64
CLS 244
CMAJ 63, 101, 107, 111
CMIN 63, 78, 90, 100, 107, 111, 114
CNTL 239
CNVT 239
Code Restriction Tree Number 265
Collaborative Server 259
common equipment 116
common equipment. 117
community strings 45
Conference loop numbers 117
configuration 29, 40, 237
Configuration Record 249
Coordinated Dialing Plan 256, 258
Core Common Equipment Diagnostics 60

Large System 60
Courtesy Change 304
CPED 107
CSV 294
customer 264, 267
Customers menu 16, 26, 28
CUTOVR 63
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D
D-channel 66
D-channel Diagnostics 66
D-Channel Expansion Diagnostics 69
D-channel Property Configuration 248
Database issue and creation date 310
delete 29
delete Bookmarks 37
DES 237, 243
Diagnostic Commands 105
Dialing and Numbering Plans

menu 16, 26, 28
Digit Conversion Tree Number 268
Digit Manipulation Block 256
digit sequences 266
Digital Trunk Card 73
Digital Trunk Card Diagnostic 72
Digital Trunk Interface 250–251, 253
Digital Trunk Interface and Primary

Rate Interface
Clock Controller Diagnostics 59

Digital Trunk Interface and Primary
Rate Interface Diagnostic 59

Digital Trunk Interface and Primary
Rate Interface Diagnostics 72

Digital Trunk Interface Data Block 250
–251, 253

Digital Trunk Interface Loop numbers 117
Digital Trunk Maintenance Diagnostics 75
Digital Trunk Route 74
DIS 95, 109
DIS AML 51
DIS AUTO 67, 104
DIS BRIE 105
DIS BRIL 105
DIS BRIT 105
DIS CC 60
DIS CNI 62
DIS DCH 67
DIS DDSC 76
DIS DDSL 76
DIS DTCS 76
DIS DTRC 76
DIS DTSL 76
DIS DTVC 77
DIS ELAN 51
DIS LLB 67
DIS LSSL 77
DIS MSDL 71, 89
DIS MSDL ALL 71

DIS MSDL AUDM 71
DIS MSDL DBG 71
DIS PRT 89
DIS RLB 67
DIS TEST 67
DIS TTY 88
DIS ZBR 116
DIS ZONE 116
DISC 100, 102–104, 113
DISC BRI 103
DISI 73
DISI DDCS 77
DISI DTCS 77
DISL 73, 102, 107, 111
DISL BRIE 103
DISL BRIT 103
DISN 103
DISR 111
DISS 102
Distant Steering Code 258
DISU 100, 104, 113
DISX 111
DSCH 74
DSPL 62
DSPL ALL 62
DSPS 103
DSRB 104
DSXP 103
DSYL 73
DTR 111

E
Echo Servers for NAT 169
EDD 309
edit Bookmarks 36
Electronic Switched Network 255

Access Codes and Parameters 256
Embedded LAN 136
ENCH 73–74
ENCK 60
ENL 95, 109
ENL AML 51
ENL AUTO 68, 104
ENL BRIL 105
ENL BRIT 105
ENL CC 60
ENL CNI 62
ENL DCH 68
ENL DDSC 77
ENL DDSL 77
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ENL DTCS 77
ENL DTRC 77
ENL DTSL 77
ENL DTVC 77
ENL ELAN 52
ENL EXT 62
ENL LLB 68
ENL LSSL 77
ENL MSDL 71, 89
ENL MSDL all 71
ENL MSDL AUDM 71
ENL MSDL FDL 71
ENL PRT 89
ENL RLB 68
ENL TEST 68
ENL TTY 88
ENL ZBR 116
ENL ZONE 116
ENLC 100, 113
ENLC BRI 103
ENLL 73, 102, 107, 111
ENLL BRIL 103, 105
ENLL BRIT 103
ENLN 103
ENLR 111
ENLS 102
ENLU 113
ENLX 111
ENPS 103
ENRB 104
Enterprise Translations Server 259
ENXP 103
ENYL 73
Equipment Data Dump 309
EST AML 50
EST DCH 69
Ethernet and Alarm Management 45,

164, 167, 169
Ethernet Diagnostics 81
Ethernet Quality of Service Diagnostic 85
Event Default Table 45
Event Preference Table 45
Exchange (Central Office) Code 258

F
FDIS NCAL 104
FDLC 104
FDLU 104
Feature Packages 117
file upload 203

firmware 137, 203
Flexible Code Restriction 263–264, 269
Flexible Feature Code Entries 220
Flexible Feature Codes (FFC) 219
Force Download 96
Free Calling Area Screening 258
Free Special Number Screening 258
FSUM 104
FWVU 104

G
General Commands 140–141
General Options 240
Geographic Redundancy 196

H
H.323 138, 259
H.323 Settings 137
Help 345
Home Area Code 258
Home Location Code 258
Home menu 25, 27

I
ICOG 238
IDC 102–104, 239
IDC CNI 62
IDC CPU 62
IDCS 103
Import Telephones 294
importing Node files 133
INC 244
Incoming Digit Conversion 266, 269
Incoming Trunk Group Exclusion 256
Input/Output Diagnostics 87
IP Line 17, 141
IP Line 3.0 316
IP Line 5.5 17–18
IP Line application commands 141
IP Network 131
IP Network menu 16
IP Phones 137, 203
IP telephony 139, 146
IP Telephony 140
IP Telephony card 131
IP Telephony Information 139
IP Trunk 3.0 259
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J
JOIN 63

L
LAN 136
LATEST 146
LBSY 102
LCNT 73
LD 02 316
LD 117 45, 81, 86, 115, 164, 167–169
LD 15 - Customer Data Block 210
LD 16 237
LD 17 249
LD 30 107
LD 32 101
LD 36 64, 67, 112, 115
LD 37 67, 88
LD 43 309–310
LD 48 67, 70
LD 49 269
LD 54 99
LD 73 253
LD 86 255, 257
LD 87 255, 257–258
LD 90 255, 258
LD 96 67, 109–110, 112
LD 97 118, 197
LDIC 113
LDID 113
LDIS 102, 107
LENL 107
LIDL 102
Link Diagnostic 70
Links menu 16, 25, 27
LMAX 113
LMNT 102
LNDS 113
Local Steering Code 258
Location Code 258
log in 21
Logging into Element Manager 21
Login banner 343
LOOP 107
Loop Timer 250
Loss and Level Plan 18
Loss and Level plans 139
LOVF 74, 114

M
maintenance 86–87
Maintenance Commands for Zones 114
MAP AML 50
MAP DCH 69
Media Gateway 1000B 17
Media Gateway Controller 9
Member Property Configuration

advanced 245
basic 243

MFR 111
Microsoft Internet Explorer 259
MIDN 100
MISP 102
Mobile Extension 10
Mobile Service Directory Numbers 225
MSDL 70
MSDL Diagnostics 94
MTST 100
Multi-Del 245
Multifrequency Signaling Diagnostics 99

N
NAT 169
NAT Echo Servers 169
NAT session time-out value 169
navigation tree 24
Netscape Navigator 259
Network Address Translation (NAT) 169
Network and Peripheral Equipment

Diagnostic 101
Network and Peripheral Equipment

Diagnostics 101
Network and Signaling Diagnostics 106
Network Attendant Services 256
Network Control and Services 256
Network Control Parameters 256
Network Loop 102
Network Numbering Plan 255, 259
Network Options 240
Network Routing Service home page 262
Network Speed Call Access Code 258
Node ID 140
Node Summary 131
nodes 136

add new 132
delete 132
edit configuration 132
import files 132

NRS
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Guest access 262
NRS Manager 255

Administrator access 262–263
Monitor access 262

Numbering Plan 256, 258
Numbering Plan Area Code 258

O
online Help 345
Operational Measurement Report 140
Operational Measurements Report 146

P
PAD Category 250
Patch Bin 205
PCON 104
PERR 104
PERR BRIE 105
PERR BRIL 105
PERR BRIT 105
Personal Directory, Redial List, Callers

List 172
ping an IP address 143
PINS 204
PLIS 204
PLOG 104
PMES 104
PNNC 239
POOS 204
POUT 204
Primary Rate Interface 250–251
PRT AQOS 86
PRT DNIP 83–84
PRT IPDN 83–84
PRT IPMG 83
PRT IPR 83
PRT ZBW 116
PRT ZDES 116
PRT ZDP 116
PRT ZONE 115
PRT ZQNL 87
PRT ZQOS 86
PRT ZTP 116
PSTAT 204
PTAB 104

Q
QoS 17, 136, 170
QoS Call Basis Threshold Parameters 171

QoS Zone Basis Threshold
Parameters 171

Quality of Service 171
Quality of Service (QoS) 136
Quality of Service (QOS) 17
Quality of Service Thresholds 170

R
RAN 114
RCNT 73
RD 144
RDGO 144
RDHEAD 144
RDOPEN 144
RDS 145
RDSHOW 144
RDTAIL 144
Report Utility 140, 143
RES 109
reset element 140
Restore from Backup Data 310
RLS AML 50
RLS DCH 69
ROUT 237
route 236–237
Route Data Block 237
Route List Block 256
Route Properties 236
Routes and Trunks menu 26, 28
Routing Entry 259
RPED 107
RSET 113
RST 95
RST DCH 69
RST MSDL 70, 89
RTMB 243

S
Save node files 132
SCPU 63
SDCH DCH 69
SDTR 111
Security menu 26, 28
SHLF 107
SIGL 243
Signaling Server 16, 131, 137, 140, 143
Simple Network Management

Protocol 17, 44
Simple Network Time Protocol (SNTP) 18
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SIP 137–138
SIP Converged Desktop Service 137
SIP Gateway 137
SIP Re-direct Server 137
SIP URI DN Mapping 137
SLFT 73–74, 95, 107, 109
SLFT AML 50
SLFT MSDL 70, 89
SNMP 17, 44
SNMP alarm browser 45
SNMP traps 45
SNTP 18, 137, 316
software upgrade 131
Special Number 258
SPLIT 63
SSCK 60
STAT 73, 90, 95, 99–100, 102–103,

107, 109, 111–112
STAT AML 50
STAT CNI 61
STAT CPU 61
STAT DCH 67
STAT DDCS 76
STAT DDSL 76
STAT DTCS 76
STAT DTRC 76
STAT DTSL 76
STAT DTVC 76
STAT ELAN 50
STAT GR 64
STAT HEALTH 64
STAT HEALTH AML 64
STAT HEALTH ELAN 64
STAT HEALTH HELP 63
STAT HEALTH HW 64
STAT HEALTH IPL 64
STAT LINK 90
STAT LINK IP 81
STAT LINK NAME 82
STAT LINK NODE 82
STAT LINK SRV 82
STAT LSRC 76
STAT LSSL 76
STAT LSVC 76
STAT MEM 61
STAT MSDL 70, 89
STAT MSDL full 70
STAT NCAL 104
STAT NEXT 61
STAT NWK 103

STAT PER 103
STAT PRT 89
STAT SERV 67, 82
STAT SERV APP 82
STAT SERV IP 82
STAT SERV NAME 82
STAT SERV NODE 82
STAT SERV TYPE 82
STAT TTY 88
STAT VTRM 104
STAT XSM 90
STAT ZBR 116
STAT ZONE 116
State Control 197
STIP HOSTID 83
STIP NODE 83
STIP TERMIP 83
STIP TN 82
STIP TYPE 83
STIP ZONE 83
STRI 244
STRO 244
STRT 78
submit 28, 40
Subscriber Manager 9
Superloop 118
SUPL 102
Syslog 145
SYSLOG.0 146
System Date and Time 316–317
System Information Web page 23
System menu 25, 27
System Status 40
System Timer 250
System Utility 307

T
TDS 111
TEIT 107
Telnet 32
Template 15
Templates 26, 273
Terminal Proxy Server 260
Terminal Session

add 32
TEST 53
TEST 100 68
TEST 101 68
TEST 200 68
TEST 201 68
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TEST CNI 62
TEST CPU 62
TEST GR 64
TEST IPB 62
TEST LCD 63
TEST LED 63
TEST SUTL 63
Threshold Set Block 252
Threshold Set Index 252
Threshold Set Index, adding 252
Threshold Set Index, editing 252
time-out 24
TKTP 237
TMDI Diagnostics 108
Tone and Digit Switch Diagnostics 110
Tone and Digit Switch numbers 117
Tools menu 16, 26, 28
TRAC 55
Transfer/Status 133–134
TRAT 56
TRCK 60
TRIP 56
trunk 236–237, 242, 245–246
Trunk Diagnostic 112
Trunk Diagnostics 112
Trunk Steering Code 258
TTPM 113
TTSM 107
TTWI 107

U
UEXT 10
Universal Extension 10
Universal Extension ID 10
Universal Extension Type 10
UNTT 107
update 28, 40
UPLD AML 51
User Endpoint 259

V
VGW Profile data 136
VGWChannel 132
VIEW 145
Virtual Terminal 140
Virtual Terminal Sessions 31
Voice Gateway 316
Voice Gateway Media Card 17–18, 137

X
XNTT 102
XPCT 103
XPEC 103
XRST 102
XTRK 243

Z
Zone 161

Basic Property and Bandwidth
Management 163

Branch Office Dialing Plan and
Access Codes 163

Branch Office Emergency Service
Information 163

Branch Office Time Difference
and Daylight Saving Time
Property 163, 167

Dialing Plan and Access Codes 166
Time Difference and Daylight Saving

Time Property 167
Zone Diagnostic 60
Zone Diagnostics 114
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